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Introduction — Welcome

              
Introduction

Welcome to ElectricImage™ 2.8!

Well, here it is, ElectricImage 2.8! Crammed with hundreds of incredible new features, 
such as a fantastic new user interface, including a totally new material and texture map 
interface, procedural shaders, and cool new character animation tools, we are sure that 
you will find this new version an essential component of your production arsenal. 

So Many Features, So Little Time

There are so many new features in this version of ElectricImage, that one wonders if there 
is truly enough time to describe them all. However, always endeavoring to do our best, 
we will describe the new features to the best of our ability in this supplement. Tutorials 
which show you how to use all of the features, new ones and old ones alike, are offered as 
Adobe Acrobat files on the 2.8 installation CD. Additionally, as new tutorials are created, 
they will also be made available at the ElectricImage web site: 

www.electricimage.com

For those users who may wish to contribute their own tutorials, please feel free to contact 
us at tech.support@electricimage.com.

New Materials and Shaders

ElectricImage now has state of the art material and surface support. Each group can have 
an unlimited number of textures and shaders attached to it. The Material editor has been 
completely redesigned both to make the process of dealing with materials an order of 
magnitude easier, and to conform to modern industry standards. New users will appreci-
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ate the straightforward layout and functions of the materials, and power users can now 
concentrate on getting the right look, as opposed to wrestling with the limitations placed 
upon them by previous versions.

Procedural shaders are now fully supported in the interface. A procedural can be placed 
into any material channel, and used to great effect. As you might expect from ElectricIm-
age, these shaders are fast! (Shaders are covered in the Procedural Shaders chapter.)

New Texture Placement Tools and Quality Controls

Unlimited textures can pose a problem if you can’t handle them well. In Electricimage 2.8, 
new placement controls allow for the ultimate in precision mapping, down to the polygon 
level. Each map has 256 levels of transparency, for multi-layered effects. Movie playback 
for mapping has never been easier, with new controls for how the playback works. Each 
map can have its own projection, and be any size or bit depth. New map filtering offers 
never before seen levels of incredible texture quality control. (See the Materials and Tex-

tures chapter for more information.)

Master Materials

Master Materials are listed in the project window, and can have an unlimited number of 
groups attached to them (groups have a limitation of one material each.) Master Materials 
let you cut down on the work required to create repetitive materials across multiple 
groups. Now you can create just one, and attach the appropriate groups to it. You can also 
immediately effect massive changes to many groups, just by changing the Master Material 
to which they are assigned. (See the Materials and Textures chapter for more information.)

Bones Deformations

Bones are commonly used in character animation. While they can be used to control facial 
movement, they are best used to create seamless skin animation. You have seen bones 
used to animate credit cards and tortilla chips in commercials, dinosaurs and other fantas-
tic creatures in television shows and the movies. Bones can work with inverse kinematics 
2       ElectricImage 2.8 Supplement    



 

Introduction — New Look and Feel

            
to get some fantastic results. (See the Deformations chapter for more information on 

bones.)

Morphing

Complementing bones is the Morphing feature. Great for character facial animation, the 
morphing control panel lets you selectively morph multiple objects for fantastic control. 
Sync dialog and a broad range of facial emotions are easy to animate with this versatile 
tool. (See the Facial Animation with the Morph Window chapter.)

Function Curve Editor

This new version of ElectricImage is all about control, control, control! And the best way 
to control the multitude of animation channels is the new function curve editor. Popular-
ized by Softimage, the function curve editor uses splines and lines to drive virtually every 
animatable function within ElectricImage. You can easily copy and paste different “enve-
lopes” between channels of totally different groups, or just the attribute next door. Com-
plex behaviors can be built up simply and easily. New explicit keyframes even give you 
independent control over the separate X, Y and Z axes which make up object translation. 
(See the Function Curve Editor chapter.)

New Rendering Features

Where to start? Light Projection Maps, Depth of Field, Glows, Displacement Mapping, 
Clipping Maps, Glare, Colored Light Rays, QTVR Object movies, QTVR Panoramas, New 
Lens Flares, New Procedural Shaders, New Map Filtering, Glow Maps, Transmission 
Effects, Fresnel Effects, New transparency types, and, of course, even faster rendering!
ElectricImage 2.8 Supplement        3



 

Introduction — New Look and Feel

        
New Look and Feel

In addition to all of the new features found in ElectricImage 2.8, parts of the user interface 
have undergone significant revisions to look and feel. In addition, virtually all of the func-
tions found in Electricimage have been significantly enhanced.

Many windows now sport a “folder tab” interface. These folder tabs enable many controls 
to be presented in a concise space, and have allowed us to clean up the interface experi-
ence quite a bit. Tab names reflect the tab contents as much as possible (space permitting, 
of course). To access a tab, just click on it.

Using Slider Bars

Many controls which allow ranges have been presented as a combination of edit boxes 
and slider bars. Many slider bars are set to “default” ranges, but some slider bars, ranges 
can actually be set by you. To do so, just type in a value greater (or less than) the value 
found in the edit box for the control. The slider bar will rescale to the new value. To reset 
the slider bar, just type in the original minimum or maximum value. 

Not all slider bars are rescalable. Those that are not will simply refuse any value outside of 
its operational range.
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New Color Picker

ElectricImage 2.8 contains a new color picker. This picker is dynamic, and offers several 
color models for your use.

Figure 1 — Color Picker displayed horizontally

The color picker is divided into several work areas. These work areas are where you can 
drag individual color pickers. You can have any or all color poickers in the work areas — 
the picker area will expand or contract to make room. You can also adjust the display of 
the picker to work in horizontal (show above) or vertical (the default form of presenta-
tion.) 

Overall, there are three basic color picker sections:

• Color Chips
• Picker Docking Area
• Color Picker Work Areas

Color Chips

The color chips show the Current color to the left, and the previous color to the right. If no 
changes were made, the colors contained within the chips will be identical.

Picker Docking Area

Unused color pickers are stowed in the docking area, next to the color chips. Pickers cur-
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rently in use are displayed darker in the Docking Area. Pickers available for use are pre-
sented normally in the docking area. To add a picker to the work area, just drag next to 
any existing picker. 

Color Picker Work Areas

The color picker is divided into several work areas into which pickers are placed. You 
drag pickers to the work area to use them. 

Adjusting Color Picker Display Orientation

To display horizontally, drag any picker to the right or left of another. You do not have to 
add a new picker to the work area to do this. To display vertically, just drag a picker to the 
top or bottom of another. In each case, the display will then switch over automatically.

Using the Color Picker

Each color picker uses a particular type of color method. There are three types of color 
pickers:

• Color Method
• Mixer
• Swatch

Color Method

Color methods are mathematical formulas for displaying colors on a computer. You are 
probably the most familiar with the RGB method (Red, Green, Blue). This is the most com-
mon method in use today for computer color. It is the same method used by all computer 
monitors to display color images.
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There are currently three color methods offered for your use:

• ARGB
• CMYK
• HSV

The default method presented when you first use the color picker is HSV (Hue, Satura-
tion, Value). This method is the closest method to the way that color works in the real 
world, and is the most common method taught in the creative arts.

To add another color method, select and drag the color method to the work area.

You can set colors with the scroll bars or enter a numeric value for a color in the edit boxes 
next to the scroll bars. Certain color methods allow you to choose between real number 
color values (0.0 to 1.0) or “byte” values (0 to 255) by checking the appropriate button.

Mixer

The mixer is a complete color presentation which lets you choose any color in the display. 
To the top of the mixer, all colors go to white. Full color saturation is in the middle, and 
darker colors are presented towards the bottom of the display. A gray scale display is pre-
sented at the bottom for easy selection.

Swatch

The color swatch area stores specific color entries. These are equivalent to the palettes in 

Adobe® Photoshop®, and the palette files which you can save in Photoshop can be loaded 
into ElectricImage. Each palette entry can be loaded with the swatch menu.
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Figure 2 — Swatch Popup Menu

The Swatch popup menu contains six entries. Each entry is a different type of palette:

• Load…
• System
• Black Body
• Gray Scale
• Spectrum
• Metals

Load…

This option allows you to load color palettes saved in Photoshop format. A file dialog will 
appear, prompting for the location of the palette file that you wish to load. Pick a palette 
from the items in the file list. The display will now update with the new palette.

System

This option will load the 256 color Macintosh system palette. Choosing this option will 
replace the previous palette.

Black Body

This option will load a 256 color palette which ramps from black, through red, to yellow, 
to white. Choosing this option will replace the previous palette.
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Gray Scale

This option will load a 256 shade gray scale palette. Choosing this option will replace the 
previous palette.

Spectrum

This option will display a 256 entry color spectrum. Choosing this option will replace the 
previous palette.

Metals

This option will load a 256 color palette which ramps from a low saturation dark blue 
gray to a low saturation cyan. Choosing this option will replace the previous palette.

To set the color selected in the picker, you must press the OK button. To refuse the color in 
the picker, press the Cancel button. The color picker is modal, which means that you will 
not be able to do anything else but pick colors while the color picker is visible. 

Project Window Changes

There have been several minor changes made to the project window, which are covered in 
the project window chapter. The most noteworthy change is that several new items are 
now displayed in the project window list. These items are:

• World Object
• Object Model Files
• Master Materials
• Animate Checkbox
• Velocity Enable Checkbox

All of these items are covered in detail in the Project Window chapter. We will briefly dis-
cuss the Object Model Files and the Animate Checkbox, as these items will be of immedi-
ate use to you.
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Object Model Files

As mentioned above, object model files are now displayed in the project window, where 
only groups were previously displayed. This change was necessary to correctly support 
the new morphing functions in ElectricImage. Morphs must often cross group boundaries, 
and thus require addressing geometry at a higher level than in previous versions of Elec-
tricImage. It became necessary to include the model list in order for the morphing features 
to work properly. You cannot directly do anything with the listed objects.

Animate Checkbox

You will note that you cannot actually animate an object by default (a preference under 
Keyframes will let you change this behavior). The animate checkbox in the project win-
dow must be active in order to create an animation for the object or attribute. The check-
box is on if the green arrow is visible. The default state of the animation record is off, in 
order to consume less RAM and improve performance. 

When creating an animation, there are many components in a scene which actually never 
animate. On occasion, you may accidentally move one of those parts, which causes the 
part to jump as it is rendered. Since most things in a typical scene will never move, the 
logical choice for this switch is off. Also, you can disable parts of your objects from ani-
mating. For example, you may not wish to move an object up or down, but rather just side 
to side. You could only activate the X and Z translation parameters, and not the Y, to con-
tain the animation to that type of motion only.

Parking

One last project window feature worth mentioning here is the parking control. “Parking” 
allows you to change the default orientation of a group, and then zero out the values (so 
that you are effectively starting from scratch.) This is extremely handy when matching 
bones to motion capture data. Motion capture data does not always have a “neutral” or 
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“index” position. Instead, the files often begin at frame 1, where the model is already in a 
certain stance or pose, with all of the further frames stored as an offset from the first 
frame. By matching the bones skeleton to your motion capture effectors, and then parking 
the bones in the skeleton, the space in which the bones operate will be within the motion 
capture file’s space — matching one to one. This is a big time saver.

What’s really going on here is that the transformations are being removed from the 
groups, and then reset with zeros. The groups are allowed to keep the new orientation as 
zero, simplifying everything.

Be sure to read the Project Window chapter for additional details on these new features.

Selection Sets

One of the coolest new features in ElectricImage are selection sets. Selection sets are 
named collections of groups for use in a variety of ways. For example, to use the new 
glow layers feature, you must specify a selection set to assign a glow effect to. Also, you 
can use sets to make large numbers of groups instantaneously visible or invisible, assign 
the to master materials, and so on. There are currently four uses for selection sets:

• Light exclusion/inclusion lists
• Camera map sets
• Glow layer sets
• Sets used just for convenience (sets used for easy selection with the selection menu.)

Selection sets are stored in the project file.
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New Preferences Window

All of the preferences found under the Edit menu have now been placed into one dialog 
window, with each preference item now presented under a separate tab. All of the prefer-
ences work the same as outlined in the Series 2 References and Supplements.

Figure 3 — New Preferences Window, with Preview & Render settings tab selected

More Reading…

Now that we have managed to whet your appetite, please continue on to the following 
chapters. Good luck!

The ElectricImage Team
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Assigning and Using Cameras

Introduction

There are two basic points of view in ElectricImage, world views and camera views. The 
world views present the project environment from a “creator’s” perspective. You see 
everything in the project through these views. They assist you in the creative process, 
allowing you a variety of perspectives in which to view and work within your project. 
Camera views are used to actually record the results of your animation. It is the camera 
through which your audience sees your work.

You can have as many cameras as you want in ElectricImage. Each of the cameras can 
have independent settings, although the resolution and image filtering settings are global 
for all cameras. These settings are covered in the Render Information Window chapter.

There are two ways to add cameras into your projects:

• Choose File>Add>Type>Camera

• Select an existing camera (in the world or project windows) and duplicate it

In order to speed screen redraws, cameras are presented in an abstract fashion in Electric-
Image, as illustrated below:

Camera

View Vector

Reference Point
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The camera control has three separate components that you can directly interact with:

• Camera (body)
• View Vector
• Reference Point

Camera (body)

The black rectangle represents the camera body. Regardless of the window’s zoom factor, 
the camera will always be presented at the same size for easy viewing and control. The 
shape of the body is designed for convenience. The actual focal point of the camera exists 
where the view vector intersects with the camera body. All of the position data for the 
camera body references this location.

View Vector

The view vector is the line drawn between the camera and the reference point. You can 
drag the entire camera control by this vector, leaving the orientation of the camera intact 
(a great time saver!) The distance between the camera body and the reference point, as 
represented by the view vector, is pertinent only when depth of field rendering settings 
are used.

Reference Point

Also called the target in some other programs, the reference point is the actual point of 
interest for the camera body. You can easily see and control the direction in which the cam-
era is pointing by dragging the reference point to the desired position.

Both the camera body and the reference point have their own motion paths, and can be 
animated independently. This might cause you to “over-animate” the camera, resulting in 
“digital whiplash.” The best way to animate the camera is either to animate only one of 
the positions (not always practical) or insure that the motion paths for each point roughly 
match, both in keyframe times, velocity, and path shape. You can use the function curve 
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editor to further adjust these factors (see the Project Window/Function Curve chapter for 

more information.) Of course, there are far more controls for cameras than just the control 
icon. Like all objects in ElectricImage, cameras have their own “info windows.” 

Figure 4 — Camera Info Window

Camera Info Window Overview

The camera info window contains all of the settings required to manipulate a camera in 
Electric Image, as well as view its current attributes. Each camera in a project maintains a 
separate set of parameters, found in its camera info window. There are two ways to access 
the Camera Info Window:

• Select the Camera and choose File>Get Info (or type  -I)
• Double Click on the Camera Icon in either the world views or project window

ElectricImage 2.8 brings a whole new look and feel to the Camera Info Window along 
with new features such as settings for explicit positioning, and depth of field as well as 
enhanced functionality in rotoscoping and projection mapping.
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General Camera Settings

In ElectricImage 2.8 the camera window has been divided into 5 folder tabs. On the left 
side are check boxes used for enabling the various methods of displaying the camera in a 
view window. The X-form tab displays the position of the camera and it’s reference point, 
as well as its current angle. The FOV tab is used for setting the focal length and field of 
view of the camera, as well as its shutter, and depth of field settings. The Roto/Comp tab 
is used for adding rotoscoping and compositing layers. The stereo tab allows for the ren-
dering of stereoscopic images. Finally, the Projection Map tab is where camera maps are 
applied, allowing for the projection of custom images onto geometry from a camera’s per-
spective.

Camera Display Options

On the left side of the camera window info are the display options which determine how 
the camera will be seen in the world view windows.

Show Angle

This checkbox toggles the display of the camera’s field of view angle in the world views. 
When enabled, it will project 2 lines outward from the center of the camera to the refer-
ence point. The area inside these lines represents the field of view of the camera. This is 
what will be “seen” by the camera and rendered. The size of this area is changed by alter-
ing either the Focal Length in the FOV window, or by changing the aspect ratio in the Ren-
der window. Refer to the Focal Length section that follows for more information on 
changing the camera’s field of view.

This display mode is very helpful for determining exactly which objects are within the 

field of view as you move the camera through the world view windows. 
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Figure 5 — Show Angle Result

Show Fog

This check box displays a projection of the fog radius used by the camera. This check box 
toggles the display of a fog region around the camera. The fog region is defined in the 
World object, listed in the project window. If no fog region has been defined, this check 
box will have no effect. The fog region is a spherical volume which emanates from the cen-
ter of any camera in the scene. With this option selected, two circles are drawn around a 
selected camera in the world view windows. The darker, outer circle shows the outer 
extent of the fog boundary. No fog is rendered past this boundary. The lighter, inner circle 
represents the inner part of the fog boundary. No fog is rendered until the beginning of 
this circle is reached. 

This fog type can be used for a “depth cueing” effect, wherein objects in the distance 
appear more hazy and clouded than objects in the foreground. (For a more detailed expla-

nation on fog, refer to the World Info Window chapter.) 

Field of View (FOV)

Camera

Reference Vector
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Show Stereo

When the Stereo rendering option is enabled, this checkbox provides a graphic display of 
the stereo separation parameters. Stereoscopic rendering creates two images for each 
frame in an animation, one for the left eye, and one for the right. Visually, this can be seen 
on the camera as a triangle (when using channel or reference convergence), or as an open 
box (when using infinity convergence). The base of the triangle or box, which emanates 
from the center of the camera, shows the amount of separation between left and right eye 
views in world units. The apex of the triangle or box shows the convergence point where 
the point of views of the two different images converge. (For more information on Stereo 

rendering refer to the Stereo rendering section below.)

Show Roto

This checkbox will cause any loaded background or foreground images to be drawn in the 
camera view window. These images are added to a camera via the Roto/Comp tab.

Show Map

This checkbox will cause any foreground image to be displayed in the camera view win-
dow.

Camera X-Form Tab

This tab is broken down into four sections:

• Camera Section
• Reference Section
• Roll, Pitch and Yaw Angles Section
• Roll Control
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Camera Section

The camera section contains the Key popup menu (for controlling camera interpolation) 
and three position edit boxes. These edit boxes list the current position of the camera, in X, 
Y, and Z coordinates, which can be changed by you at any time.

Reference Section

The reference section contains the Key popup menu (for controlling reference point inter-
polation) and three position edit boxes. These edit boxes list the current position of the ref-
erence point, in X, Y, and Z coordinates.

Roll, Pitch, and Yaw Angles Section

The camera can also be controlled through more traditional roll, pitch and yaw edit boxes, 
and are expressed in degrees. The order of the boxes is actually presented as Yaw (X), 
Pitch (Y) and Roll (Z), and equates directly to X, Y, and Z.

Roll Control

The roll control is interactive, and can be dragged to create roll angles. Its presentation is 
reminiscent of the roll indicator found in aircraft avionics.

Figure 6 — Camera X-Form Tab
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All of the numeric values presented in the edit boxes are dependent upon the editing 
mode set in the project window, and if the animate flag has been set for the camera object 
or a particular channel for the camera object. (For an explanation of editing modes in Elec-

tricImage, see the Electricimage Series 2 Reference Manual, Chapter 8, page 8-5)

In Index mode, changing the values updates the value for the current keyframe you are 
editing. Index mode only allows for the editing of previously generated keyframes, rather 
than for creating new ones, so it is only possible to alter an existing keyframe while in 
index mode.

In Frame mode, changing the values in the x-form window creates a custom frame with 
those new values. Custom frames have an underline mark below their values in the 
project window. Custom frames are not affected by the interpolation and velocity of the 
frames around them. They are fixed values which will be implemented without regard to 
any other keyframes. If you can picture a smooth curve, custom frames are like spikes jut-
ting out from the curve. They have no regard for the curve itself, or its shape (velocity). 
They simply pop to their value, and then return back to the curve when done. (For more 

information on custom frames please refer to the Frame mode in the Electricimage Series 2 

Reference Manual, chapter 8.)

In Keyframe and Time modes, changing the values in the x-form window either creates a 
new keyframe (if none exists at the current frame), or updates the values of an existing 
keyframe.

A new feature to Electric Image 2.8 is the ability to display keyframe values in either 
Implicit, or Explicit values. Implicit is the way that Electric Image has always displayed 
vectorized quantities. When the camera is set to implicit, it will work as it has in previous 
versions, where dragging the camera in a window controls two of its positional measure-
ments. The velocity is computed as a composite of these two vectors. For instance, by 
dragging a camera in the top view window, the X & Z coordinates will change, in the 
Front View the Y&X, and the Side View the Y&Z coordinates. Implicit controls always 
function on all axes simultaneously.
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When a camera or object is set to explicit positioning, a new option for controlling posi-
tional values becomes available. Using the function curve editor, it is possible to control 
the values and velocity for all 3 components of motion (X,Y,Z) independently. (For more 

information on using the curve editor please refer to the Function Curve Editor chapter.)

FOV Tab

This tab controls the camera focal length, shutter angle, and depth of field options. It is 
divided into three sections:

• Focal Length Section
• Shutter Section
• Depth of Field

Figure 7 — Camera FOV Tab

Focal Length Section

In actual photography, where an image is exposed onto film or captured on video, light is 
collected through the camera’s lens, and projected onto the focal plane. In film cameras, 
the focal plane is actually inscribed on the camera body, typically denoted by a circle with 
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a slash running down the middle.   The distance between the first lens element in the lens 
body to the focal plane is referred to as focal length. In all professional camera systems, 
lenses are interchangeable, allowing the operator to have a variety of focal lengths to work 
with. 

ElectricImage provides many controls to manage the lens characteristics of a camera. 
These controls are affected by the aspect ratio settings in the Render Info Window (dis-

cussed in the Rendering chapter.) The focal length section consists of the following three 
items:

• Focal Length Edit Box
• Field of View Edit Box
• Focal Mode Popup Menu

Focal Length Edit box

This edit box allows you to explicitly define the camera lens focal length. The number will 
change depending upon the aspect ratio setting in the Render Info Window. The default 
for that setting is “computer,” so the number that you are most likely to see is a floating 
point number, such as “1.0.” Changing the aspect ratio setting will result in a conversion 
of the number in the edit box to a new number. With the exception of the custom and com-
puter aspect ratio settings, the number in this box will be expressed in millimeters. This 
allows you to match real world lens types to real world photography formats. 

Note that if you do change the aspect ratio, the focal length will be adjusted to the new 

number, but the image in the viewing rectangle will appear relatively unchanged. Only 

the cropping areas will be affected, the image distortion will not.

The smaller the focal length, the wider the field of view. The larger the focal length, the 
narrower the field of view. Lenses with small focal lengths (6mm to 12mm) are called wide 
angle lenses, lenses with large focal lengths (75mm to 135mm) are called narrow or tele-
photo lenses, and those in between (16mm to 50mm) are considered normal lenses. Focal 
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length is directly proportional to the size any object will appear in the frame. If the dis-
tance to the object remains constant, and the focal length is doubled, the object will appear 
twice as large in the frame.

Field of View Edit Box

Field of View (FOV) determines how much of the scene when viewed through the camera 
lens is visible to the lens. This value is expressed in degrees. The FOV is directly related to 
the focal length of the lens, the focal mode popup menu (discussed following) and the 
selected aspect ratio. 

Many single lens reflex cameras (SLRs) include a 50mm lens. This lens most closely mim-

ics the human eye for this 8 perf 35mm format (8 perf is also called “Vista - Vision” for-

mat when applied to motion picture cameras.) The field of view for this lens is 

approximately 40˚ in the real world (depending upon differing specifications by camera 

and lens manufacturers.) It should be noted that ElectricImage presents these values in 

true mathematical space, while real world cameras and lenses are incapable of meeting 

these tolerances, and will often vary by one or two degrees.

Perspective distortion is also driven by both the focal length and Field of View. The 
smaller the FOV, the more distortion will appear, creating a wide angle effect. The larger 
the FOV, the less distortion will appear creating a telephoto effect. You can use extremely 
large focal lengths if you wish to negate the effects of perspective altogether. For example, 
you may wish to render a view with no perspective in order to create the basis for a tex-
ture map the closely conforms to the shape of the group.

Focal Mode Popup Menu

This menu determines how the focal length and field of view calculations are performed. 
There are three choices:

• Horizontal
• Vertical
• Diagonal
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Horizontal Focal Mode

This mode uses the sides of the frame to calculate the focal length and field of view. This is 
the default mode, and is the typical method for making such calculations in most motion 
picture camera systems.

Vertical Focal Mode

This mode uses the top and bottom of the frame as a basis to calculate focal length and 
field of view. Some computer imaging systems use this mode, but it is unlikely that you 
would need to.

Diagonal Focal Mode

This mode uses the frame diagonal as a basis to calculate the focal length and field of view. 
Many SLR cameras use this method.

Shutter Angle Section

All real world cameras have a shutter system. Film cameras have a physical shutter, and 
video cameras have electronic shutters. A shutter is used to create discreet frames, other-
wise all we would see would be smearings of color. Discreet frames are necessary for our 
perception of imagery in motion, made possible by a phenomenon called “persistence of 
vision.” It is this phenomenon that enables us to see the discreet frames on film (or video 
fields) as a continuous motion. 

Shutters actually keep parts of the film from exposing, rendering them black. A shutter is 
typically very fast, covering the focal plane for about half of the total exposure time. For 
example, in a 24 frames per second shot, the shutter will be closed for about 1/48 of a sec-
ond, and open for the same amount. During the time that the shutter is closed, the world 
is still moving. When the next frame is exposed, the subject matter will not necessarily be 
in the same place, and thus, its motion is imparted to the film.
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This section contains two controls:

• Enable Shutter Check Box
• Shutter Angle Edit Box

Enable Shutter Check Box

Use this check box to override the global shutter settings in the Render Info Window. If 
this box is enabled, the value in the Shutter Angle Edit Box for this camera will be used 
instead of the global value.

Shutter Angle Edit Box

Use this edit box to set the angle of the open shutter in degrees. In the real world, the shut-
ter angle would max out at far less than 360˚, otherwise the images recorded would not 
make any sense to us. However, ElectricImage provides a “virtual shutter” that can be far 
greater than 360˚. You can still view an image, because ElectricImage does not actually use 
a shutter to render the discreet frames, it does so automatically (one of the benefits of a 
synthetic camera!) As such, the shutter angle can be used for some really cool effects, such 
as ultra high speed motion (like a space warp drive.)

Instead, shutter angle is a major component of the motion blur effect. The size of the shut-
ter angle will dictate the amount of perceived motion blur along the following rules:
• Larger shutter angles produce longer blur streaks
• Shorter shutter angles produce shorter blur streaks

Note that shutter angle has no apparent effect on the Depth of Field function. It is 

included in this section as an animatable control for motion blur only.
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Depth of Field Section

3D programs like ElectricImage are all designed to mimic real world cameras, up to a cer-
tain point. The focal length section is used to approximate what a real world camera 
would see if the scene existed in our world. The basic physics are the same, with some 
added bonuses (such as, everything is always in focus.) Sometimes, however, that’s not 
what you want. New to ElectricImage 2.8 is the ability to perform depth of field rendering. 
Depth of field mimics a real camera, whereby images are blurred according to the focal 
settings of the camera. Depth of field is defined as the distance from the nearest object in 
sharp focus to the farthest object in sharp focus.   

Depth of field rendering is a multi-frame technique that requires the multi-frame button 

to be set in the Motion Blur tab of the Render window. For best results the number of Blur 

Frames should be set to 5 or higher.

The Depth of Field section contains five items used to control the options for this feature:

• Enable Focus Check Box
• F-Stop Edit box
• Focus Distance Edit box
• Distance Popup Menu
• Multi-frame Pixel Offset

Enable Focus Check Box

This check box enables the depth of field feature. It must be selected in order for the effect 
to be created.

F-Stop Edit Box

Use this edit box to set the f-stop for the camera lens. In real world terms, the light gather-
ing power of a lens is called the speed of the lens. The more light that is available to a lens, 
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the larger the area it is able to keep in focus (the depth of field). This is expressed as an f-
number, or f-stop. This number is the ratio between the focal length of the lens and its 
diameter (the aperture):

As the lens diameter increases, so does the amount of light that passes through. As the 
focal length increases, the light is dispersed over a greater area and the amount of light 
available decreases. This is often expressed as a faster lens allowing more light through, 
and a slower lens allowing less light. Lenses of about f/2 and lower are considered fast. 

Additionally, inside the lens is an iris diaphragm which can open or close to change the 
amount of available light. Thus, the actual term, f-stop, is determined by a series of 
“stops” along the lens aperture:

The standard series of stops is: 1, 1.4, 2, 2.8, 4, 5.6, 8, 11, 16, 22, 32. Each stop represents the 
halving (or doubling) of the amount of light that the lens passes. At low f-numbers, the 
diaphragm is open wider and more light enters the lens.

As in actual photography, smaller f-stops result in a shorter depth of field. Objects outside 
of the focus distance will appear soft and out of focus. Larger f-stops will result in a longer 
depth of field. Objects outside of the focus distance will be in sharper focus. Unlike real 
world cameras, the actual amount of light required to illuminate the scene will not 
change. Only the depth of field will be affected, not exposure.

f-stop=
focal length

lens diameter

f-stop=
focal length

diameter of lens aperture
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Focus Distance Edit Box

This edit box determines the distance from the camera in which the object will be in sharp 
focus. Objects not in the area of the focus distance will appear out of focus, depending 
upon the f-stop setting. The focus distance can also be set to use the reference point of the 
camera. This is controlled by the distance popup menu, covered below. If the reference 
point method is used, the value in the Focus Distance Edit Box is ignored.

Distance Popup Menu

The two options in this popup menu selects the method for calculating the depth of field:

• By Channel
• By Reference

By Channel

When setting the focus distance by channel, the focal target is determined by the value 
entered in the Focus Distance edit box. This value emanates from the center of the camera, 
and is expressed in world units. For instance, a number of 50 would focus the lens on an 
object 50 units from the focal plane of the camera.

By Reference

When setting the focus distance by reference, the focal target is the end point of the refer-
ence vector. This provides an easy way to determine exactly what the focal object is. Just 
drag the reference vector out or in until it is sitting over your target object. This is the 
default method.

Multi-frame Pixel Offset

This value represents what is known as the circle of confusion. The point at which the 
focus distance is set, is said to be the area of critical focus. Everything on this plane is in 
focus. Objects that are nearer and farther from this point are said to be in the circle of con-
fusion. Depending on the f-stop and focal length, many of these objects will also be in 
variable states of focus even though they aren’t located at the exact focus distance. 
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For example, when the focus distance is set at 15 units, we might find that the depth of 
field where objects remain in focus ranges from 12 units to 20 units. Thus, the total depth 
of field here would be 8 units. Since “being in focus” is a subjective judgment, in order to 
determine what is defined as in focus, a permissible circle of confusion must be set; the cir-
cle of least confusion. In ElectricImage, this value is the multi-frame pixel offset, and it 
uses this number to determine the acceptable range of sharpness when performing depth 
of field calculations. The following rules apply:

• Smaller offset values produce sharper images
• Larger offset values produce blurrier images

Effectively, the offset is an additional control to determine how blurry the objects in the 
scene will appear.

Roto/Comp Tab

Rotoscoping (“roto”) is a term used to describe the process of incorporating information 
from previously exposed (or rendered) footage into a shot. One might wish to match the 
camera movements or other objects from live action footage, or have a rendered model 
follow the movements of an actor. Compositing (“comp”) is a process of including fore-
ground or background images or movies into your rendered scene. Composite layers are 
added above the 3D action you create in ElectricImage, and background layers appear 
behind your renderings in the final image or movie. In order for compositing to work 
properly, the images or movies that you use will need to contain an alpha channel mask. 

Your roto and comp footage can be any resolution, but it is best to match the final resolu-
tion to which you are rendering. If your background or foreground maps are smaller than 
your target render resolution, then they will be enlarged. This will reduce the quality of 
the images used for compositing. If the footage is a greater resolution, then the footage 
will be down sampled to fit in the image rectangle. This will not decrease the quality of 
the imagery used for compositing, but will add somewhat to the render time.
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The Roto/Comp tab contains controls which allow for background and foreground image 
compositing within a rendering, and display of these images in the camera view window. 
There are several items in this tab:

• Render Rotoscope/Composite Check Box
• Background Map List
• Foreground Map List
• X-Form Tab
• Properties Tab
• Info Tab
• Crop Tab 

Figure 8 — Camera Roto/Comp Tab

Render Rotoscope/Composite Check Box

This check box enables the images in the background and foreground map lists to be ren-
dered and/or composited into the final image. (Maps can also be individually enabled or 
disabled within the map lists.)
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Background Map List

This list contains all of the images used as backgrounds for the active camera. Each cam-
era renders its own map lists separately — what appears in the background list for one 
camera will not be present for another, unless you insure that the lists are the same for 
each camera. Each image can be enabled or disabled by clicking the active icon next to the 
name of the map. The background maps will appear in the final rendered image only if 
the active icon next to the image name in the list is present, and the Render Rotoscope/
Composite check box is enabled. Background images can be animated and scaled in XY 
screen space with the X-form tab next to the map list.

To add a background image to the list:

• Click the Add button
• Choose an image or movie from the file list
• Click the Open button

The background image you selected will now appear in the list.

To delete a background image from the list:

• Select the image
• Click the Delete button

The image will be removed from the list.

You can reorder the maps in the list by dragging the map to its desired location. You can 
Edit>Copy (command-c) and paste maps between lists by selecting the map and choosing 
copy, then selecting the destination map list, and choosing Edit>Paste (command-v). 
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Maps will be layered by the order in which they appear in the list. If the maps do not have 
alpha channel masks, then the top-most map will be the only map that will appear as a 
background image for this camera. 

Foreground Map List

This list contains all of the images used as foregrounds for the active camera. Each camera 
renders its own map lists separately — what appears in the foreground list for one camera 
will not be present for another, unless you insure that the lists are the same for each cam-
era. Each image can be enabled or disabled by clicking the active icon next to the name of 
the map. The foreground maps will appear in the final rendered image only if the active 
icon next to the image name in the list is present, and the Render Rotoscope/Composite 
check box is enabled. Foreground images can be animated and scaled in XY screen space 
with the X-form tab next to the map list.

To add a foreground image to the list:

• Click the Add button
• Choose an image or movie from the file list
• Click the Open button

The foreground image you selected will now appear in the list.

To delete a foreground image from the list:

• Select the image
• Click the Delete button

The image will be removed from the list.
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You can reorder the maps in the list by dragging the map to its desired location. You can 
Edit>Copy (command-c) and paste maps between lists by selecting the map and choosing 
copy, then selecting the destination map list, and choosing Edit>Paste (command-v). 

Maps will be layered by the order in which they appear in the list. If the maps do not have 
alpha channel masks, then the top-most map will be the only map that will appear as a 
rendered image for this camera, hiding any 3D objects that you intended to render. 

Note — to view any image in the background of the Camera window, the option to show 

the image must be on (found in the Roto/Comp Properties Tab, Show in Camera View 

check box) and the Paint Image button must be set to the image name desired.

The following illustration indicates the roto/comp controls that are displayed in the cam-
era view window. These controls are visible only when the option to display an image in 
the camera view is active.

Paint Image Icon

This icon will draw the foreground/background image in the camera view. To use click on 
the button. A popup menu will appear, with the names of the loaded images listed. 
Choose the image that you wish to view. You cannot preview composites in this window. 
You must perform a “preview snap” rendering or complete rendering to do so.
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Figure 9 — Camera View Roto/Comp View Tools indicated

Frame Number

This box displays the current frame number. If the Sync with Time option is selected in the 
Roto/Comp Properties Tab, then this number will match the current frame number of the 
project.

Scroll Bar

The scroll bar allows you to scroll through the movie file to find the appropriate frame for 
use. This bar will have no effect on a single frame image.

Roto/Comp X-form Tab

This tab provides position, scale and alignment information used by the currently selected 
map in either list. Each map in each list can be positioned, scaled and aligned indepen-
dently from the others. These functions are presented in 3 areas in the X-form tab:

Paint Image Icon Frame Number Scroll Bar
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• Position Edit Boxes
• Scale Edit Boxes
• Alignment Popup Menu

Figure 10 — Roto/Comp Tab Foreground/Background Image X-form Tab

Position Edit Boxes

These boxes control the position of the selected image in either of the foreground or back-
ground map lists. Maps can be positioned in X and Y space only (acting as flat layers.) The 
default value of 0.0 will place the map in the center of the frame. X and Y values of 1.0 or 
greater for each position attribute will place the map offscreen (Values may may vary 
depending upon the aspect ratio of the map as it relates to the rendered image.)

Scale Edit Boxes

These boxes control the scale of the selected image in either the foreground or background 
map lists. The default scale of 1.0 fits the map to the extents of the rendered image rectan-
gle. The alignment popup, covered below, governs which axis is used as the “fit” axis, that 
is, which axis is used to fit correctly into the frame at a scale of 1.0. Values of less than 1.0 
in will reduce the size and values greater than 1.0 will increase the size of the image.
ElectricImage 2.8 Supplement        35



Assigning and Using Cameras — Roto/Comp Tab
Align Popup Menu

This menu is used to determine how the map will fit into the rectangle of the rendered 
image. There are three choices:

• Both
• Horizontal only
• Vertical only

Figure 11 — Align Pop Up Menu

Both

This option will fit both axes of the image into the aspect ratio of the rendered image rect-
angle. If the aspect ratio of the image does not match the aspect ratio of the rendered 
image rectangle, the image will appear stretched or squeezed.

Horizontal Only

This option will fit just the horizontal axis of the background or foreground image into the 
rendered image rectangle. The vertical axis may extend past the rendered image extents or 
end within view of the frame if the aspect ratios of the foreground/background image 
doesn’t match the rendered image rectangle.

Vertical Only

This option will fit just the vertical axis of the background or foreground image into the 
rendered image rectangle. The horizontal axis may extend past the rendered image 
extents or end within view of the frame if the aspect ratios of the foreground/background 
image doesn’t match the rendered image rectangle.
36       ElectricImage 2.8 Supplement    



Assigning and Using Cameras — Roto/Comp Tab
Roto/Comp Properties Tab

This tab is used to control the foreground/background image rendering and display 
properties. This tab is comprised of several items:

• Camera View Section
• Image Tiling Section
• Anti-Alias Check Box
• Invert RGB Check box
• Invert Alpha Check Box
• Samples Edit box
• Blur Edit Box
• Opacity Edit Box

Figure 12 — Roto/Comp Properties Tab

Camera View Section

This section contains controls which govern the display of the foreground/background 
image in the camera view window. There are three sub items listed in this section:

• Show In Camera View Check Box
• Synchronize with Time Check Box
• Display Mode Popup Menu
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Show in Camera View Check Box

This control enables the display of the image in the camera view window.

Synchronize with Time Check Box

This control insures that the foreground/background images will match the time refer-
ence of the project scene time.

Display Mode Popup Menu

This popup menu determines which channels of the image will be displayed in the cam-
era view window. This feature does not affect the rendering quality of the foreground/
background images. There are four choices:

• RGB Only
• Alpha Only
• RGB + Alpha
• RGB + Color

RGB Only

Displays only the RGB channel of the foreground/background image in the camera view 
window. If the image has an alpha channel, then the display of the image in this mode will 
appear to have ragged edges (the anti-aliasing information is in the alpha channel).

Alpha Only

Displays only the Alpha (mask) channel of the foreground/background image in the cam-
era view window.

RGB + Alpha

Displays a properly anti-aliased foreground/background image in the camera view win-
dow. (Uses the alpha channel information to mask in the RGB channel.)
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RGB + Color

Displays the RGB channel of the image with the selected background color (set in the 
World Info Window).

Image Tiling Section

This section contains two popup menus which control the way the foreground/back-
ground images are tiled when viewed or rendered. There are four choices:

• None
• Hold
• Repeat
• Mirror

None

Disables mirroring of the the image on the specified map axis. Choosing None for both 
axes will cause the image to be displayed only where you positioned it, nowhere else.

Hold

Applies the colors found at the image edges outside of the actual image rectangle. (The 
image will appear once as positioned, with the border colors of the image extending 
beyond the image rectangle, covering the frame.)

Repeat

Repeats the image along the specified axis. Choosing Repeat for both axes will cause the 
image to repeat continuously.

Mirror

Mirrors the image along the specified axis. Choosing Mirror for both axes will cause the 
image to flip flop about both axes.
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Anti-Alias Check Box

This check box enables foreground/background filtering. If you are not scaling your fore-
ground/background images, and if they match the aspect ratio of the rendered image 
rectangle, then this setting can be disabled.

Invert RGB Check Box

This option will negate the RGB color space of the image.

Invert Alpha Check Box

This option will negate the alpha channel of the image. This is useful if you decide that 
you need to mask the area opposite of that represented by the alpha channel.

Samples Edit Box

This edit box lets you determine the sampling quality of the image. The default is 5.0. 
Numbers greater than 5 will cause the image to be sampled more often, slowing down 
render time, but increasing the quality of the image. Numbers less than 5 will cause the 
image to be sampled less often, speeding up render time, but decreasing the quality of the 
image. Numbers greater than 10 might be prohibitively slow. 5 is a good default, and you 
will likely not need to deviate from that amount.

Blur Edit Box

This edit box lets you blur the image. The default is 1.0. This value will present the image 
as is. Values of greater than 1.0 will blur the image. For example, a value of 2.0 will pro-
duce a blur of two pixels for every one encountered in the image. Values less than 1.0 will 
sharpen the image, although it will also introduce aliasing (jagginess) into the image.

Opacity Edit Box

This edit box controls the opacity of the foreground/background image. The default is 1.0, 
where the image is completely opaque. Values of less than 1.0 will make the image more 
transparent, ending at 0.0 where the image will be invisible. Values of greater than 1.0 are 
ignored.
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Stereo Tab

The stereo tab is used to set up stereo image rendering in ElectricImage. This technique 
lets you create true “3D” images, when properly assembled and viewed through polar-
ized glasses. (ElectricImage does not support the anaglyph (red/blue) stereo effect, just 
“right eye/left eye” stereo.) To accomplish this, ElectricImage creates separate image files 
for each eye. You will need a third party program to assemble the images into viewable 3D 
imagery or movies.

The stereo tab consists of a few simple controls to accomplish the stereo effect:

• Enable Check Box
• Stereo Separation Edit Box
• Stereo Convergence Edit Box
• Convergence Popup Menu
• Render Popup Menu

Figure 13 — Stereo Tab

Enable Check Box

This box enables the stereo effect. You can play with settings without actually rendering 
them by disabling this check box.
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Stereo Separation Edit Box

This edit box controls the distance between the two cameras. (If you would like to see the 
distance indicated on the camera, enable the “Show Stereo” check box in the Camera Info 
Window’s Camera display control area to the left of the window.) The default value is 1.0. 
This may or may not be appropriate for your needs. Essentially this control is attempting 
to duplicate the distance between the human eyes. How much scale you want something 
to have will depend upon the size of this value. Unfortunately, the relevance of this num-
ber is directly related to the scale of the objects in your scene, so we can offer little guid-
ance here.

Stereo Convergence Edit Box

This edit box controls to focus point of the stereo effect. Beyond this point, no depth will 
be perceived. This value is used only if the Convergence Popup Menu is set to “By Chan-
nel.”

Figure 14 — Convergence Popup Menu

Convergence Popup Menu

This menu controls the type of convergence that will be used when the scene is rendered. 
There are three choices:

• By Channel
• By Reference
• In Infinity

By Channel

Causes the stereo effect to use the value found in the Stereo Convergence Edit Box.

By Reference

Causes the stereo effect to use the reference point as the point of convergence.
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In Infinity

The perception of depth will extend into infinity.

Render Popup Menu

This menu controls what image files are created at render time (if any) for the stereo effect. 
There are four choices:

• Normal
• Left Only
• Right Only
• Left & Right

Figure 15 — Stereo Render Popup Menu

Normal

This option will render the scene normally, producing only one, “flat” image file.

Left Only

This option will render an image file for the left eye position only.

Right Only

This option will render an image file for the right eye position only.

Left & Right

This option will render two image files, one for each eye. In this instance, render times will 
be twice as long, as complete scenes for each eye must be rendered.
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Projection Tab

This tab is used to control map projections from the camera position. A projection map is a 
texture than can be projected onto many groups at once from the same location in space. 
Both lights and cameras can project maps. Lights project maps exactly like a slide or 
movie projector. Camera projection maps work a little differently. These maps are typi-
cally projected onto objects which are fully self-illuminated (meaning that the objects are 
always at full brightness, as are any maps applied to them.

Here’s a real world analogy to this process — imagine that you have a photograph of a 
building. The camera is inside of an alcove, with walls on the sides, and an arch to the 
rear. Now, imagine that you have a model that is roughly scaled to the objects in the pho-
tograph. In essence, you have walls and then an arch at the end of the walls. The model is 
painted white to accept the slide of the photo. Now, setup a slide projector that can project 
the photo onto the model. Position the projector so that it approximates the position of the 
camera that took the original photograph. As you bend down and look at the model from 
the same point as the slide projector (or as close as you can get to the lens) what you 
would see would appear to be very close to the original photo. However, the farther away 
from the projector that you move — either side to side, up or down, or in and out — you 
would notice that what you are seeing is almost a true 3D representation of the original 
photo! This is a special effects technique that has been used for many years.

The first known use of this technique on a computer was performed by Mr. Yusei Usegi, 
an extremely talented matte painter, on the film “Hook.” He painted an overhead view of 
the Neverland Island, and had the computer department create a rough model of the 
island and ocean. As the map was project from his point of view created in the painting, as 
soon as the recording camera moved off axis, the painting suddenly appeared to have a 
three dimensional feel. Since then Mr. Usegi and a variety of very talented artisans have 
used this technique to great effect in such films as “Spawn,” “Star Wars Trilogy Special 
Edition,” “101 Dalamations,” and so on.
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The true benefit of camera projection maps is that in many cases what would have 
required complex models before can now use rather simple models. The complexity 
instead is found within the details of the painting — a process many find easier than mod-
eling.

The Way it Works

Camera maps are applied to either all groups in a scene or groups within selection sets. 
(See the Selection Sets chapter for more information on selection sets.) Each map in the 
list can be set to project in different manners (“applied as”), and each map can be set to 
project to a different selection set (“applied to”). Typically, camera projection maps are 
applied as “luminance” maps (the default), so that the map appears at full brightness. 
This method allows the scene that is rendered and the original map image to have the 
same brightness levels. In other words, the rendered scene would look like the photo-
graph of the map. It is not uncommon to also use clip and transparency map methods to 
isolate elements in the map image, such as people, trees, or other details.

After applying a camera map and aligning the projecting camera, you should lock the pro-
jecting camera, so that registration is maintained.

Figure 16 — Camera Info Window Projection Map Tab
ElectricImage 2.8 Supplement        45



Assigning and Using Cameras — Projection Tab
The Projection Map tab consists of three items:

• Camera Map List and Controls
• Camera Map Applied As pop up menu
• Camera Map Applied To pop up menu

Camera Map List and Controls

The camera maps list is where you add camera projection maps. You can put as many 
maps as you like in this list. Maps can be single frames or movie files, and can be any bit 
depth desired.

To add a camera projection map to the list:

• Click the Add button next to the Camera Map list
• Select a map from the file list
• Double click the map, or press the Open button

The camera map will be added to the list. To configure the map, double click on the map 
name in the list. To reorder the map in the list, just drag it to its new location. (See the 

Materials and Textures chapter, section “Using Texture Maps” on page 178 for more infor-

mation on working with maps in the map list.)

To delete a camera projection map from the list:

• Select the map from the file list
• Click the Delete button next to the Camera Map list

The map will be removed from the list.

Camera Map Apply As Pop Up Menu

This menu allows you to set the method in which the map will be applied to items in the 
selection set. All map channel methods described in the Materials and Textures chapter 
are found here. You can use any of the methods that you wish, although in practice you 
may find just the few described above to be of any real use in the map projection process. 
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Figure 17 — Camera Map Apply As Pop Up Menu

There are eleven methods in the list in which the map can be applied. Applying camera 
maps to any of these channels acts as if the map has been applied to that group’s corre-
sponding material channel (see the Materials and Textures chapter for a full explanation 

of map properties):

• Bump/Displace
• Clip
• Diffuse
• Specular
• Ambient
• Reflection
• Reflectivity
• Transparency
• Luminance
• Glow
• Transmission
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Bump/Displace

The projected map will act as a bump/displacement map for the items listed in the 
Applied To pop up menu. This option is not typically used as a camera projection map.

Clip

The projected map will act as a clip map for the items listed in the Applied To pop up 
menu. This is option is great for isolating elements easily by masks.

Diffuse

The projected map will act as a diffuse map for the items listed in the Applied To pop up 
menu. This option is not typically used as a camera projection map, as the groups receiv-
ing a camera map from this method would shade normally, without self-illumination. (in 
other words, requiring standard scene lighting) 

Specular

The projected map will act as a specular map for the items listed in the Applied To pop up 
menu. This option is not typically used as a camera projection map.

Ambient

The projected map will act as a ambient map for the items listed in the Applied To pop up 
menu. This option is not typically used as a camera projection map.

Reflection

The projected map will act as a reflection map for the items listed in the Applied To pop 
up menu. This option is not typically used as a camera projection map.

Reflectivity

The projected map will act as a reflectivity map for the items listed in the Applied To pop 
up menu. This option is not typically used as a camera projection map.
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Transparency

The projected map will act as a transparency map for the items listed in the Applied To 
pop up menu. This option might be useful for some effects, or to isolate some elements of 
target groups.

Luminance

The projected map will act as a luminance map for the items listed in the Applied To pop 
up menu. This is the default setting, as it allows for the projection map and the original 
image to have the same brightness (in other words, the rendered image will appear virtu-
ally identical to the original map image in terms of brightness). 

Note that the groups receiving maps from this method do not accept shadows when this 

setting is used. Self-illumination means that the groups are effectively not shaded, rather 

presented at full brightness levels. If you wish to cast shadows from other scene groups 

upon a projection mapped group with this method, you will be required to render an addi-

tional image, with the same groups, but with the map projections disabled, and the group 

shadow settings for the projection mapped groups (found in the group info window, 

shadow tab) set to “generate shadow mask.” You would then need to composite the two 

images together, using the projection mapped image as the background, and the shadow 

mask image as the foreground.

Glow

The projected map will act as a glow map for the items listed in the Applied To pop up 
menu. This option is not typically used as a camera projection map.

Transmission

The projected map will act as a transmission map for the items listed in the Applied To 
pop up menu. This option is not typically used as a camera projection map.
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Camera Map Applied To Pop Up Menu

This menu determines which groups in the scene will receive the selected camera projec-
tion map. There are three choices for this menu:

• None
• All
• “Set List”

None

No groups in the scene will receive the selected camera projection map.

All

All groups in the scene will receive the camera projection map. This option should be used 
if you will not be introducing items that are not intended to be components of the map, as 
every group in the scene will receive the map projection.

“Set List” 

Actually, after the All menu item, you will see the entire list of selection sets that exist 
within the project. If no selection sets exist, then there will be no items presented after the 
All menu item. Selection sets are the most controllable way of using camera projection 
maps. By use of a set or series of sets, you can determine exactly which groups will receive 
the selected camera projection map. Using sets, you can mix and match groups which do 
and do not receive projection map effects.

All of the maps can be further adjusted using the standard set of texture mapping tools. 

See the Materials and Textures chapter, “Using Texture Maps” on page 178 for further 

information.
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Using and Animating Groups

Introduction

In ElectricImage, geometry that is animated and rendered are referred to as groups. Typi-
cally, a single group corresponds to a single layer or object within a model file. Groups can 
exist as independent entities, or within a hierarchy. Groups can be translated (moved, 
rotated and scaled), deformed, have its materials animated, and so on. Groups can be 
imported from other programs (into the native ElectricImage FACT format) or the Elec-
tricImage Modeler, or be created by a variety of plug-in programs. A group can have as 
many as 250 or more animation channels, many of which can be individually enabled or 
disabled (others by the class of animation channel). Each channel can be controlled inde-
pendently by you. All of the channels can be placed into the function curve editor for ani-
mating, or you can pick individual channels. (See the Project Window/Function Curve 

chapter for more information.) 

Each group can contain an unlimited amount of points, lines and polygons and texture 
maps. There are no limits to the amount of groups that you can have within a project, 
memory permitting.

To add a FACT model into a project:

• Choose File>Add>Model>FACT…
• Select the Model name from the file list
• Double click or press the Add button
• Click the Done button when finished

The model will now appear in the world view windows, and the file name of the model 
will appear in the Model File section of the Project Window. The model’s groups will 
appear in the group section of the Project Window.
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Model formats from other programs can be imported into ElectricImage. There are cur-
rently over 30 different import formats supported.

To import a model into a project:

• Choose File>Add>Model>Other…
• Select the Model name from the file list
• Double click or press the Add button
• Click the Done button when finished

The model will now appear in the world view windows, and the file name of the model 
will appear in the Model File section of the Project Window. The model’s groups will 
appear in the group section of the Project Window.

There are several import options available to you. These options are covered in the Elec-

tricImage Series 2 Reference Manual, pages 1-22 through 1-30.

In addition to adding and importing models into ElectricImage, you can also create font 

models from Adobe® PostScript® Type 1 fonts or Apple® TrueType™ fonts. The font out-
lines are converted into polygons, and depending upon your choices, extruded into 3D 
and even bevelled.

To add a 3D font into a project:

• Choose File>Add>Model>Font…

• Select a Font from the file list (a font does not need to be installed in the system in 
order for it to be converted into 3D — the fonts can reside on any disk)

• Type in the font letters that you desire in the edit box
• Set the extrusion height and bevels and element colors (if desired)
• Click the Add button
• Save the font model
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The font model will now appear in the world view windows, and the file name of the 
model will appear in the Model File section of the Project Window. The model’s groups 
will appear in the group section of the Project Window.

For more detailed information on importing PostScript Type 1 and True Type fonts, see 

the ElectricImage Series 2 Reference Manual, pages 1-17 to 1-21.

As mentioned previously, groups can exist individually, or as part of a hierarchy. Hierar-
chies enable complex motions to be created, using groups linked in “chains” or “trees.” 
Hierarchies are also required if you wish to animate your groups with inverse kinematics. 
For more information on these topics please consult the following chapters:

• Effectors
• Hierarchies and Constraints
• Group Linkage Window

Group Info Window

Like all other object classes in ElectricImage, groups have an information window associ-
ated with them that allow you to control a variety of options. The group info window con-
tains basic non-material attributes for the group (such as position, rotation, scale, and so 
on), as well as an access point to the group’s material record. (See the Materials and Tex-

ture Maps chapter for more information.) Like so much else in ElectricImage 2.8, the 
Group Info Window has undergone a complete overhaul. The window has many familiar 
elements from previous versions, but it also has quite a few enhancements. Like many 
new interface enhancements, the group info window is divided into conveniently orga-
nized folder tabs, each containing the controls and functions indicated by the name of the 
tab. To access the contents of a tab, just click on it.
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The group info window is divided into the tab section, Material ball icon, and configura-
tion check boxes. The four folder tabs are:

• X-Form (Transformation)
• Shading
• Shadow
• Info

Figure 18 — Group Info Window

Base Options

Figure 19 — Material Ball

On the left side of the window you will see either two or four options, depending on what 
type of object it is. They are not linked under a folder tab, and remain visible at all times.
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Show Extent Box

This checkbox toggles on and off the display in the project windows of group bounding 
boxes.

The Material Ball

The material ball shows shading properties that are set for the current group (it is does not 
show texture maps or procedural shaders.)

The following two options will only appear if the group’s geometry is generated by an 

active plug-in.

The Plug in Button

When a group is comprised of data generated by a plug-in, clicking this button will open 
the plugin’s configuration window. 

Live Plug in

This checkbox toggles on and off the active recalculation of a plugin’s parameters when 
the time thumb is moved (a great time saver.) 
For example, if you have a Mr. Nitro group in your project, every time you move the time 
thumb Mr. Nitro will recalculate the position of the group’s fragments.   A particle system 
will do exactly the same thing. Unchecking Live Plug-in will disable this calculation, 
removing the need for you to type  -. (Command-Period) to prevent recalculation.
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The X-Form Tab

Figure 20 — X-Form Tab

The X-Form (Transformation) Tab contains spaces which contain X, Y, and Z values for the 
four geometric transform values of a group: 

• Position
• Rotation
• Center
• Scale

Each of these values functions exactly the same as they did in previous versions of Elec-
tricImage. (See the ElectricImage Series 2 Reference Manual, chapter 13, for more informa-

tion.)

In the position and scale sections, you will see a popup menu where you can select 
Implicit or Explicit keyframe interpolation. The following section will explain the differ-
ences in these two types of interpolation. Following this section we will continue with the 
explanation of the Group Info Window.
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Implicit and Explicit Interpolation

As you may have already noticed, all vectorized quantities in ElectricImage (position, ref-
erence, center, etc.) now have an extra pulldown menu in their info windows. This pull-
down controls whether the quantity is Implicitly or Explicitly translated. Implicit 
translation is what you have been using in past versions of ElectricImage. Explicit transla-
tion allows separate control in our new curve editor for each of the three components 
(X,Y,Z).

Implicit Translation Example

Figure 21 — Top View in ElectricImage

The illustration above shows us the top view of a basic motion path, as you were used to 
seeing in prior versions of ElectricImage. 

The Camera's motion path, as seen above is really a composite of the Z and X channels of 
the Camera motion path transform. When you drag the Camera in the top view, the Z and 
X values change but Y does not. Velocity is computed on the composite vector (The vec-
tors of X and Y.) There is no curve available to adjust one of the three components by itself.
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Explicit Translation Example

By making the Camera's transformation Explicit, velocity calculations are removed and 
you are free to independently manipulate the three component vectors of the motion 
(X,Y,Z).

To make an object’s Translation explicit:

• Open the Group Info window for a given object. Make sure that the X-Form window 
is in the foreground.

• Change the translation of the particular Transformation characteristic from Implicit to 
Explicit.

The illustration below shows the Position translation being changed to Explicit.

Figure 22 — Changing Implicit to Explicit

The translation value for the object’s position is now explicit. Repeat these steps for any 
other value to change its transformation.

The Shading Tab

The shading tab contains attributes which let you specify the shading behavior of the 
group. 
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Figure 23 — Shading Tab

The Shading Window is divided into seven sections:

• Fog Section
• Reflection Section 
• Line Section
• Blur Section
• Color Section
• Geometry Section
• Shading Pop up Menu Section

Fog Section

Fog Enable

This checkbox enables the group to be affected by any of the global fog settings in the 
World Info Window’s Fog Tab. When this box is unchecked, the object will not be affected.
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Reflection Section

The items in this section are pertinent only when automatic reflections such as mirror or 
environment maps are used somewhere in the scene. They are otherwise ignored.

Cast No Reflection

Enable this check box if you don’t want the group to cast a reflection onto another group. 

Reflection Object Only

Checking this box will force the group to not render in the scene, but other objects will be 
able to see it in their reflections.

Line Section

The attributes in this section affect wireframe shading options only. They do not affect the 
cell/outline shader settings found in the geometry tab of the Material Info Window. (See 

the Materials and Texture Maps chapter for further information.)

Shade Lines

When a group’s shading popup is set to wireframe, this check box enables the material 
attributes assigned to the group to actually shade the wireframes of the group. Very cool.

Line Size (pixel)

Use this value to set the line thickness in pixels for wireframe shading. A value of 0.0 will 
use the global line thickness settings in the Render Information Window instead.
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(Motion) Blur Section

Blur Mode Popup

There are three options for motion blur for every group:
• None
• Point /Line
• Motion Vector

None

No blur is used for the group (default)

Point/Line Motion Blur

This blur option should be used if you wish to blur groups containing points and lines. 
The line size value is also used by this option when active.

Motion Vector Blur

A very high quality fast motion blur that most closely approximates real photographic 
motion blur. This setting is the best to use in about 90% of the cases you will come across. 
At times, the effect does break (such as a fan inside a cage). At those times, you can set the 
Motion Vector setting at the group level, and choose both the Frame Multisample (set the 
sample value to 2 and increase as necessary) and Motion Vector settings (use the default) 
in the Render Information Window. The combination of these two blurs can usually sat-
isfy all but the most ardent critics!

Color Section

Smooth Across Faces

Enables the shading of the group to smoothly blend across the faces that make up the 
group’s shape. If you want to see the individual faces defined, disable this check box.
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Color Blend

Blends the color of the vertexes of the group together. Typically, the vertexes of a group are 
a single color, rendering this option useless. However, you can create some nifty special 
effects if you have the ability to color individual polygons (most modelers do) and use this 
feature. For example, you can create a tail cone of a jet with black colored polygons 
around the edge of the cone closest to the outlet, and the color the polygons around the 
section closest to the body gray. Enable this checkbox and shade. See how the colors blend 
together? For added realism in this example, don’t color all of the polygons black around 
the outlet, leave some gray. It looks even better now. This is basically a throwback to the 
old CGI days, before texture mapping was common.
 
Vertex Transparency

Certain new plug-ins are able to set transparency values for geometry on a polygon by 
polygon basis. This will be very useful for plug-ins that simulate fire and other such 
effects. This type of transparency will be used by the render if this is checked.

Glow Object Only

This option will not shade the group, but will allow its glow settings to be used by the ren-
derer. When combined with particle systems, for example, what you essentially end up 
with are “fuzzy particles.”

Geometry Section

This section contains controls which directly affect the group’s geometry during the ren-
dering process.

Cull Backfaces

Removes back facing polygons (those not seen by the camera) so that they are not shaded 
at render time. This speeds up rendering (didn’t think we could get any faster?) and is 
great for eliminating the double specular effect present with transparent objects.
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Reverse Normals

You can reverse the normals of a group with this option enabled. Unlike most rendering 
engines, ElectricImage understands that polygons have two sides regardless of the nor-
mals for the polygons and will shade the model accordingly. You can turn the group 
inside out with this feature, or better yet, combine it with the Cull Back faces option. Try 
this: add a model (don’t use the standard shapes plug in with this feature) of a sphere and 
enable both of these features. When you render, you will see the inside of the back of the 
sphere. Combine this with edges set to transparent (see the Materials and Texture Maps 

chapter for more information), and you have yourself the beginnings of a planet atmo-
sphere!

Shadow Tab

The shadow tab controls the shadow casting properties of the group. There are five check 
boxes in the tab:

• Cast Shadow
• Receive Shadow
• High Precision Shadow
• Generate Shadow Mask
• Shadow Object Only

Figure 24 — Shadow Tab
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Cast Shadow

Enables the group to cast a shadow onto other groups. Defaults On.

Receive Shadow

Enables the group to receive shadows from other groups. Defaults On.

High Precision Shadow

Improves the quality of the shadows that fall upon this group. Defaults Off, because it is 
usually not needed. If you do not like the way a shadow appears as it falls upon this 
group, high precision shadow’s alternative filtering method might improve the look of it.

Generate Shadow Mask

Creates a “shadow cutter” using this group. The group effectively becomes a mask wher-
ever a shadow from another group would fall upon it. The sections of the group outside of 
the shadow would be rendered with a value of zero (black) in the alpha channel of the 
image. You can use this to assist in realistic compositing of rendered objects into real 
world scenes, and so forth. Use the diffuse color channel to determine the color of the 
“shadow” that this group becomes. Defaults to Off.

Shadow Object Only

Forces the group to be rendered only during the shadow pass, not during the final render. 
With this feature you can create low resolution shadow casting groups to make things ren-
der even faster! Defaults to Off.

Info Tab

This tab stores information about the group’s creation date, the amount of points, lines 
and polygons in the group, and the extent of the group’s volume.
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Working with Lights

Introduction

As with real world photography, 3D computer graphics programs need light to properly 
render an image.  It is in lighting that one truly sets the mood of the composition. Electric-
Image offers a variety of different light types and lighting effects to help you set the mood 
you envision. You can animate all of a light’s characteristics — there are over 450 channels 
to work with for a single light (including all of the special effects).  The interface is very 
straightforward, to the point that you don’t realize just how much control you have over 
the light.

Like groups, lights can exist individually or as part of a hierarchy, although they are best 
placed at the end of a chain or strange results will occur. (See the chapters on Hierarchy 

and Constraints, and Effectors and Inverse Kinematics for more information on hierarcy.) 
Sometimes you will want to add lights into a hierarchy for scene illumination, other times 
you may wish to add them for visual effects.  Some of the many visual lighting effects 
available are lens flares, visible lights and light rays, and light projections (where you load 
an image or movie and it is then “projected” into a scene.) You can also tell lights to 
include or ignore groups in a scene with selection sets. And you can even tell a light to 
remove light from a scene, by setting its intensity to a negative value!

By default, all projects in ElectricImage start out with one radial light so that you won’t be 
left in the dark. (For an explanation of the different lighting types, please consult the Elec-

tricImage Series 2 Reference Manual and Addendums.) Typically you will use many lights 
in a scene to achieve a desired effect.  There are three ways to create new lights in a project:

• Lights can be added from the File menu
• Lights can be added from the Object Palette
• Existing lights in a scene can be duplicated
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To add a light to a project from the File menu:

• Choose File>Add>Type>Light 
• Click and place the light into the scene
• Drag the light into the desired position

To add a light from the Object Palette:

• Click on the light icon in the palette
• Drag the light into the scene from the palette
• Continue to add as many lights as desired

To duplicate an existing light:

• Select the light to be duplicated in either the project window or world windows
• Choose Edit>Duplicate (command-D)
• Drag the duplicate to the desired position

New Lighting Features in 2.8

In addition to the other functions found in the Light Info Window (documented in previ-
ous addendums and the Series 2 Reference Manual,) ElectricImage 2.8 offers these new 
lighting features: 

• Illumination lists
• Projection maps
• Lightflare plug in

Illumination lists use the new Selection Set feature to control a light’s effect on a particular 
group of objects. (See the Selection Sets chapter for more information.) These lists are 
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used to either illuminate or ignore only the objects in the list. In other words, if you assign 
an illumination list to a light, the light will then “see” only those objects in the lists 
assigned to it for the specified behavior.

Projection maps allow a light to work as a slide or movie projector, up to an including cre-
ating light rays colored by the projection map. You can also use this feature to mimic real 
world lighting, such as “gobos.” (Gobos are patterns placed in front of a light to break up 
the light in a particular way.)

The Lightflare plug in is a new type of lensflare. It has different properties than the Lens-
flare, and mimics the lensflare of some other 3D programs. It is provided for your conve-
nience.

The following pages discuss these new features and the new Light Info Window in depth.    

Accessing the Light Info Window

Like all Info windows in ElectricImage, the Light Info Window can be accessed using any 
of the following methods:

• Double click on the light in the World View or Camera Windows
• Double click on the light name in the Project Window
• Choose “Get Info” from the File menu, with the light previously selected

Basic Layout

Below we have an illustration of the Light Info Window. To the left of the Light Info Win-
dow you will see a Light Type pulldown menu and a series of check boxes. To the right are 
a series of named tabs, each containing the controls and functions indicated by the name 
of the tab. To select a tab, just click on it to bring it forward.
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Figure 25 — Light Info Window

The popup menu allows you to select the type of light you want this light to be, and the 
eight check boxes activate visual representations of specific attributes within the world 
view and camera view windows. The checkboxes allow the user to have quick visual feed-
back regarding the parameters of the lights sources without having to render out scenes. 
Generally, users should use the checkboxes while setting up a scene but be careful to only 
turn on those references as they refine the attributes. Turning on too many of the attributes 
at the same time can be a little confusing.

Two new checkboxes have been added in ElectricImage 2.8:

• Show Flare Dropoff
• Show Volume Dropoff

Show Flare Dropoff

This checkbox draws a circular Flare dropoff extent in the world view and camera view 
windows when selected, and represents the furthest distance from the light that the lens 
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flare effect will be visible. You can access installed lens flares through the Flare tab in the 
Light Info Window.

Show Volume Dropoff

This checkbox draws a circular volume dropoff extent in the world view and camera view 
windows when selected. The volume dropoff compensation will occur inside of the 
dropoff extent. The volume drop off setting is an edit box located in the properties tab of 
the Light Info Window (see “Volume Dropoff Edit box” on page 72.)

X-Form Tab

The X-Form (Transformation) tab displays the value of the light’s position, reference, and 
angles at the current scene time. The roll control is also available here. The functions of 
these attributes are identical to previous versions of ElectricImage and are covered in the 
ElectricImage Series 2 Reference Manual and Addendums.

Figure 26 — X-Form Tab
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Properties Tab

The Properties tab contains the basic illumination features of the light. These features are 
covered in the ElectricImage Series 2 Reference Manual and Addendums. ElectricImage 
2.8 presents some new features:

• Inner Cone is Offset Check Box
• Volume Dropoff Edit Box
• Illumination Lists

Inner Cone is Offset Check Box

This check box let’s you create a great looking spot light cone by typing in just one value 
instead of two.  When you enable this option, an edit box will appear to set the offset dis-
tance.  5 ˚ is a good value for starters, but feel free to experiment.  Once enabled, whenever 
you set the outer cone of the spotlight, the inner cone will adjust to its new value based 
upon the offset that you provide.

Figure 27 — Properties Tab

Volume Dropoff Edit box

The Volume Dropoff setting is used to improve the look of both glow and fog lights. The 
purpose of this feature is to prevent spotlight beams from washing out surfaces which 
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they intersect. The illustration below clearly shows the benefits of using volume dropoff.  
Most would argue that the image on the right appears more natural than the one on the 
left. With the exception of enabling the volume dropoff feature for the image on the right, 
both images use identical values. There is no significant render time penalty to use the 
volume dropoff feature.

Figure 28 — To the left, Volume Dropoff is disabled, to the right image Volume Dropoff is 
enabled. All other values are the same.

Smaller values set the dropoff towards the light source, larger values set the dropoff closer 
to the illuminated object.  The Volume Dropoff value represent distance in scene units.  
Using the ruler bars (command-m) will help to choose the best distances.

Dropoff values visible inside of the glow or fog regions will appear as a parabolic mach 
band within the region. This effect is similar to seeing a spotlight beam focused in smoke. 
If this effect is undesirable, increase the dropoff value beyond the range of the glow or fog 
region. The effect will no longer be visible.

Illumination Lists

Illumination lists provide a way to control which objects receive light from a particular 
light source. Which objects receive or are excluded from the illumination of a particular 
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light source are determined by selection sets. (For information on sets and how to create 

them please refer to the Selection Sets chapter.)

Adding Illumination Lists

To add an illumination list to the light, use the following method:

• Click the Add button. 
• Select the set from the list window that appears.
• Click the Add button in the list window
You will now see the name of this selection set listed in the Illumination List window.

Enabling/Disabling Illumination Lists

Sets in the Illumination lists are enabled or disabled by clicking on the solid circles to the 
left of their names (defaults to enabled.) Once clicked, the circle becomes hollow, indicat-
ing that the set member will be ignored. This feature works in the same manner as the 
checkboxes to the left of each group name in the project window.

Figure 29 — Normal Render                                               Excluded Render     
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Illumination Lists and Light Behavior

Once you assign an illumination list to a light, the light “sees” only those items contained 
within the selection sets listed for the specified behavior. If the Illumination List is set to be 
excluding, then those selection sets in the illumination list are not lit by the lightsource. All 
other objects in the scene will be lit normally. If the Illumination List is set to be including, 
then only those items contained within the selection sets will receive illumination from 
the lightsource. All other objects in the scene will be ignored by the light.

Lights can only offer include or exclude behavior, regardless of the number of selection 
sets within the illumination list. Behaviors cannot be mixed and matched. If such is 
desired, you would need to create a new light with the corresponding selection sets and 
settings.

Flare Tab

The flare tab contains all of the parameters to control lens flares for the lightsource. 
Installed lens flares are available from the popup Flare menu (flares are plug ins and need 
to be installed into the EI Sockets folder to be available to a project.) 

Figure 30 — Flare Tab
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Previously, Enable Obscuration was the only Lens Flare option. ElectricImage 2.8 provides 
several more, offering more control.

• Enable Offscreen
• Enable Distance
• Enable Background
• Enable Fog
• Enable Intensity

Enable Offscreen

This checkbox enables the flare to gradually diminish as the origin of the flare moves off-
screen. With this option on the flare behaves as the real photographic artifact behaves. The 
lightsize setting in the Properties tab is used to control the effect.

Enable Distance

This checkbox enables the flare to diminish over distance. The lightsize setting in the 
Properties tab is used to control the effect.

Enable Background

Allows the lens flare to “glow behind” all objects in the shot. As such, this feature ignores 
the Enable Obscuration setting. You can add some dramatic backlighting effects to your 
scene with this feature.

Enable Fog

Causes the flare intensity to diminish as the flare moves into the fog (the fog feature is 
available in the World Info Window.)

Enable Intensity

Uses the Light intensity setting to calculate the flare intensity. The Light intensity setting is 
available in the Properties tab. The Dropoff setting for the light will effect the lensflare if 
this setting is active.
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Glow Tab

This tab contains all the information to control the glow properties of your light source. 
(These features are all covered in the ElectricImage Series 2 Reference Manual and Adden-

dums.) ElectricImage 2.8 adds a new feature, Volume Falloff.

Figure 31 — Glow Tab

Volume Falloff

The Volume Falloff checkbox enables the volume dropoff value in the Properties tab to be 
used when shading the glow or fog region. For more information, see “Volume Dropoff 

Edit box” on page 72.

Fog Tab

This tab contains all the information to set the fog properties of your light source. (All of 

the features are discussed in the ElectricImage Series 2 Reference Manual and Adden-

dums.) ElectricImage 2.8 offers a new item, Volume Falloff, and works exactly the same as 
Volume Falloff in the Glow window. (See previous tab description.)
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Figure 32 —  Fog Tab

Projection (Map) Tab

Projection maps are controlled from this tab. Projection maps are single or multiple frame 
image files, which are projected along the a light’sdirection vector. Any light that can cast 
a shadow can cast a projection map. Each shadow casting light is allowed one projection 
map only 

Light projection maps are simpler than camera projection maps (see “Projection Tab” on 

page 44 for information on camera projection maps.) Light projection maps can be used to 
simulate movie or slide projectors, bulb patterns that are common with flashlights, and so 
on.  In fact, you can think of them as texture maps for lights. Some of the texture map con-
trols are also used in the projection map sub-tabs, covered below.   

To Add a Projector Map

• Click on the Add button
• Select an image file
• Double click the file or click on the Open button

The map is now ready for use.
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This tab contains several sub tabs:

• X-form
• Properties
• Info
• Crop

Projection Map: X-Form Tab

The Projection Map X-Form (Transformation) tab is used to control the position of the map 
in the light’s local space. The position edit boxes control the X and Y position of the map. 
The scale edit boxes control the X and Y scale of the map. The Align popup menu (shown 
extended in the figure below) eases map alignment and fitting. They are discussed below.

Figure 33 — Projection (Map) Tab: X-Form Tab

• Fit Outer Cone (Default)
• Fit Within Inner Cone
• Fit Without Inner Cone
• Fit Within Outer Cone
• Fit Within Outer Cone
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Fit Outer Cone (Default)

This option distorts the projection map to fit inside of the outer cone of the spotlight. Do 
not use this option if you wish to maintain the map’s aspect ratio.

Fit Within Inner Cone

This option fits the rectangluar extent of the projection map to the inside of the inner cone 
of the spotlight. The map’s aspect ratio is presented without distortion.

Fit Without Inner Cone

This option fits the rectangluar extent of the projection map to the outside of the inner 
cone of the spotlight. The map’s aspect ratio is presented without distortion.

Fit Within Outer Cone

This option fits the rectangluar extent of the projection map to the inside of the outer cone 
of the spotlight. The map’s aspect ratio is presented without distortion.

Fit Without Outer Cone

This option fits the rectangluar extent of the projection map to the outside of the outer 
cone of the spotlight. The map’s aspect ratio is presented without distortion.
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Projection Map: Properties Tab

The Projection Map: Properties tab is used to control the properties of the projection map. 
Illustrated below, the tab is divided up into several components: Tiling popup menus; 
Samples edit box; Blur edit box; and a series of checkboxes. 

Figure 34 — Projection (Map) Tab: Properties Tab

Tiling Popup Menus

The tiling section controls the repeat functions of the map if it is scaled at less than 1.0 
(scale functions are found in the Projection Map: X-Form tab.) There are four options for 
each popup menu: 

• None
• Hold
• Repeat
• Mirror

None

Disables mirroring of the the map on the specified map axis. Choosing None for both axes 
will cause the map to be displayed only where you positioned it, nowhere else.
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Hold

Applies the colors found at the map edges outside of the actual image rectangle.  (The 
map will appear once as positioned, with the border colors of the image extending beyond 
the image rectangle, covering the frame.)

Repeat

Repeats the map along the specified axis. Choosing Repeat for both axes will cause the 
map to repeat continuously within the cone of the light, depending upon the scale of the 
map.

Mirror

Mirrors the map along the specified axis. Choosing Mirror for both axes will cause the 
map to flip flop about both axes.

Samples Edit box

This edit box lets you determine the sampling quality of the map.  The default is 5.0.  
Numbers greater than 5 will cause the map to be sampled more often, slowing down ren-
der time, but increasing the quality of the map.  Numbers less than 5 will cause the map to 
be sampled less often, speeding up render time, but decreasing the quality of the map.  
Numbers greater than 10 might be prohibitively slow.  5 is a good default, and you will 
likely not need to deviate from that amount.

Blur Edit Box

This edit box lets you blur the map.  The default is 1.0.  This value will present the map as 
is.  Values of greater than 1.0 will blur the map.  For example, a value of 2.0 will produce a 
blur of two pixels for every one encountered in the map.  Values less than 1.0 will sharpen 
the map, although it will also introduce aliasing (jagginess) into the map.
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Quality Control Check Boxes

There are four check boxes which let you control the quality of the map:

• Interpolate
• Anti-Alias
• Invert RGB
• Invert Alpha

Interpolate

Enables map filtering. Necessary to avoid moire patterns in the map as it rotates off axis.

Anti-Alias

An additional level of filtering for image quality. Not always necessary, and can soften the 
look of the map.

Invert RGB

Negates the RGB channels of the map for special effects.

Invert Alpha

Negates the Alpha channel of the map. This feature comes in handy when you aren’t sure 
how to design the alpha channel of the map.

Projection (Map): Info Tab

The info tab contains information about the projection map, as well as any cropping that 
you may have performed on the map.
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Figure 35 — Projector(Map): Info Tab

Projection (Map): Crop Tab

The crop tab displays a reduced version of the map and allows you to crop within it, so 
you can use just a section of the map. To crop, click anywhere on the “crawling ants” bor-
der around the edge of the map in the rectangle. Clicking on the edges of the map will 
drag the entire side of the map. Clicking on the corners of the map drags the corner 
inward. To reset the map, drag the borders to the extents of the image. 
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Backdrops, Fog and the World Info Window

Introduction

Backdrops and fog help to create a variety of locations, times of day and weather condi-
tions. Used in conjunction with other rendering features, backdrops and fog can produce 
striking results. ElectricImage puts these controls in the World object, along with back-
ground image color, scene ambient values, and global reflection maps. Unlike other 
objects in ElectricImage, the world object is more like a “meta object.” Rather than occupy-
ing a particular location, the world objects exists everywhere in the scene. Like other 
object classes in ElectricImage, the attributes in the world object can be animated. There 
are more than 100 potential animation channels for the world object, and even more when 
you add global reflections.

The world object does not officially occupy a space. It cannot be included in a hierarchy. It 
has no groups included within it. The world object is listed only in the Project Window.

World Info Window Overview

The World object is included in every project, and is presented at the top of the Project 
Window List. Like other objects and groups in ElectricImage, the world object has its own 
information window.

Figure 36 — The World icon in the Project window

There are two ways to access the World Info Window: 

• Double click the World icon in the Project Window
• Select the World Icon in the Project Window and choose File>Get Info (command-I)
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Fog/Ambient/BG Tab

The Fog/Ambient/BG window contains three sections:

• Fog controls
• Ambient Color control
• Background Color control

 

Figure 37 — World info window

The Fog Controls

Figure 38 — Fog control window

Fog, or Fog Projection, simulates atmospheric depth cuing. Atmosphere has depth 
because of particles contained within it, which gives Fog the appearance of being more 
86       ElectricImage 2.8 Supplement    



Backdrops, Fog and the World Info Window — Fog/Ambient/BG Tab
dense the further away it is from the Camera. While it can simulate distant haze or fog in 
a landscape, it does not induce atmospheric effects such as visible light shafts or shadows.

There are a number of items in the Fog Controls section:

The Enable checkbox

This checkbox enables the Fog effect. It defaults to off.

The Color Box

Clicking this box will bring up the ElectricImage color picker. There, you can select a color 
for your fog.

The Mode menu 

This menu determines the type of transition that will occur between the region in which 
the fog effect starts, and the region in which the fog reaches its maximum density. (The fog 
region starts at the center of the active camera body and extends outward in all directions 
by the specified distance.) There are two choices under this menu:

Figure 39 —  The Mode Menu

The default option, Linear, gives an even increase in the density of the fog region. The rate 
in which density increase will be constant throughout the length of the fog region, as 
defined by the Radius boxes (below.)

The second option, Exponential, will calculate the density of the fog in a more realistic, 

non-linear fashion. This option renders results similar to Pixar’s RenderMan® fog shader. 
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Fog To Menu

This menu determines the type of fogging technique to be used. There are three choices 
under this menu:

Figure 40 — The Fog Menu

The default option, Color, will calculate fog to the color specified in the Fog Color box. As 
the fog gets further and further away from the Camera, it will become closer and closer to 
the specified color. This is exactly the same as doing a gradient fill in a paint program, 
where the gradient tool is set to fade from transparent to a color. No matter what color you 
may have selected for a Background Color, the fog will calculate to the designated fog 
color.

The illustration below shows us a linear fade from transparent to blue. The further away 
from the camera the fog is, the more dense it becomes.

Figure 41 —  A linear fade to color

 The second option, Alpha, will calculate the fog to an alpha value of 0, which is totally 
transparent. When this is digitally composited over a background image, the objects 
enveloped by the fog will eventually fade out to the composited background.

The illustration “A linear fade to a transparent alpha value” on page 89 below shows this 
principle at work. On the left the fog has an alpha value of 100, which is totally opaque. As 
the fog gets further away from the camera, the alpha value decreases to 0. This does not 
fog itself transparent - the fog value actually fades the the objects in the scene itself.
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Think of the check pattern as the objects in your scene. On the left the fog is 100% opaque. 
The farther to the right the fog goes, the more it’s alpha value begins to get closer to 0. As 
it does so, the check pattern begins to become transparent, allowing the background 
image to show through (which in this case is set to white, to match the white color of the 
page.)

Figure 42 — A linear fade to a transparent alpha value

The final option, Background, calculates the fog to the background color, as set in the 
Background Color box (see below.)

Figure 43 — shows us a fade to a background color.

This is essentially the same as the first option, Color. The difference, however, is that while 
Color calculates the fog to the color designated in the fog color box, Background calculates 
the fog to the designated Background Color.

The Radius boxes

These edit boxes contain values that define the inner and outer fog radii of the camera. 
The first box represents the point where the fog will begin, and the second box designates 
where the fog will end. These two values are known respectively as the Inner Radius and 
Outer Radius.

The inner and outer fog radii are drawn in the world view windows as two circles which 
enclose the camera controls. These circles are only visible if the camera is selected, and if 
Show Fog is checked in the Camera Info window.

The illustration “The Inner and Outer Radii” on page 90 shows us these two circles, with a 
red fade pattern added to illustrate the principle. From center point (the camera) out to the 
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first circle, which is a dashed circle, the fog effect is not seen. This first circle is the Inner 
Radius circle. From the Inner Radius circle to the second, large solid circle, the fog value 
fades from the Inner Radius value to whatever Fog To option (Color, Alpha, or Back-
ground) has been selected. This second circle is known as the Outer Radius. From the 
Outer Radius onward to infinity the fog is at full value.

Figure 44 — The Inner and Outer Radii

The Amount Boxes

These boxes function in essentially the same way as the fog radius boxes. However, 
instead of determining the start and stop points of the fog radius, they determine the 
opacity value of the fog at the start and stop points. These values in these boxes range 
from 0 to 1, with 0 being 100% transparent and 1 being 100% translucent.

While it is possible for you to enter a higher value than 1, you will not ever get a value 
higher than 100%, so make sure you don’t enter a value of anything other than numbers 
between 0 and 1 in these boxes.

The first box shows the fog opacity value between the camera and the inner radius. The 
second number designates the opacity value at the outer radius and beyond.

The illustration “A fade from 0.2 to 0.9.” on page 91 shows this effect. Let’s assume we 
have a dark green color selected for our fog. Instead of going from 0 to 1 (transparent to 
opaque) we will go from 0.2 to 0.9.
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From the camera to the first arc (the Inner Radius) the light green value is solid. From the 
Inner Radius to the second arc (the Outer Radius) the dropoff occurs. From the Outer 
Radius onward the fog is at full value.

Figure 45 — A fade from 0.2 to 0.9. 

The Ambient Color Controls

Figure 46 — The Ambient Light Control

The Ambient Color Controls set the color of global ambient light in a scene. There are two 
items in this section:

The Enable checkbox

This checkbox enables the ambient light effect. The default is off.

The Color Box

Clicking this box will being up the ElectricImage color picker. There, you can select a color 
for your ambient light.
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The Background Color Controls

Figure 47 — Background Color Controls

The Background Color Controls set the color of the background in a scene. When 
unchecked, the default black background will be rendered in your scene. 

The background color is actually colorizing the alpha channel of the image. If you import 

a 32 bit ElectricImage file into an application such as Adobe ®Photoshop®, the back-

ground will appear black, regardless of the color you have set. This occurs because Photo-

shop does not support colorized alpha channels. 

There are two items in this section:

The Enable checkbox 

This checkbox enables the background color. The default is off, which produces a back-
ground color of black.

The Color Box   

Clicking this box will bring up the ElectricImage color picker. There, you can select a color 
for your background.

Backdrop Tab

The World Info Window contains new features under the backdrop tab that procedurally 
generate ramped color sky and ground planes. This feature can be used while initially set-
ting up your project to give your test renderings a better sense of scale.
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Figure 48 — The Backdrop Tab

There are two main sections in this window:

• Sky
• Ground

The Sky Controls

The Sky Controls give you the ability to designate custom background colors sky. There 
are four items in this window:

The Enable Check Box 

This checkbox enables the sky color effect. The default is off.

The Horizon Color Box   

Clicking this box will being up the ElectricImage color picker. There, you can select a color 
for the sky at the horizon line.

The Zenith Color Box 

Click this box to enter a color value for the sky at the Zenith line.
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The Horizon is the point at which the sky meets the ground. The Zenith is the upper region 

of the sky that is positioned directly above the camera.

The Transition Box 

This value sets the midpoint of the transition between the Horizon Color and the Zenith 
Color. Higher values move the midpoint closer to the horizon, thus showing more of the 
zenith color. Lower values, such as the default 1, will show more of the horizon color.

  

Figure 49 —  The default sky colors

Figure 50 — The sky colors with a transition of 3
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The Ground Controls

The Ground Controls function in exactly the same manner as the Sky controls do. There 
are four items in this window:

The Enable Check Box 

This checkbox enables the ground color effect. The default is off.

The Horizon Color Box 

Clicking this box will being up the ElectricImage color picker. There, you can select a color 
for the ground at the horizon line.

The Nadir Color Box 

Click this box to enter a color value for the ground at the Zenith line.

The Horizon is the point at which the ground meets the sky. The Nadir is the lower region 

of the ground that is positioned directly below the camera. The Nadir is diametrically 

opposed to the Zenith.

The Transition Box 

This functions in exactly the same manner as the sky transition box. Higher values move 
the midpoint closer to the horizon, thus showing more of the nadir color. Lower values, 
such as the default 1, will show more of the horizon color.
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Figure 51 — The default ground colors 

Figure 52 — The ground colors with a transition of 6

When both items are enabled at the same time, the following image appears when ren-

dered:
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Figure 53 — A rendering with the default settings
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The Global Reflection Tab

The third tab contains a list of Global Reflection maps that are accessible in each group's 
material interface.

Figure 54 — The Global Reflection Tab

To add a reflection map to this window, click the Add button. A standard Open dialog will 
appear. Simply navigate through your computer, find the map you wish to add, and select 
okay.

When setting an object’s reflectivity value in the Material Info window, you will notice a 
checkbox called Use Global Reflections. Any object that has this item checked will reflect 
the reflection maps added to this window.

Please see the Materials and Textures chapter for more information.
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Rendering

Introduction

Rendering is the process in which all of the elements in a scene (models, lights, cameras, 
textures, etc.) are combined, and used to generate a final picture or movie. It is analogous 
to the photographic exposure of a scene recorded by the film in a camera. ElectricImage is 
known to have the world’s fastest 3D rendering engine. That is not an idle boast. From 
time to time we often compare the variety of 3D software programs with our own, com-
paring features and timings. In most cases with the most popular of our competitors, Elec-
tricImage is typically 6 to 15 times faster to create the same image. Often our image quality 
is superior, as faster render times let us perform better anti-aliasing.

The ElectricImage rendering engine, Camera, was designed from the ground up as a 
motion picture production rendering system. It can handle an incredible amount of data 
(currently topping out at 30,000,000 polygons, although this is an artificial limit) in a very 
short amount of time. With the introduction of Motion Vector blur in version 2.0, Electric-
Image achieved a design goal of supplanting motion control model photography in many 
studios for most situations.

Newer features and faster rendering speeds are always packed into subsequent versions, 
each time setting the pace for the other packages to follow.

Rendering is very different from ray tracing, a common rendering technique used by 
many hobby level programs and some production renderers. Rendering requires more 
hands on attention from you than ray tracing, especially when dealing with shadows, and 
to a lesser degree, reflections. As advances in hardware make ray tracing more practical 
on a production basis, ElectricImage will incorporate those functions into the renderer. 
Until then, a little extra attention to shadows and reflections will yield very good results, 
in an order of magnitude less time than ray tracing.
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Technically speaking, the rendering engine of ElectricImage (the Camera application) 
transforms the models into optimal segments for rendering speed, caches the texture 
maps to RAM (or the hard drive), generates shadow maps and color buffers, and then 
applies the desired shading algorithm and render settings to the geometry in the scene. It 
is also during this stage that effects like anti-aliasing, motion blur, and glow are applied. 
All of these complex processes take place transparently to you after clicking on Go to 
launch the render. It is in the Render Information Window that the settings which control 
all these various rendering parameters are applied.

Render Info Window

In order to give the user maximum control over all aspects of the rendering process, the 
Render window in ElectricImage 2.8 has been divided into folder tabs. This chapter will 
explore each of these sections and explain what their functions are, as well as how these 
settings affect other group and object settings.

There are two ways to access the Render Info Window:

• Choose File>Render…
• Type command-r

The Render Info Window will then appear.

Figure 55 — The Render Info Window
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This is the window where general rendering parameters are set, such as the global shad-
ing level, color depth, and the image format. This is also where global rendering flags are 
set, allowing the user to enable and disable specific parameters on a per-render basis. Each 
of these areas is explained in depth in this section.

The Render Tab

The render tab in the Render Information Window contains global shading level attributes 
for shading method, image quality, format, activation flags and gamma control.

Figure 56 — The Camera shading popup menu

The Camera Menu

This menu sets the maximum shading level for a render.   The default is Phong shading, 
and this will provide the highest quality rendering for most projects. If this global shading 
level is set to a lower quality than an individual group or object’s shading level, the global 
setting will be override the objects’ setting. For instance, if an object is set for Phong shad-
ing and the global is set for Flat shading, the object will be rendered using flat shading. 
This allows the user to render an entire scene quickly using a lower quality shading level 
for motion tests and other previews. However, if the global is set to a higher quality shad-
ing level, individual objects in the scene can still be set to render at any of the other lower 
shading levels on a per object basis. This allows for a mixture of shading methods (i.e., 
wireframe objects with Phong rendered objects) in the same scene.

There are four basic shading algorithms currently available in ElectricImage. Listed by 
increasing quality and render time they are:

• Wireframe
• Flat
ElectricImage 2.8 Supplement        101



Rendering — The Render Tab
• Gouraud
• Phong

Wireframe

Wireframe rendering is the fastest of the four rendering methods, and renders out a sim-
ple wireframe mesh image. This option will override any of the other shading methods set 
at the group/object level.   

To control line thickness enter a value in the Point/Line thickness box. Higher numbers 
result in thicker mesh lines (see illustration “The Point/Line Thickness Box” on page 109). 
Here are examples of Wireframe shading using various Point/Line Thickness settings:
 

Figure 57 — P/L Thickness: 1.0      P/L Thickness 3.0                                P/L Thickness5.0       

Flat Shading

Flat shading is the fastest, but lowest quality, solid rendering algorithm. Solid rendering 
allows for full hidden surface elimination, which is helpful for quick test renders in order 
to make sure objects aren’t intersecting with each other improperly. Flat shading, also 
known as constant shading, applies a light source to only one point on each face of a 
model. This can give a rendered image a faceted, blocky appearance. Using this global set-
ting, individual objects can use both flat, and wireframe shading, at the group/object 
level. It will however, override the shading level for any group/object that is set for 
Gouraud, or Phong shading.

Gouraud Shading

Gouraud shading results in a higher quality solid rendering than Flat Shading, but is 
slightly slower. Rather than applying a light source to only one point on each face of a 
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model, Gouraud shading calculates the light source based on the vertices of the polygons 
that make up a face. These values are then interpolated to give a slightly smoother appear-
ance than flat shading. The net result is that for a slight increase in render time, objects 
appear smoother and more naturally shaded than they do with Flat Shading. With this 
global setting, individual objects can use wireframe, flat, and Gouraud shading at the 
group/object level. This global setting will however, override the shading level for any 
group/object that is set for Phong shading

Phong Shading

Phong shading, the default, is the most time consuming solid renderer, using an algorithm 
that creates the most natural, smooth shaded images. Phong shading calculates the light 
sources from multiple points across the surface of a model, instead of just at the vertices of 
the component polygons. The result is more realistic specular highlights on surfaces as 
well as the most natural shadowing and light sourcing of any of the shading methods. 
This global shading level allows for all shading types to be active at the group/object level 
for the maximum amount of control.

The Image Menu

Figure 58 — The Image popup menu

The Image popup menu determines the final bit depth of the rendered image. Bit depth 
represents the number of colors used in the palette of an image. Black and white images 
are 1-bit (black or white), 256 Color and grayscale images are 8-bit, thousands of colors are 
16-bit, millions are 24-bit, and millions + alpha are 32-bit. These color depths are all pro-
cessed as a post-rendering effect, as all ElectricImage rendering algorithms are initially 
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computed in the 32-bit color (Millions+Alpha) Image format. After rendering the image in 
32-bit color, ElectricImage then converts the image to one of the settings defined above.   
Thus, it is important to note that there will be NO savings in render time or speed by ren-
dering in less than 32-bit color. It may actually take longer to render in one of the other 
modes, as there is an extra step which takes place after the render is complete. 

The options for this pop-up are:

BW Lines

Renders an image with lines only, in black and white only.

BW Filled

Renders an image with filled polygons, in black and white mode, similar to flat shading. 

BW Dithered

Simulates a smooth shaded image using a fixed dither pattern, in black and white. The 
dither is similar to the dither patterns found in the original MacPaint program from 1984.

BW Summation

Renders a black and white image using summation dithering, a higher quality dithering. 
This dither uses randomly placed dots to make the image appear to be more smoothly 
shaded. From a distance, the image appears as a continuous tone.

256 Shades

This option converts the image to 256 shades of gray (8-bit). No histogramming is 
required for 256 Shades as it is converted directly to gray scale from the original 32-bit pal-
ette. Therefore, there is no rendering time penalty for this option.

256 Colors

This option coverts the image to an optimized 8-bit color palette. 256 Color animation’s 
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are histogrammed from the original 32 bit IMAGE file, resulting in a consistent frame-to-
frame color palette. This means that a 256 color animation will maintain the same color 
palette throughout the entire animation. There will be a time penalty for the histogram 
process to occur, and the amount of time required is directly related to the amount of 
frames in the movie file.

Thousands

This option converts the image to a 16-bit color palette (32,768 colors) after rendering. As 
noted above, this does not speed up render time as the image is initially created in 32-bit.

Millions

This option renders the image in 32-bit color and discards the alpha channel, resulting in a 
final 24-bit image.

Millions+Alpha

This option renders the image in 32-bit color, creating a 24-bit RGB image with an embed-
ded 8-bit alpha channel.

The Format Menu

The Format pop-up menu determines the file format for the final, rendered image. 
 

Figure 59 — The Format Menu

Image

The original file format, used since the origin of ElectricImage. The Image format is a 
robust, 32-bit color format. It is also natively supported by many other, high-end graphics 

packages such as Adobe Photoshop® and After Effects®. Files stored in the Image format 
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can be displayed within ElectricImage by using the display option in the File menu, or by 
using the separate Projector application. Additionally, a utility program bundled with 
ElectricImage, ImageToQuickTime, will convert an Image file to a QuickTime movie.

QuickTime

Created by Apple Computer®, QuickTime™ is a digital movie format that has become a 
standard across multiple platforms. Choosing the QuickTime format brings up a dialogue 
that offers the choice of any installed hardware or software compression CODEC’s.

It should be noted that settings made in the CODEC window will override both the 
frames per second, and the Image Depth, settings in the Render window. For instance, 
even if you set the Image Depth to Millions+Alpha in the Render window, if you choose 
millions only in a QuickTime CODEC the image will be stored in millions of colors, 
WITHOUT the alpha channel. Also note that any slave machines used for rendering must 
have the same QuickTime CODEC installed as selected on the host machine.

PICT

The PICT file format is another cross platform image format which began on the Mac. 
Unlike QuickTime, the PICT format is used for single frame images, rather than anima-
tions. If PICT is chosen for a multi-frame render, a series of sequentially numbered PICT 
files will be saved. PICT files have the same CODEC options as a QuickTime movie.

Flags Section

These check boxes are used to turn on and off various effects for rendering. Any box that 
is checked enables that function. This has no effect on the settings of a given group or 
object, but simply turns off that function temporarily during the render. Any objects that 
use these effects (i.e., reflections or shadows) will still maintain their settings, and will ren-
der properly when the appropriate flag is re-enabled. This allows the user to enable and 
disable specific effects and functions on a global, per render basis. For instance, while 
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doing a test render it might not be necessary to calculate shadows, so the Shadows box 
can be unchecked to save time until a final render is needed.
 

Figure 60 — The Flags section

At many professional effects houses a trick that is often employed is to render out the 
same image using multiple passes, and then compositing the different passes together to 
form the final image. One render will be made just for the reflections, while another will 
be done for the diffuse light, another for glows, and so on. Then, in a post-processing pro-
gram these layers can be combined with the utmost accuracy and flexibility, even chang-
ing over time.

The Flags control the following functions:

Clip

This check box controls whether or not clip maps are rendered. This option defaults to on.

Bump/Displace

This check box controls whether or not bump and displacement maps will be rendered. 
This option defaults to on. 

Diffuse

This checkbox controls whether or not the Diffuse channel will be used during rendering. 
This option defaults to on. 
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Specular

This check box controls whether or not specular maps will be used in the rendering pro-
cess. This option defaults to on.

Transparency

This check box controls whether or not transparencies or transparency effects will be ren-
dered. This option defaults to on.

Transmission

This check box controls whether or not transmission effects and maps will be rendered. 
This option defaults to on. 

Textures

This check box controls whether or not any texture maps will be rendered. This option 
defaults to on. 

Reflections

This check box controls whether or not any reflection maps will be rendered. This option 
defaults to on. 

Shaders

This check box controls whether or not procedural shaders will be rendered. This option 
defaults to on.

Luminance

This checkbox controls whether or not Luminance effects will be rendered. This option 
defaults to on. 
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Glows

This check box controls whether or not glow effects are applied to the render. This option 
defaults to off.

Outlines

New to ElectricImage 2.8, this check box controls whether or not the Cel/Outline shader 
functions are enabled. It defaults to off. By enabling this check box, and by also activating 
the Cel/Outline shader options in a groups’ material window, a variety of effects can be 
achieved. The Cel/Outline shader allows for separate color and thickness to be assigned 
to polygons, edges, and silhouettes of models. (For more information on this please refer 

to the Materials and Surfaces chapter.)

Lens Flares

This check box controls whether or not lens flare effects will be rendered. This option 
defaults to off.

Shadows

This check box controls whether or not shadows will be calculated and rendered for an 
image. This option defaults to on. 

Add Noise

This check box adds random noise to rendered images to reduce mach banding (very dis-
cernible differences in what should be smooth color transitions), especially prevalent in 
darker colors of the 32-bit color space. This option defaults to on.

Point/Line Thickness

Figure 61 — The Point/Line Thickness Box
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When a scene is rendered in wireframe, the Point/Line Thickness edit box allows the user 
to specify the thickness of points and lines in pixels. The default is 1 pixel. Higher num-
bers will give the wireframe mesh thicker lines. (See the illustration “P/L Thickness: 1.0 
P/L Thickness 3.0 P/L Thickness5.0” on page 102 for an example.)

Output Gamma

Gamma is a technical term used to describe the intensity of different levels of gray as they 
appear on an output device; usually either a computer monitor or video screen. Standard 
gamma settings range from 1.0, up to 2.2 depending on the output device. Mac monitors 
are often much brighter, and thus have a higher gamma level than PC monitors. If you 
intend to render for target devices other the the Macintosh, consider using a gamma of 2.2, 
as it is the most common. NTSC, many film recorders, and many print devices use a 
gamma of 2.2.

The Resolution Tab

The Resolution Settings tab is where all of the parameters for the resolution of the final 
rendered image are set. In this window there are options for setting the aspect ratio, reso-
lution, cropping, and VR rendering functions. 

Figure 62 —  The Resolution Tab
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The Aspect Ratio Menu

The Aspect Ratio popup menu defines the relationship between the x and y pixels of the 
image. This relationship is known in technical terms as the aspect ratio. This ratio is com-
monly stated as “x resolution in pixels: y resolution in pixels”, simplified to the lowest 
common denominator. Therefore, a standard Macintosh screen with a resolution of 640 
pixels horizontally (x) and 480 pixels vertically (y) has an aspect ratio of 4:3. Usually, when 
discussing film resolutions, the aspect ratio is specified as a ratio with y always equal to 1. 
For instance, IMAX film requires a very square 1.22:1 ratio, while 70mm uses an ultra 
wide 2.20:1 ratio. There are a number of preset aspect ratios defined in ElectricImage, or 
the user may choose to enter their own Custom aspect ratio. What aspect ratio you choose 
depends solely on the final format required for output. By choosing one of the pre-defined 
aspect ratios, the rendered image will be constrained to the proper pixel ratio for that for-
mat.

Figure 63 — The Aspect Ratio Menu

An important consideration when using one of the preset aspect ratio’s is how it affects 
the field of view of the camera. Not only does film stock vary in aspect ratio, it also corre-
spondingly varies in the amount of information it can record, or the Field of View. One 
way to consider how the field of view relates to the aspect ratio is to visualize a physical 
piece of film stock. When you look at it, it has a tangible measurement of x inches horizon-
tally, and y inches vertically. One factor is the relationship of these two measurements to 
each other. Those measurements will give you the aspect ratio, and determine how wide 
or square an image will appear when projected. The other factor is the physical size of the 
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film stock itself. Although both Super 8mm film, and 35mm Full format film have the 
same aspect ratio (1.33:1), you can see a lot more on 35mm film, shooting the same subject 
at the same distance, and using the same lenses. In other words, if you put the exact same 
lenses on both cameras, say 25mm, and shoot from the exact same distance, the 35mm film 
will have a significantly wider field of view and you will see more information recorded 
on the film. Why? Because 35mm film is physically larger and has about 4 times the sur-
face area of Super 8mm film on which to record an image. So it is very important to 
remember that you are determining not only the width, or aspect ratio, of an image, but 
also it’s relative field of view. Of course, in 3D you can use any lens, regardless of the 
aspect ratio, in order to create a specific field of view, but the film stock is an important 
factor in this equation. (For more information on Focal Length and Field of View, please 

refer to the Assigning and Using Cameras chapter.)

Note that the aspect ratio is locked to the X resolution. Any number entered in the X box 
will automatically calculate the proper Y resolution based on the currently selected aspect 
ratio. However, numbers can be entered manually in the y resolution and do not automat-
ically convert the x value to the correct aspect ratio. Therefore, if you want the aspect ratio 
to be automatically calculated, always enter your resolution in the X edit box, and let Elec-
tricImage calculate the proper Y resolution.

For reference information, the field of view in horizontal degrees, assuming a 37 mm Focal 
Length lens, is given with each preset choice (we have rounded up from 36.8699). The 
aspect ratio choices are as follows:

Custom

This option brings up a dialogue box for entering a custom aspect ratio. The pop-up menu 
on the right allows the user to specify the measurement system in millimeters, centime-
ters, or inches. Then, simply enter the specific film gauge measurements in both x and y 
dimensions, or enter an aspect ratio in the Frame Aspect edit box. 
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This dialogue box is very useful for entering custom measurements when you are trying 
to match a film stock that is not one of the presets, or you need to match a particular 
aspect ratio from another 3D package, or to suit a specific programming need. 

Computer

This option (the default) specifies the 4:3 aspect ratio of a standard 640x480 computer 
screen. The horizontal field of view using a 25 mm lens is 3.0 degrees.

If you are doing multimedia work for a standard computer screen, this is the setting that 
you would use most often.

Super 8mm

This option specifies the 1.33:1 aspect ratio of Super 8mm film. The horizontal field of 
view using a 25 mm lens is 12.1 degrees.

16mm

This option specifies the 1:38:1 aspect ratio of standard 16mm film. The horizontal field of 
view using a 25mm lens is 23.2 degrees.

Super 16mm

This option specifies the 1.7:1 aspect ratio of Super 16mm film. The horizontal field of 
view using a 25mm lens is 28.1 degrees.

35mm

This option specifies the 1.37:1 aspect ratio of standard 35mm film. The horizontal field of 
view using a 25mm lens is 47.4 degrees.

35mm Full

This option specifies the 1.33:1 aspect ratio of 35mm Full format film, also known as Acad-
emy Aperture or “four perf,” for the amount of sprocket perforations used per frame as 
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the film runs vertically through the camera. The horizontal field of view using a 25mm 
lens is 52.9 degrees.

VistaVision

This option specifies the 1.5:1 aspect ratio of VistaVision format, with 8 horizontal perfora-
tions per frame. The horizontal field of view using a 25mm lens is 74.1 degrees.

65mm

This option specifies the 2.28:1 aspect ratio of 65mm vertical 5 perf film. The horizontal 
field of view using a 25mm lens is 92.8 degrees.

IMAX

This option specifies the 1.22:1 aspect ratio of 65mm horizontal 15 perf IMAX film. The 
horizontal field of view using a 25mm lens is 109.25 degrees.

70mm

This option specifies the 2.20:1 aspect ratio of 70mm film running vertically through a 
motion picture camera. The horizontal field of view using a 25mm lens is 88.3 degrees.

TechniScope

This option specifies the 2.35:1 aspect ratio of TechniScope film. (TechniScope is also 
referred to as “two perf,” as it divides the vertically oriented 4 perf standard 35 mm frame 
into two frames, each using two sprocket perforations.)The horizontal field of view using 
a 25mm lens is 88.3 degrees.

Image Resolution Menu

The Resolution popup menu determines the final number of pixels to render for an image. 
This resolution will be constrained by the chosen Aspect Ratio. 
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Figure 64 — The Resolution menu

The resolution of an image has little effect on the amount of memory required to render, 
but does increase the number of passes needed, due to the additional pixels, and increases 
render time.

You should note that the resolution has no effect on the field of view. You won’t be able to 
see twice as much of a scene by doubling the resolution. In order for the camera to “see” 
more of a scene, it is necessary to either change the aspect ratio and/or the focal length of 
the camera. The resolution setting merely renders more or less pixels in a given image. 
The amount of information seen by the camera is the same, regardless of the resolution.

The choices for image resolution, based on a Computer aspect ratio of 4:3, are:

• 260x200
• 320x240
• 640x480
• 1024x768
• 1280x960
• 2048x2048
• 4096x4096
• Main Screen (the default): This setting uses the resolution of the primary monitor.
• NTSC: (720x486) The standard television resolution used in North America and Japan. 
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Pixel ratio =.9 (See below for explanation of Pixel ratio)
• PAL: (768x576) The standard television resolution used in many European countries, 

including England, and Germany.
• HDTV: (1920x1280) The mythical, high definition television format that may appear in 

the United States one day, but most likely not at this resolution and no longer called 
HDTV.

• Abekas NTSC: (720x486) Resolution used by Abekas direct disk recorders at NTSC 
resolution. Pixel ratio=.9.

• Abekas PAL:   (720x576) Resolution used by Abekas direct disk recorders at PAL reso-
lution. Pixel ratio= 1.0667.

X and Y Edit Boxes

These edit boxes allow the user to directly enter values for resolution rather than choosing 
from the resolution pop-up menu. The X value will automatically constrain the Y value to 
the chosen aspect ratio, but not vice-versa. The maximum theoretical resolution is 32,760 
pixels by 32,760 pixels.
 

Figure 65 — The X and Y Edit Boxes

Pixel Aspect Ratio

This edit box allows the user to control the aspect ratio of each rendered pixel. Most com-
puter screens display square pixels, at a pixel ratio of 1.0. However, broadcast television 
signals, including NTSC, PAL, and HDTV do not use square pixels. Therefore, by altering 
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the pixel aspect ratio, non-square pixels can be rendered. The value in this box will auto-
matically change when specifying a resolution in the resolution popup.
 

Figure 66 — The Pixel Ratio box

Rendering with rectangular pixels will tend to make images look stretched out when 
viewed on a computer screen, but after being properly processed and sent to video tape 
they should appear normal.

Image Cropping

New to ElectricImage 2.8, is the image cropping function. This allows for only a portion of 
an image to be rendered. There are two ways to use the new cropping feature. First, the 
enable cropping check box must be checked in the Render window. Next, values from 0 to 
1 can be entered directly in the text boxes in the cropping area, where 0 represents left/
top, and 1 represents right/bottom. When the image is sent to render, only the area within 
the cropping guidelines will be rendered.

Figure 67 — The Image Cropping options

More usefully, the crop region can be seen and interactively set. By option-clicking on the 
title/safe pulldown symbol at the bottom of the Camera View and selecting Crop, a visual 
guide will appear in the camera window. This region can now be interactively resized 
using the Drag Cropping tool found under the tools pulldown menu. When the render is 
sent, only the area within the visual cropping guides will be rendered.
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Rather than just a temporary selection, like the method of rendering Selected Size, the 
Crop region can be saved, turned off and on, and easily moved and resized. 

This kind of selective rendering option can be extremely useful when you have a scene set 
up, and you need to preview specific areas of the scene, but don’t want to wait while the 
computer renders everything in the scene. Rather than turning a bunch of objects off and 
on, or setting up multiple cameras, you can selectively set a cropping region around the 
object you wish to and render. There is also a new shortcut under the preview render icon, 
Cropped Size, that allows you to instantly render the cropped selection, or to render a 
selection within the cropped area, Selected Cropped Size.

QuickTime VR Image Format

The options for outputting a QTVR image are as follows:

QuickTime

When using this option in the image format pop-up menu, ElectricImage generates a final, 
diced, compressed QTVR movie. You can play it back, distribute it, or use it as a basis for 
creating a multi-node movie. When using the QuickTime option, you will be prompted to 
select a CODEC for compressing the QTVR movie.

It should be noted that ElectricImage can only generate single node movies. You will need 
to obtain additional tools, either from Apple or a third party, in order to create multi-node, 
or other special QTVR movies.

PICT

When using this option in the image format pop-up menu, ElectricImage will generate a 
final, stitched, warped panoramic image in the Pict format. Warped PICT files are then 
used with other authoring tools to create QTVR nodes and movies. One major advantage 
to this method is that the finished image can be touched up and rotoscoped, prior to being 
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compressed and included in a node. You should be aware, however, that this format does 
not create a QTVR movie, and you will need other software to make a finished QTVR 
node.

Image

When using this option in the image format pop-up menu, ElectricImage will generate a 
final, stitched, warped panoramic image in the Image format. There are no real differ-
ences, aside from the format, between this and a warped pict file.

QuickTime VR Object Movies

New to ElectricImage 2.8 is the ability to create object movies through the VR pop-up 
menu. A Quicktime VR Object movie is a VR movie that tracks a single object around a 
360 degree axis. Rather than the viewer panning and tilting across a panorama, an object 
movie allows the viewer to spin and rotate a single object around it’s own axis.

Simply place the object you want to rotate at 0,0,0 on the global axis. Then, select Object 
from the VR popup menu. This will bring up an additional dialogue box allowing you to 
set the number and angle of Horizontal (Latitude) and Vertical (Longitude) samples 
needed. By default an object movie will utilize a 360 degree axial rotation, starting at 90 
degrees Latitude, 0 degrees Longitude and rotating to 90 degrees Latitude, and 360 
degrees Longitude. To create a smoother object movie, more samples can be created per 
rotation, by entering a value in the Sample edit box.

Unlike QTVR Panoramas, QTVR Object movies do not have set requirements for FOV or 
Resolution. These are left up to the user.
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The Anti-Alias Tab

The anti-alias tab contains all of the settings which control final image quality.
 

Figure 68 — The Anti-Alias tab
The Anti-Alias Menu

Figure 69 — The Anti-Aliasing popup menu

The Anti-Aliasing popup menu determines the type of anti-aliasing used when rendering. 
The choices are:

None

This option specifies that no anti-aliasing will be used on the image. Edges and outlines 
may have a jagged, rough appearance.

Adaptive

This option specifies that adaptive anti-aliasing be performed on the render. This pro-
duces a softer image than None, and a sharper image than the Oversample. Thin, sharp 
lines may cause artifacting when rendering for video output, and using Oversampling 
may be more effective in these cases.
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Oversampling

This option (the default) specifies that Oversampling be performed on the render. This 
produces the softest images with the smoothest edges, and significantly reduces video 
artifacting caused by jagged edges.

The Anti-Aliasing Levels Menu

Figure 70 — The Anti-Aliasing Levels menu

4x4

(The default) This setting is generally sufficient for most images. Lines and edges main-
tain a sharp, detailed appearance. High contrast vertical and horizontal edges can cause 
artifacts, and moire patterns, for which the 8x8 setting may work better.

8x8

This setting is useful when a slightly smoother, softer look is required. Lines and edges 
will appear less crisp than when using the default, and may reduce moire patterns and 
artifacts. Be aware, however, that this setting may slow down rendering time significantly 
over the default 4x4.

16x16 (and higher)

These settings should only be used in specific instances where a very high level of anti-
aliasing is needed. For the vast majority of renders, these sampling levels will produce an 
image that is indistinguishable from one rendered at a 4x4 or 8x8 level. However, render-
ing time goes up dramatically when using these levels.
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The Sampling Levels Menu

Object sampling levels are set in the group info window for each object. The values in the 
sampling level menu are used to determine the maximum amount of sampling allowed at 
render time. If some of your groups are set to 4x4 sampling, and the sampling menu is set 
to 2x2, sampling will be limited to up to 2x2 maximum as the image is rendered.
 

Figure 71 — The Sampling Levels Menu

1x1

(The default) This setting is sufficient for lower detail objects, or models that appear at a 
moderate distance from the camera. However, when viewing images rendered at this set-
ting up close, jagged edges may be apparent. This is also not a good setting for high reso-
lution images.

2x2

This is a good, general setting for most objects and groups. Render time compared to 1x1 
sampling may be only slightly higher, and the extra detail is generally worth the time, 
especially with high detail texture maps.   This setting may also help animations that 
exhibit flashing, or stair step patterns on playback.

4x4

This setting, although slower than 2x2, is useful for objects which require a high amount 
of sampling detail. This includes objects with intricate texture maps that are in close prox-
imity to the camera, or that involve complex effects passes (smoke, fog, glow). Very high 
resolution images may also benefit from this sampling level.
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16x16 (and higher)

Like anti-aliasing levels, these setting should only be used in specific instances where a 
very high sampling level is required. Render time at these levels increases by a huge 
amount, and for the majority of renders will show no noticeable improvement.

When rendering at any typical resolutions (720x486 and less), leave your anti-aliasing 
level at 4x4. Unless you see a problem in the render this setting will be more than ade-
quate and allow you to render as quickly as possible. For sampling levels, consider using 
a global maximum sampling level of 4x4, and individually setting the sampling levels on 
a per object basis. Therefore, if you have an object with a complex texture map very close 
to the camera you can set it’s sampling level to 4x4, while objects that only appear in the 
distance can be set for 1x1. This approach gives you the maximum control over the 2 
major issues in a production setting; quality and render time.

Adaptive Sampling Threshold

 

Figure 72 — The Sampling Threshold boxes

The Min and Max edit boxes contain values that control the type of adaptive comparison 
filtering to be performed between adjacent pixels of different color values. If the difference 
in the pixels is less than the minimum value, the image is sharper (less filtering, more 
jaggy). If the difference in the levels is greater than the maximum value, the image is softer 
(more filtering, less jaggy). If the difference falls between the minimum and maximum 
values, adaptive anti-aliasing is performed. The higher the difference, the softer the 
image; the lower the difference, the sharper the image.
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The Motion Blur Tab

Figure 73 — The Motion Blur Tab

This section of the Render window is used to control the motion blur features of Electric-
Image. Motion blur is the simulation of the kind of effect that occurs when recording a 
moving object on film. As an object moves across a frame of film it naturally blurs, 
depending on the speed of the film, and the object’s velocity. These controls allow you to 
mimic that behavior in ElectricImage. Note that in order for blur effects to be rendered, it 
is also necessary to set the blur mode for each object/group that you wish to blur under 
that object’s group info window.   This setting defaults to no motion blur. You will need to 

change the blur mode to the desired setting per object blur or motion blur will not be ren-

dered.

Shutter Angle

 

Figure 74 — The Shutter Angle Box

This edit box contains a value in degrees that represents the circular angle at which a cam-
era shutter is open. A value of 360 degrees simulates a shutter that is always open, 
whereby all moving objects leave a continuous streak across the frame. A value of 180 
degrees (the default) simulates a shutter that is open for half a frame, mimicking a motion 
picture camera. The higher the angle, the longer the shutter will stay open, creating longer 
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streaks and more blur. Note that only moving objects create blur, or streaks, as the streak 
length is computed by the distance an object moves within the field of view from frame to 
frame. Hence, objects that are far away from the camera will streak very little regardless of 
their velocity, while very close objects will streak dramatically with very slight movement. 
Values higher than 360 ˚ will create dramatic streaking, even on slow moving objects. 
Great for that “warp speed” effect.

Blur Intensity

 

Figure 75 — The Blur Intensity checkbox

This edit box is used in conjunction with the Point/Line blurring technique (see below). 
This value controls the brightness of the streaks left behind by points and lines. A value of 
0.0 (the default) imparts a constant value regardless of the length of the streaks. Larger 
values produce brighter streaks, while smaller values produce dimmer streaks. New to 
ElectricImage 2.8, a separate blur intensity can be set for each individual object/group in 
that group’s info window. This edit box automatically appears after selecting the Point/
Line blur mode.

Blur Noise

Figure 76 — The Blur Noise checkbox

This edit box is used in conjunction with the Motion Vector blurring technique (see 
below). This value controls the number of blur samples per pixel. The higher the number, 
the less visible noise in the streak. By using a value of 0, ElectricImage will automatically 
compute the optimal number of samples for a streak based on its length. A value of 4 (the 
default) renders quickly and produces high quality results. Values over 10 are unproduc-
tive, and will drastically slow the rendering process.
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Blur Frames

This edit box is used in conjunction with the Multi-Frame blurring technique. This value 
represents the number of individual frames that are rendered prior to averaging the 
frames together to generate a single frame. For instance, if this value is set to 3, for each 
frame of an animation, ElectricImage generates 3 images, the frame ahead of the current 
frame, the current frame, and the frame behind. It then averages these images together to 
make a single frame, with blurring based on the distance moved between all 3 frames. If 
this value is set to 2, ElectricImage calculates two frames for averaging; the current frame, 
and one after the current frame.

Point/Line Blurring

 

Figure 77 — The Point/Line Blurring checkbox

This check box, when enabled, activates the point/line motion blur technique at the global 
level. Individual objects still need to be set for this type of blurring at the group/object 
level. In this mode, only points and lines leave streaks behind. This is most useful for the 
motion blur of star streaks and particle systems. Normal polygonal models will not streak 
using this method.

Motion Vector

Figure 78 — The Motion Vector checkbox

This check box, when enabled, turns on the Motion Vector motion blur technique at the 
global level. Unlike the point/line method which only blurs points and lines, this method 
induces blur on all objects which have been set for motion vector blurring. This includes 
points, lines, and polygons. It should be noted that blurred lines are always linear, and are 
never curved when seen in a single frame. This is a fast and versatile technique which 
works for most objects.
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Multi-Frame

Figure 79 — The Motion Vector checkbox

This check box, when enabled, allows for multi-frame sampling for motion blur. It can be 
used in conjunction with the other blur techniques (point/line or motion vector). The 
number of frames to be sampled is set in the Blur Frame check box. Strobe like effects are 
produced if too few sample frames are used with this option alone. It is best applied to a 
section of an animation where there is complex or rapid motion (like spinning fan blades, 
or the tires of a quickly moving car). Combining this technique (set to 2 sample frames) 
with Motion Vector blur produces great results for those times when Motion Vector isn’t 
quite enough.

The Glow Layer Tab

New to ElectricImage 2.8, are glow layers. Any group can be given a gaussian glow that 
emanates outward from that object. Additionally, groups of layers can be defined, each 
with its own glow radius and intensity. 

Figure 80 — The Glow Layer Window

There are three sections in the glow tab:
• Glow Layer List
• Glow Layer Members List
• Configuration Section
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Glow Layer List

A glow layer contains glow attributes which apply only to members of that layer. To add a 
glow layer:

• Click the Add Button Next to the Glow Layer list
• Name the layer
• Click OK
A new glow layer is added to the list.

Glow Layer Members List

Glow layer members are selection sets. In order for groups to use their glow effects 
(applied as a material), the groups need to be in a selection set contained within a glow 
layer. To add a selection set to a glow layer:

• Select a glow layer
• Click the Add button next to the glow layer member list
• Pick a selection set form the list
• Click the Add button

The selection set is now added to the glow layer.

Glow Configuration Section

The appearance of the glow layer is a combination of the material attributes of the glow, as 
well as the settings in the Glow Radius and Glow Intensity edit boxes, shown below.
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Figure 81 — The Glow Layer Window with Glow Layers and Layer Members

Glow Radius

The pixel area of the glow. This is the area of the image that will have a glow effect applied 
to it. Smaller values are good for objects that you wish to appear brighter in a scene, while 
larger values are better for simulating effects such as glare.

Glow Intensity

This value controls the brightness of the glow. Glows are added on top of the rendered 
scene, therefore a value of 1.0 would produce a glow that is twice as bright as the original 
image without glow.

Although glow layers and sets may seem a bit complex at first, once you get the hang of it 
you will begin to understand the potential. Rather than having to manually tweak settings 
for each separate glow effect you can simply define a series of standard effects and apply 
those to the appropriate sets at render time. For instance, you could come up with a set of 
glow layers to simulate fire, candles, tv monitors, spaceship exhausts, light bulbs, etc. 
Once you have a series of defined glow layers they can easily be assigned to any set of 
objects you’ve created. Additionally, since Glow radius and intensity can vary by layer, a 
series of complex effects and layered glows can be created.
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The Timing Tab

The timing tab contains start and stop information, and playback information.

Figure 82 — The Timing Window
Start and Stop Times

This edit box defines the start and end times for a project, in seconds. These settings are 
also represented visually in the project window by the green (start) and red (end) arrows, 
and can be changed by dragging them interactively. Any changes made in the project win-
dow will be reflected here, and vice versa. These boxes define the total range of frames for 
a given project. Animation keyframes can still exist outside of the range of frames for a 
project, but will not be rendered.
 

Figure 83 — The Start and Stop Boxes

Note: It is possible to set the start time to a negative number. This can be very helpful if 
you’ve already created a complex animation starting at 0.0 seconds, and you later realize 
you need to add a sequence prior to the start of the animation. Rather than attempting to 
drag all of your keyframes to the right, simply use a negative number as your start time. 
Be aware, however that while this works in most cases, negative frame numbers may not 
work with simulation plug ins such as particle systems.
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Total Frames

Figure 84 — The Total Frames box

This edit box displays the total number of frames in an animation. This number is gener-
ated automatically based on multiplying the delta (difference) of the start and stop times 
by the number of frames per second and adding 1. For instance, if a project is set for 10 
seconds, and the frame rate is 30 frames per second, the total number of frames rendered 
will be 301. This extra frame is due to the fact that ElectricImage counts frame zero as the 
first frame in an animation. This number is displayed primarily for reference, although by 
setting the Total number of frames directly in the edit box, the Stop Time will be updated 
accordingly in both the Stop edit box and the project window.

Nth Frame

Figure 85 — The Nth Frame box and checkbox

This edit box is used to specify that an animation is only rendered out with every nth 
frame. In other words, if this box is set to 2, then every 2nd frame will be rendered. If the 
start frame is 0, the following frames will be rendered: 0, 2, 4, 6, 8...etc. In order for this to 
work, the Enable Nth frame checkbox must be checked. This setting works independently 
of the Render frames pop-up. The Nth frame is always used if selected, whether an anima-
tion is rendering all frames, or a selected range of frames. For instance, if a render is set for 
a range of frames from 100 to 150, and Nth frame is set to 3, then the following frames will 
be rendered: 100, 103, 106, 109...etc.

The Nth frame box is extremely useful for doing test renders. Instead of having to render 
out every single frame of an animation, it is often sufficient for a rough motion test to only 
render out every 2nd or 3rd frame.
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FPS

Figure 86 — The Frames Per Second (FPS) Menu
This edit box is used to specify the number of frames per second (fps) to be rendered for 
an animation. This figure determines the total number of images that are drawn per sec-
ond. Note that it is important to set this number prior to doing any animation in a project, 
as all animation keyframes that are created will be based on this number of frames per 
second. By changing this value later, velocities and keyframe attributes may be thrown 
off. The pop-up menu contains the following choices:

Custom

The Custom setting allows the user to enter any number of frames per second, as well as 
choose whether or not the image will be interlaced. Interlaced rendering splits each frame 
into two fields, with the odd field dominant unless the Even Field check box is enabled. 
Interlaced fields are necessary for some broadcast video output cards. You should consult 
with your video output devices manuals to determine if interlaced fields are necessary.

NTSC: 30, 30i

This setting specifies the NTSC video standard of 30fps. This is what all broadcast televi-
sion in the US is shown using, and consists of a 60Hz signal, being shown in 2 fields. Com-
bining both fields into 1 frame results in a frame rate of 30fps. NTSC: 30i is output as 
interlaced frames, with the odd field dominant.

PAL: 25, 25i

This setting specifies the PAL video standard of 25fps. This is most common for European 
broadcast television, and differs from the US in that it operates at 50Hz, shown in 2 fields. 
Combining both fields into 1 frame results in a frame rate of 25fps. Pal:25i is output as 
interlaced frames, with the odd field dominant.
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Film: 24

This setting specifies the motion picture standard of 24fps.

The Render Menu

This pop-up menu is used to select the range of frames that are to be rendered. The 
choices are:

Current Frame

This option (the default for single frame projects) causes only the current frame in the ani-
mation to be rendered. The current frame is defined as whatever frame is currently dis-
played in the camera window. This is selected by moving the timebar in the project 
window.

All Frames

This option (the default for multi-frame projects) causes all frames in an animation to be 
rendered. The total number of frames is defined by the Start and Stop times, mentioned 
above.

Range of Frames

This option opens a dialogue box which allows for setting specific frame numbers to be 
rendered. Using this tab, any portion of an animation within the Start and Stop times can 
be rendered. This is very helpful when working in a large project, with multiple animation 
sequences. Using this setting, only a specific range of frames needs to be rendered. You 
can also use Range of Frames to render your animation in reverse order, by typing reverse 
values in the edit boxes.

Even Field

This checkbox specifies that when rendering interlaced animation files, the Even field will 
be rendered out as the dominant field. This defaults to off, because the RS-170A specifica-
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tion for NTSC calls for odd field dominance. Some video cards break this rule (program-
mers always start on even numbers, such as zero, instead of odd numbers like one) and 
this option is present for those conditions. Be warned, even if your setup is even field dom-

inant, all production houses are odd field dominant — you might need to re-render!

How To Render a Project

The little button on the right side of the render window looks simple doesn’t it? Well, it 
actually features two modes of operation which turns it from a simple start button into a 
powerful selective rendering feature.

Go

To simply begin rendering a project, click the Go button. If you haven’t saved, you will be 
prompted to do so. Following that, ElectricImage will quit, launch the camera application, 
and begin rendering. 

Control-Go

One of the great, “hidden” features of ElectricImage is the Control-Go option. By holding 
down control when clicking Go, ElectricImage prompts you to locate the Camera applica-
tion. This allows you to select a camera from any mounted drive, including networked 
machines, for rendering. Thus, by doing a Control-Go, instead of a standard go, you can 
send a render to launch on a slave camera on any network machine. Also, when using this 
method, ElectricImage launches the selected camera application as a separate process. So, 
if you have enough memory you will never need to quit ElectricImage when sending a 
render. Similar to the Preview Render option, control-go allows you the utmost in flexibil-
ity when sending a render.

Network Rendering

You can render to as many Macintosh computers as you wish (assuming they meet mini-

mum performance requirements.) Renderama, the ElectricImage network control applica-
tion, must be available in the same folder as ElectricImage, and properly configured. (See 

the Renderama chapter in the 2.5 Supplement for further information.)
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Selection Sets

Introduction

Although this chapter is deceptively short, it discusses a seemingly simple part of Elec-
tricImage that grows in importance with the complexity of the project: selection. Just as 
image-editing and illustration applications have multiple methods of selecting elements 
based on their attributes, then acting on them in ways unique to the selection process, we 
have widened the scope of how selections are made in ElectricImage — of how they are 
used to organize a project, and how they can be used to create special effects.

To move an object or access the material attributes of a group, you must first select the 
object or group. This is done by clicking once on the object, either in the world views or 
Project Window, or by dragging a rectangle around one or more groups. To facilitate selec-
tions which are larger in scope, the Select menu was added in version 2.7.5. That menu 
allowed you to select models and groups by a variety of methods.

In ElectricImage 2.8, the Select Menu has a new selection type added, By Set. A set is sim-
ply a defined collection of groups from within a project. The By Set menu option allows 
you to edit selection sets, or select items in the project that already belong to an existing 
set. The hierarchical menu below By Set initially contains a single entry, Edit Sets. As sets 
are created their names will appear in this space.

Selection sets are used for light inclusion/exclusion lists, glow layers and, of course, typi-
cal selections. Selection sets will come in very handy as you work with ElectricImage.
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Select by Set

Figure 87 — Select Menu
 
Sets have four purposes in ElectricImage 2.8. 

• To select groups of items within the project
• To include or exclude groups from a light’s illumination
• To control the glow radius and glow intensity for a set of models
• To control which objects receive projections from Camera Maps.

To Create a Set

• Choose Edit Sets from under the Select menu.
• The Sets window, show below in the illustration “Selection Sets Window” on 

page 137, opens.
• In the Selection Sets column, click Add. When prompted, create a name for your set.

The name of the selection set will be appended to the Select>By Set menu.
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The Selection Sets Window

Selection Sets 

The left column, Selection Sets, contains the names of all existing sets. Once you create 
your set its name will appear in this column. New sets can be created and old sets can be 
deleted using the Add and Remove buttons. The Sort pull down gives you the option of 
viewing the list of sets alphabetically or in their creation order.

Members

The right column, Members, shows the members of the set that is highlighted in the left 
column. To add members to an existing set, go to the Project window and highlight the 
names of the groups to be added. Then return to the Selection Sets window. 

Figure 88 — Selection Sets Window

In the left column, highlight the set name to which you wish to add the objects and click 
on the add button on the right side of the dialog box. Members of sets or whole sets can be 
removed by highlighting the item and clicking on the remove button.
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Materials and Texture Maps

Introduction

In this chapter we will discuss the new Materials and Texture Map features in Electric 
Image 2.8. Materials are what the rendering engine uses to give shading and detail to a 
group. Textures are a component of Materials (new to ElectricImage — previously tex-
tures were treated separately). Procedural Shaders are also a component of Materials, but 

are covered in the Procedural Shaders chapter.

Great effort has been spent conforming to industry standard material terms and behavior 
wherever possible. This was done to allow you to take advantage of the myriads of books 
and publications which cover the topics of 3D which are now available, and to make Elec-
tricImage even easier to use than ever before.

Overview of New Features

The following highlights will give you an idea of the radical changes to the Materials and 
Texture Map capabilities of ElectricImage 2.8. 

• Master Materials (materials that groups can subscribe to)
• Materials Can Be Saved To Disk
• Industry Standard Material Controls
• New, Easy to Use Interface Design
• Displacement Maps
• Clipping Maps
• Procedural Shaders
• Unlimited Texture Maps
• Precise Texture Mapping Controls
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Materials Defined

Materials are a collection of shading attributes, called channels, that you create and apply 
to a group (or groups.) Materials can also contain texture maps and procedural shaders. 
You can apply materials from saved material files on disk, from materials created in the 
Material Info Window, or from Master Materials. 

Master Materials

Master Materials are new to ElectricImage 2.8. They are visible in the Project Window, and 
can have many groups linked to them. Master Materials will replace all of the attributes of 
the groups linked to them (an exception to this rule applies to locked maps.) You will still 
have to tweak the texture map alignment to fit each particular group for the best results, 
unless the groups are similar in shape. You can have as many Master Materials as you 
wish in a project. To add a Master Material to a project, choose File>Add>Type>Material. 
You will now see the Material at the top of the item list in the Project Window.

Groups must be linked to Master Materials in order to use them. You can link as many 
groups as you like to an individual Master Material. A group may be linked to only one 
Master Material in a scene.

To link a group to a master material:

• Select the group (or groups) that you wish to link to the Master Material
• Click on the Link Material icon in the Project Window tool bar
• Click on the desired Master Material in the Project Window List

The selected groups are now linked to the Master Material. You can confirm this by setting 
the Project Window display icon to “By Material.” The Project Window display will 
change to show the groups that are linked to the Master Materials displayed as children to 
the Master Material.
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Accessing the Material Info Window

In order to create or edit a material or Master Material, you need to get to the Material Info 
Window. There are four ways to access the Material Info Window:

• Select the Group, and click the Material Info Window icon in the Project Window
• Command double click on a Group in any window
• With the Group Info Window open, click on the Material Ball icon
• Double click a Master Material in the Project Window

The Material Info Window

There are two variants of the Material Info Window, one for group materials, and one for 
Master Materials. 
 

Figure 89 — Master Material Info Window
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The primary difference between the Group Material Info Window and the Master Material 
Info Window are the material management buttons, located above the tab area. The fol-
lowing discussion applies to both window variations.

Figure 90 — Group Material Info Window

The Material Info Window sports a totally new look and feel. All of the material channels 
now have their own tabs, with each tab containing the controls and functions indicated by 
the name of the tab. To access the contents of the tab, just click on it.

Above the tabs you see the material ball icon to the left. The material name edit field is just 
to the right of that. Below are the Load and Save Material buttons, and below them is the 
Create New Master button. To the right of the buttons is the Material Statistics section, 
which illustrates the makeup of the material.
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The material ball icon shows a live preview of the settings of the various material chan-
nels. To copy a material, select the Material Ball Icon and choose Copy. To paste a new 
material into this material record, select the Material ball icon, and choose paste. (You can 
change the background color of the material ball icon by option clicking in the back-
ground of the icon, and choosing the preferred background display pattern or color.)

Loading and Saving Materials

One of the most powerful new features is the ability to create a material and save it to disk 
to be called up any time it is needed. The material is saved to a directory within your Elec-
tricImage directory called “EI Material.” The saved material contains the settings of the 
various material channels (diffuse, specular, etc.), as well as, external references to texture 
maps and procedural shaders.

To load a material

• Click the Load button
• Choose a material from the directory
• Double click the material or click the open button

The material is now applied to the group. Groups can only have one material assigned to 
them, whether you assign a material to a specific group, or whether you assign a group to 
a master material.

To save a material

• Make sure that the material is named
• Click the Save button

The material is then added to the EI Material directory. ElectricImage does not provide 
any indication that the material has been saved. To check this you can save it again, if you 
like. When you do, you will then be asked if you wish to replace the material (indicating 
that it was previously saved.)
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Creating New Master Materials

You can create new Master Materials from the Material Info Window of a particular 
group, or you can add them to a project as described previously. Groups can be linked to 
them with a special material link command described in the Master Materials section.
Groups can be passively linked to a Master Material, or they can be “live linked.” Pas-
sively linked groups will require a manual update to receive any changes that are made to 
the Master Material they are assigned to. Live linked groups will be updated immediately 
upon any change to the Master Material they are assigned to.
 
To create a Master Material:

• Set up your material
• Click on the Create New Master button
• A dialog will appear, prompting you to name the material.

A Master Material version of the material you were editing now appears in the Project 
Window item list. You will note that two new material management buttons have now 
been added to your material, just below the Create New Master button: Reload from Mas-
ter and Update Master.

Figure 91 — Material Management Buttons

Reload From Master

This button appears in groups that are passively linked, not live linked, to a Master Mate-
rial, and reloads the material properties from the Master Material. This is useful if you are 
exploring a change to a material but decide you prefer the original.
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Update Master

This button appears in groups that are passively linked, not live linked, to a Master Mate-
rial, and replaces the Master Material with the current material. Groups that are live 
linked to the master will be immediately updated.

New Material Interface

With ElectricImage 2.8, the Material Info Window now presents all material channels in a 
tab context. This makes all of the shading attributes of ElectricImage very accessible and 
easy to use. It should not take very long to get acclimated to the new interface.
To edit a particular channel within a material, just click on its tab. A material channel is a 
shading component, referred to as “surface attribute” in the ElectricImage Series 2 Refer-
ence Manual. We are calling them channels now to more appropriately reflect their nature 
and how you can use them. There are eight material channel tabs:

• Geometry
• Diffuse
• Specular
• Ambient
• Reflectivity
• Transparency
• Luminance/Glow
• Transmission

Each channel tab contains the many attributes which are controlled by the channel, 
including texture maps and procedural shaders.
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The Geometry Tab

The geometry tab contains all of the material channels and attributes which affect the 
apparent geometry of a group and how it is shaded. You can add outlines to the group, 
add bump and displacement maps for more detail, or punch actual holes into the group 
with clipping maps (and shadows do see these holes.)

The geometry tab is organized into three basic sections:

• Cel/Outline Shader section
• Bump/Displacement Map list
• Clipping Map list

Figure 92 — Geometry Tab

Cel/Outline Shader Section

In this section you assign color and thickness to polygon outlines, edge outlines and sil-
houette outlines. Used in conjunction with the Cartoon procedural shader, the look of tra-
ditional 2D cel animation can be achieved. There are three types of line effects:
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• Polygon Outlines
• Edge Outlines
• Silhouette Outlines

Polygon Outlines

Activating this setting causes all of the polygons in the group to receive an outline. This is 
similar to wireframe shading, except that the polygon will also be shaded.

Edge Outlines

Activating this setting will cause certain edges to be defined with lines. As the group or 
camera is in motion, the definition of the edges will change, similar to the effect you see in 
traditional 2D animation. The silhouette feature should be active with this feature.

Silhouette Outlines

This setting causes the silhouette of an object to be drawn in lines. On occasion, the silhou-
ette is not clearly resolved, so it is best to use this feature with the Edge Outline feature 
enabled.

To activate the particular line effect you wish you must click in the check box. You can 
color the lines by clicking on the color swatch and choosing a new color from the color 
picker. To adjust line thickness, type in a new value in the edit box to the right of the line 
type (values are in pixels.)

The way the model is constructed is very important with this feature. If the polygons of 
the model are not properly welded, the edge outline feature will find and render all edges, 
creating unwanted lines within your rendered image. If you notice this happening, re-
import the model with the Combine Coordinates feature turned on (see the ElectricImage 

Series 2 Reference Manual pp.1-25 and 1-26 for more information on welding vertexes.)
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Bump/Displacement Maps List

The Bump/Displacement Maps list is where you add maps of these type. You can add as 
many maps as you like to this list. Along with the standard bump map, displacement 
maps are now supported. Displacement maps actually move the vertexes in the group 
using the map to determine how much displacement is applied. 

With bump maps the illusion of depth or relief can be created such as the bark on a section 
of log. The limitation to bump mapping is that the silhouette or edge of the log is perfectly 
smooth and the closer to the edge the more obvious the cheat. With a displacement map 
the geometry is actually moved, so the edge of the log shows relief as well as the center. It 
is important that there be enough vertex points in the group to achieve a satisfactory 
effect. It might be necessary to apply the Dicer plug-in to the group to achieve best results. 
(Dicer is covered in the ElectricImage Version 2.5 Supplement, chapter 8.)

Bump maps and displacement maps can be either a grayscale bitmap image or movie file 
or a procedural shader. Any bitmaps of greater than 256 colors will be converted to gray 
scale by the rendering engine to achieve the effect. If an alpha channel is present, it can be 
used to control the bump instead. (See the section “Map Alpha Channels” on page 179 for 

more details on the alpha channel.)

To add a bump or displacement map

• Click on the add button next to the bump map list
• Choose the Map
• Double click on the map or click on the open button

The map will be added to the list. You can configure the map by double clicking on the 
name of the map in the map list. (See the section “Using Texture Maps” on page 178 for 

more details.)

Controls for the strength of the bump and displacement are found under the Special Tab 
in the Texture Info Window (“Special Tab” on page 193,) and these controls can be ani-
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mated. Setting Bump Factor to 0 will disable the bump calculation. Setting Displacement 
to 0 will disable the displacement calculations.

Clipping Maps List

The clipping maps list is where you add clipping maps to your group. You can add any 
amount of clipping maps or procedures to this list. Similar to transparency maps, clipping 
maps are a quick and efficient way of cutting holes into a group. Unlike a transparency 
map, the clipped region is anti-aliased independent of resolution. Zooming in close, the 
clipped object will still exhibit very clean edges. Clipping maps actually remove geometry, 
so they will create appropriate shadows. 

Clipping maps can be either a grayscale bitmap image or movie file or a procedural 
shader. Any bitmaps of greater than 256 colors will be converted to gray scale by the ren-
dering engine to achieve the effect. If an alpha channel is present, it can be used to control 
the clipping instead.

To add a clipping map

• Click the Add button next to the Clipping Map list
• Select the map or procedural from the dialog
• Double click the map, or click the open button

The Clip factor edit box is found in the Texture Info Window under the special tab, and 
controls the strength of the clipping map, where 0 is fully transparent and 1 is fully 
opaque.

The Diffuse Tab

The diffuse tab contains all of the material channels and attributes which affect the diffuse 
channel of a group. The diffuse channel is where color is applied, and you will note that 
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there is no longer a surface color attribute. (This was done to more closely conform to 

industry standard guidelines. By conforming to as many industry standards as possible, 

much of the information available in magazines and books which cover the 3D spectrum 

will be applicable in ElectricImage, making it easier to learn and use.)

Figure 93 — The Diffuse Tab

The diffuse tab is organized into two basic sections:
• Diffuse parameters
• Diffuse Maps list

The diffuse parameters section contains a color swatch, slider bars for controlling the 
amount of energy transmitted by the group, the falloff of that energy, and the mask opac-
ity for the group. There is also a checkbox that allows you to use the original polygon col-
ors of the group (some modeling programs let you assign unique colors to individual 

polygons, which you may want to keep.)

Color Swatch

To choose a diffuse color, click on the swatch and pick a new color from the color picker. 
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Use Polygon Color

This check box forces the renderer to use the color assigned to the individual polygons of 
the group when it was created. Assigning a color to the group with the swatch will ignore 
all of the polygon colors in the group. You can revert back to the original color of the 
group with this checkbox.

Amount

Use this slider to darken the group’s color. The slider bar will use the color in the swatch 
(or the polygon colors if Use Polygon Color is active) as top end of the range (brighter). 
You can also type in a value in the Amount edit box. The Amount slider is a nifty way of 
keeping your diffuse color intact while adjusting the brightness levels of the group. 

Falloff

Falloff was formerly called Shading Dropoff, and sets transition value from fully shaded 
to not shaded. Larger objects to have sharper falloff values (such as planets, where .25 is a 
good falloff value.) Smaller objects should have falloff values closer to 1.0.

Some sliders will accept values of greater than 1.0, or less than zero. You can adjust the 

value by typing in the value that you wish in the edit box to the right of the slider. Falloff 

is one of the attributes that allow this.

Mask

This slider affects the alpha channel for the group (often called a Mask or Matte) in the 
final render. This feature can be used in conjunction with a compositing effects. If you 
want the group to appear normally in the scene, then leave the value at 0.0 (opaque on the 
slider.) If you want the group to act as a cutter, removing its shape from the scene, then set 
the value of the mask attribute to 1.0 (transparent on the slider.) Note that a true hole will 
be left behind, if the group is obscuring another object if this setting is anything more than 
0.0.
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Diffuse Maps list

The diffuse maps list is where you add color maps, procedural shaders, or diffuse value 
maps. You can put as many maps as you like in this list. Maps can be single frames or 
movie files, and can be any bit depth desired.

To add a diffuse map to the list:

• Click the Add button next to the Diffuse Map list
• Select a map or procedural shader from the file list
• Double click the map, or press the Open button
The map will now be added to the list. To configure the map, double click on the map 
name in the list. To reorder the map in the list, just drag it to its new location. (See the sec-

tion “Using Texture Maps” on page 178 for more information on working with texture 

maps.)

The Specular Tab

The specular tab contains all of the material channels and attributes which affect how the 
various specular attributes of a group will shade. The specular tab is organized into two 
basic sections:

• Specular Attributes
• Specular Map List
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Figure 94 — The Specular Tab

The Specular Attributes section contains a color swatch, slider bars for controlling the 
amount of specularity, gloss, size and falloff, and a diffuse bias check box.

Color Swatch

The color swatch is used to set the color of the specular highlight. To choose a color, click 
on the swatch and pick a new color from the color picker. This setting is ignored if the Dif-
fuse Bias setting is active.

Diffuse Bias

This check box forces the specular color to be equal to the diffuse color. The color of the 
highlight is added to the diffuse color, making the highlight brighter than the surrounding 
area. This is analogous to the way that highlights work in the real world, and defaults to 
on (which ignores the color in the color swatch.)

Amount

The Amount slider controls the brightness of the specular highlights that appear on the 
group. A value of 0 turns off the highlight. 
ElectricImage 2.8 Supplement        153



Materials and Texture Maps — The Specular Tab
Gloss

The gloss slider adds a gloss or sheen to your group. It imitates what the group would 
look like if it were a bit reflective, removing color from the surface around the highlight. It 
can create an odd look, so you might want to use this sparingly.

Size

Controls the size of the highlight on the group. The smaller the number, the larger the 
highlight. Values of greater than 1.0 can be typed into the Size edit box.

Some sliders will accept values of greater than 1.0, or less than zero. You can adjust the 

value by typing in the value that you wish in the edit box to the right of the slider. Specu-

lar size is one of the attributes that allow this.

Falloff

Controls the sharpness of the highlight. Larger numbers give a sharper, more abrupt tran-
sition, and smaller values produce a smoother and less defined highlight.

Specular Maps List

A specular map controls the area in which the specular highlight is visible on a group, as 
well as the value (brightness) of the highlight or the color of the highlight. Specular value 
maps can be either a grayscale image or movie file or procedural shader. Any bitmaps 
greater than 256 shades will be converted to gray scale by the renderer for specular value 
maps. If an alpha channel is present, it can be used to control the specular instead of the 
RGB channel. (See the section “Map Alpha Channels” on page 179 for more details.)

To add a specular map to the list:

• Click the Add button next to the Specular Map list
• Select a map or procedural shader from the file list
• Double click the map, or press the Open button
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The map will now be added to the list. To configure the map, double click on the map 
name in the list. To reorder the map in the list, just drag it to its new location. (See the sec-

tion “Using Texture Maps” on page 178 for more information.)

The Ambient Tab

The ambient tab contains all of the material channels and attributes which affect the ambi-
ent shading characteristics of the group.  Ambient is a simulation of ambient fill light, and 
you can make the ambient take a different color cast than the diffuse channel.

Figure 95 — The Ambient Tab

There are two basic sections to the ambient tab:

• Ambient Attributes
• Ambient Map List

The ambient attributes section contains a color swatch and a slider bar.
ElectricImage 2.8 Supplement        155



Materials and Texture Maps — The Reflectivity Tab
Color Swatch

Controls the color cast of the ambient fill light on the group. To change the color, click on 
the color swatch and pick a new color from the color picker.

Amount

Controls how the group responds to ambient light. Larger numbers will make the group 
appear to have more fill color, and be a little less defined. Higher fill values would be 
appropriate for objects in sunlight. Lower fill values would be more appropriate for night 
time or deep space shots.

Ambient Map List

Ambient maps can affect the color of the ambient effect, the value of the effect, and the 
areas of the group that receive the ambient effect. You can have as many ambient maps as 
you like in the material. An ambient map can be an image or movie file or a procedural 
shader.

To add an ambient map to the list

• Click on the Add button next to the Ambient Map List
• Select the map
• Double click the map, or click the Open button

The map is now added to the list.To configure the map, double click on the map name in 
the list. To reorder the map in the list, just drag it to its new location. (See the section 

“Using Texture Maps” on page 178 for more information.)

The Reflectivity Tab

 The reflectivity tab contains all of the material channels and attributes which affect how 
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and what the group will reflect. The reflectivity tab is one of the more complex tabs in the 
Material Info Window. There are four main sections to the reflectivity tab:

• Reflectivity Configuration (How the Group Reflects)
• Reflection Configuration (What the Group Reflects)
• Reflectivity Map List
• Reflection Map List

Both the Reflectivity Configuration section and the Reflection Configuration section are 
comprised of additional subsections.

Figure 96 — The Reflectivity Tab

The Reflectivity section resides within the left side of the tab, and the Reflection section 
resides on the right side of the tab.

Reflectivity Configuration Section

The reflectivity configuration section contains the basic reflectivity controls and special-
ized edge attenuation controls.    
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Amount

The Amount slider is used to control overall reflectivity amount of the material. The valid 
ranges are 0.0 to 1.0.

Color Swatch

The color swatch tints the group’s reflection. It is disabled if the Reflection Bias checkbox 
is enabled.

Reflection Bias

This check box forces the reflected color to be equal to the diffuse color. The reflection is 
then added to the group by whatever percentage is set in the Amount attribute. This is 
more realistic than setting the color of the reflection manually, and defaults to on. 

Edge Control (Attenuation) Section

Edge control allows you to attenuate the reflection across the surface of the group (this is 
also called the Fresnel effect.) Objects in the real world tend to reflect more intensely 
towards the edge, and less so towards the center as seen from the viewer’s point of view. 

To illustrate this effect, set the reflectivity amount to .5, edge amount to 1.0 and falloff 

amount to 1.0. Note that the center of the material ball shows no reflection, but the edges 

are quite reflective.

Amount

The amount value controls the amount of reflection along the edge of the group. It is fac-
tored into the overall reflection amount. This value is unused if the edge falloff amount is 
set to 0.0.
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Falloff 

The Falloff value controls how the reflection will fall off towards the center of the group. 
The higher the number, the less reflection you will see at the center of the group. This 
value is not considered if the Edge Amount value is 0.0.

To the right of the edit boxes is a graph area, which shows the relationship of the Edge 
Amount and Falloff values. With the Edge Amount set to 1.0, and the Edge Falloff set to 
0.0, the graph will appear as a white square (the default.) This indicates that the reflection 
will appear evenly across the surface of the group. As you adjust the relationships 
between the two values, you will see the graph change to reflect the new values.

Reflectivity Maps List

A reflectivity map controls how the group will reflect any reflection maps assigned to it in 
the Reflection Map section. It can also control what areas of the group receive a reflection, 
and how much of it. Any bitmap image, movie or procedural shader can be used as a 
reflectivity map.

To add a reflectivity map to the list:

• Click the Add button next to the Reflectivity Map list
• Select the map or procedural shader from the file list
• Double click the map, or press the Open button

The map will now be added to the list. To configure the map, double click on the map 
name in the list. To reorder the map in the list, just drag it to the new location. (See the sec-

tion “Using Texture Maps” on page 178 for more information.)

Reflection Map Configuration Section

Reflection maps are what the group is actually reflecting. Reflection maps can be bitmaps, 
either still or movie files. Procedural shaders cannot be used for reflection maps. Reflec-
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tion maps can also be automatically generated by ElectricImage. These are called mirror 
maps, which are flat, and environmental maps, which are cubic. The controls for the auto-
matic maps are in the Environment Reflection subsection.

In the main Reflection Map Configuration section, there are three check boxes:

• Use Global Maps
• Use Bitmap Reflection
• Use Environmental Reflection

Any or all of these settings can be selected at any time. Each map has an amount slider 
that allow maps to be less than full intensity. This allows reflections to be added together, 
say global maps with bitmap reflections. The effect is additive, which may not be desired.

Use Global Maps

This check box enables the reflection maps applied under the World Info Window located 
in the Project Window as a reflections for the group. This setting allows as many groups as 
you wish to use the same reflection. This map can also function as a “default” reflection 
map, removing the need to physically assign a reflection map to the group.

Use Bitmap Reflection

This check box enables the group to reflect maps from the reflection map list.

Use Environment Reflection

This check box enables any of the selected Environment Reflections specified in the Envi-
ronment Reflection subsection.

Environment Reflection Subsection

There are three choices in the subsection:
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• None
• Mirror
• Environment

None

No map is selected. This is the default condition.

Mirror

Mirror maps are flat, and automatically render an exact mirror reflection, relative to the 
established mirror plane. You control the mirror plane through the Configure… button in 
the subsection. It is necessary to establish a plane to guarantee expected results. (See the 

section “” on page 181 for more information.)

Environment

Environment maps are cubic reflection maps that are automatically created by the render-
ing engine. The rendering engine creates six images representing the faces of the cube. 
These images then form the basis of the reflections on the group. You can control the reso-
lution of the environment map with the Configure… button. The resolution settings are in 
an edit box available under the Projection tab. (See the section “Map Projection Tab” on 

page 184 for more information.)

Please note that environmental reflections and mirror reflections can add up rendering 

time if you use alot of them. These methods provide a much faster reflection than ray 

traced reflections, as long as they are not abused. Overuse of these types of reflections can 

engender render times equal to or greater than ray traced reflections available in other 

programs.

To save render time, you can set an automatic environment map to calculate its reflection 
only once. This setting is available through the Configure… button, in the Filter tab. (See 

the section “Calculate Once (automatic reflections only)” on page 190 for more details.)
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Reflection Map List

The reflection map list is where you add the bitmap images or movies that you wish the 
group to reflect. 

To add a reflection map to the Reflection Map List

• Click on the Add button next to the Reflection Map list
• Select a map from the file list
• Double click the map, or press the Open button.

The reflection map is added to the list. To configure the map, double click on the map 
name in the list. To reorder the map in the list, just drag it to its new location. (See the sec-

tion “Using Texture Maps” on page 178 for more information.)

The Transparency Tab

The transparency tab contains all of the material settings and attributes which affect the 
transparency of the group. Several improvements and modifications have been incorpo-
rated in the transparency calculations used by the rendering engine, and industry stan-
dard presentations of the transparency attributes have been incorporated into the 
interface wherever possible.

Please note that the specular highlight and reflection calculations for the group are not 

affected by the transparency settings. If you wish to lessen their impact on a transparent 

group, you will need to adjust these values separately.
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Figure 97 — The Transparency Tab

The transparency tab contains four sections:

• Transparency Attributes section
• Edge Characteristic section
• Transparency Map list
• Transparency Edge Map list

Transparency Attributes Section

The transparency attributes section contains controls for setting the actual transparency of 
the group. The slider bar controls the amount of transparency. The three buttons to the 
right of the slider control the type of transparency applied to the group:

• Filter
• Color Filter
• EI Filter
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Filter

Filtered transparency groups are mathematically “averaged” into the scene, meaning that 
they do not change the appearance of any groups that fall behind them, with the excep-
tion of dimming the brightness values of those groups by the value set for the transpar-
ency. This effect does not reflect how transparent objects behave in the real world, and 
tends to be used primarily for special effects. 

Color Filter

Color filter transparencies are either subtracted from the scene or added to the scene, 
depending upon which choices you make in the filter mode subsection. (The filter mode 

subsection is visible only if this option is selected.) 

Figure 98 — Filter Mode Subsection

The filter mode subsection is divided into two areas:

• Filter Mode
• Filter Color

Filter Mode

Filter Mode determines the method by which the transparency will be applied to the 
scene. 

Subtractive transparencies most accurately mimic the effect of transparent objects in the 
real world. Groups which pass behind a subtractively transparent group will be tinted to 
color of the transparent group, as the color of the transparent group is subtracted from 
whatever is behind it. 
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Additive transparencies are typically used for special effects purposes, such as glowing 
balls of energy and so forth. Groups which pass behind additive transparent groups will 
appear brighter, as the color of the transparent group is added to whatever is behind it.

Filter Color

Filter color is used to determine the color that will be used for the filter effect. 

The Use Surface Color option will use the Diffuse channel and all attributes assigned to it 
for the filtering process set by the Filter Mode switch. This is the most realistic setting, and 
the default.

The Use Custom Color option will use the color in the swatch next to the item as the filter-
ing color. It will ignore all of the attributes in the Diffuse channel. To change the color of 
the swatch, click on it and pick a new color from the color picker.

EI Filter

This setting is included for project file compatibility with previous versions of ElectricIm-
age. (See the ElectricImage Series 2 Reference Manual p. 8-14 for a discussion on this type 

of transparency.) The color filter transparency method offers far more control and ease of 
use than this method. Consider ingoring this method when you are creating new projects 
from scratch.

Figure 99 — EI Filter Options

When this option is selected, the EI Filter options subsection appears. It consists of two 
items:
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• Use Surface Color
• Use Custom Color

Use Surface Color

This option will use the diffuse channel and all attributes associated with it as the filtering 
process for the transparency. This item is new to ElectricImage 2.8. 

Use Custom Color

This option will use the color in the swatch as the filter color. This is analogous to the 
methods used by previous versions of ElectricImage. To change the color in the swatch, 
click on it and pick a new color from the color picker.

Transparency Map List

Transparency maps can be applied to modify the amount of transparency or to modify the 
color of the transparency (see “Use Channel Popup Menu” on page 191 for more informa-

tion). You can have both types of maps in the list. Maps can be bitmap images and movie 
files, or procedural shaders. 

To add a transparency map to the list:

• Click on the Add button next to the transparency map list
• Choose a map from the file list
• Double click on the map, or press the Open button

The map is added to the list. To configure the map, double click on the map name in the 
list. To reorder the map in the list, just drag the map to its new location. (See the section 

“Using Texture Maps” on page 178 for more information.)

Edge Characteristic Section

The items in this section control the effect of the edge of an group, regardless if the group 
is set to be transparent or opaque.   For transparent groups, you can adjust the opacity of 
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the edge, and the falloff when the edge gets more opaque. For opaque groups, you can 
adjust when the edge of the object becomes more transparent. 

A notable difference between ElectricImage 2.8 and previous versions is that the Edge 

Color value has been removed. Instead, the edge color is derived from the color of the dif-

fuse channel. If a colorless transparent glass look is desired, set the transparency method 

to color filter, select subtractive, and the custom color option. Click on the color swatch 

to set a new color, perhaps a lighter variant (close to white) of the diffuse color selected 

(remember, we are using that value to give the edge some color.) Because you have selected 

the subtractive transparency mode, the white will be removed, leaving no color contami-

nation behind, as more saturated colors will do. This will give a result equivalent to ear-

lier versions of ElectricImage.

There are two sliders which affect the look of the edge:

• Amount
• Falloff

The Edge Characteristic sliders work similarly to the Edge Reflection sliders (covered in 

the section “The Reflectivity Tab” on page 156.) The type of effect achieved is determined 
by the three edge control buttons described following the Amount/Falloff discussion.

Amount

This slider determines the amount of edge transparency or opacity applied to the group. 
The falloff value (described below) must be set to a value other than 0.0 to see the effects 
of this slider. The range of this slider is 0.0 to 1.0.

Falloff

This slider determines how the edge will intrude into the body of the group. The Edge 
Amount slider must have a value other than 0.0 to see the effect. This slider has an infinite 
upper range, however, you may find numbers greater than 5 of no useful effect.
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Edge Graph

To the right of the sliders and edit boxes is the edge graph, which shows the relationship 
of the Amount and Falloff parameters in graphic form. It updates in real-time as these val-
ues are edited. You will note that the more white area in the graph, the more powerful the 
defined edge will be, as represented in the material ball. The curvature plotted in the 
graph represents the actual mathematical function plotted by the values in Amount and 
Falloff

Edge Control Buttons

There are three radio buttons which control the treatment of the edge of the group:

• Normal
• Opaque
• Transparent

Normal

No edge characteristic is applied. The transparency effect is carried evenly through the 
group. This often yields a group with less definition, and is considered less realistic for 
transparencies.

Opaque

The edges of the group will be opaque, using the parameters set by the Amount and Fal-
loff sliders. For transparent objects, this option yields the most realistic results, with the 
Amount and Falloff values set to your preference.

Transparent

The edges of the group will be transparent, using the parameters set by the Amount and 
Falloff sliders. Opaque objects can be made to have clear, fluffy edges, and can be used for 
such things as clouds, cotton balls, or planet atmospheres.
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Transparency Edge Map List

Transparency edge maps work the same as the transparency maps and can affect the value 
or color of the transparency at the edge of the group.

To add a transparency edge map to the list:

• Click on the Add button next to the transparency edge map list
• Choose a map from the file list
• Double click on the map, or press the Open button

The map is added to the list. To configure the map, double click on the map name in the 
list. To reorder the map in the list, just drag the map to its new location. (See the section 

“Using Texture Maps” on page 178 for more information.)

The Luminance/Glow Tab
The luminance/glow tab contains all of the material channels and attributes which affect 
the luminosity and glow effects that a group can have applied to it. 
 

Figure 100 — The Luminance/Glow Tab
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The luminance/glow tab is divided into four sections:

• Luminance Color
• Glow Color
• Luminance Map List
• Glow Map list

Luminance Color Section

The luminance value controls the group’s self illumination. (This value does not actually 
cause the group to emit light, but rather glow like an LED would glow.) The slider con-
trols the amount of self illumination of the group, using either the color in the color 
swatch, or the diffuse shading channel of the group. Texture maps can also be used to con-
trol the luminescence of the group. 

Use Color Button

The use color button will cause the group to luminesce with the color in the color swatch. 
The change the color in the swatch, click on it and pick the color from the color picker.

Use Shading Button

The use shading button will cause the group to luminesce with the values found in the 
diffuse channel.

Luminance Map List

Luminance maps can be either value maps or color maps. In the case of grayscale the 
white areas of the map will illuminate to white and black areas will not illuminate. In the 
case of a color map the illumination will possess the colors of the map.

To add a map to the luminance map list:

• Click the Add button next to the map
• Select a map from the file list
• Double click the map, or press the Open button.
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The map will now be added to the list. To configure the map, double click on the map 
name in the list. To reorder the map in the list, just drag the map to the new location. (See 

the section “Using Texture Maps” on page 178 for more information.) 

The map will now be added to the list. To configure the map, double click on the map 
name in the list. To reorder the map in the list, just drag the map to the new location. (See 

the section “Using Texture Maps” on page 178 for more information.) 

Glow Color Section

The glow effect causes groups to apparently emit a glowing area around the group. The 
glow is a compositing effect added at the end of each rendered frame (and as such the 
effects of the glow settings are not represented in the material ball icon.) Glowing groups 
will not effect the appearance of other groups in the scene. Setting up glows properly 
requires the following procedure:

• Setting the glow attribute in the group’s material
• Assigning the group to a selection set
• Adding a the selection set to the glow layer tab in the Render Information Window
• Set up the glow layer

Setting the Glow Attribute in the Group’s Material

In the Glow Color section, you can control the amount that an object will glow, the color or 
shading of the glow, and whether the group will actually glow, or have a glare on the 
brighter areas of the group (which you can control.)

Glow

The Glow radio button will use the color swatch as the glow color. The value of the glow 
is set by the Glow Amount slider. To change the color in the color swatch, click on the 
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swatch and pick a color with the color picker. The actual area of glow is determined by the 
attributes of the Glow Layer, found in the Glow Layer tab of the Render Information Win-
dow. If the group is not part of a selection set contained within a Glow Layer, then the 
group will not appear to glow in the rendering.

Glare

The glare button will use the diffuse channel to create a glare around the group. The 
amount slider determines the brightness cutoff for the glare. Typically, a fairly subtle cut-
off is desired, as glares tend to be less overpowering than glow effects. 50% is a good 
value for the brightness cutoff to begin with. You can have the entire group “radiate” by 
setting the slider to 0.0. This makes the group appear to be heavily over-exposed, depend-
ing upon the settings in the glow layer to which the group’s selection set is assigned.

Figure 101 — Teapot without glare on the left, Teapot with glare on the right

Any pixels which fall within the specified tolerance set by the Glow Amount attribute will 
be blurred by the amount specified in the Glow Radius attribute of the Glow Layer, and 
then added back onto the scene by the amount specified in the Intensity attribute of the 
Glow Layer to which it is assigned. Glow Radius values of 50 pixels or greater, plus a 
Glow Intensity of 1.5 will give you a good starting point for a nice glare effect (as shown in 
the illustration.)
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The actual area of the glare is determined by the attributes of the Glow Layer, found in the 
Glow Layer tab of the Render Information Window. If the group is not part of a selection 
set contained within a Glow Layer, then the group will not glare in the rendering.

To assign the Group to a Selection Set:

• Select the group
• Choose Select>By Set>Edit Sets
• Click the Add button in the Selection Sets section of the window that appears
• Type in the name of the set and hit return
• Select the name of the set that now appears in the list
• Click the Add button in the members section of the window
• Close the window

All of the selected groups will now be part of that named selection set. (For more informa-
tion on Selection Sets, see the Selection Sets chapter.)

Figure 102 — Edit Selection Sets Window

Add the Selection Set to a Glow Layer:

• Open the Render Information Window (File>Render…)
• Select the Glow Layer tab
• Click the Add button in the Glow Layer Section
• Type in Glow Layer name in the edit field and hit return
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• Select the Glow Layer in the list
• Click the Add button in the Glow Layer Member section
• Select the desired selection set from the list that appears, and click the Add button

Figure 103 — Glow Layer Tab of Render Information Window

The selection set is now added to the glow layer. (See the Chapter on the Render Informa-

tion Window for more details about working with Glow Layers.)

Set Up the Glow Layer

• Select a Glow Layer from the Glow Layer List
• Type in a value for the Glow Radius in pixels
• Type in a value for Glow Intensity

The smaller the pixel number in the Glow Radius edit box, the more defined and brighter 
the glow will appear. Larger values in the Glow Radius edit box might require an adjust-
ment to the Glow Intensity value to achieve the desired effect (larger intensity values for a 
stronger glow, smaller intensity values for a weaker glow.) Glow effects will typically be 2 
or greater in intensity, while Glare effects will probably not be brighter than 1.5, but feel 
free to experiment.

The previous steps cover typical glow and glare usage. (For more information, see the 

chapter on the Render Information Window, Glow Layer section.)
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Glow Color Maps List

Glow maps can be applied to control the amount of glow, and to control the color of the 
glow. Glow maps can be a bitmap image or movie file, or a procedural shader. You can 
have as many glow maps as you like.

To add a map to the glow color maps list:

• Click the Add button next to the glow color maps list
• Select a map from the file list
• Double click the map, or press the Open button

The map will now be added to the list. To configure the map, double click on the name of 
the map in the list. To reorder the map, just drag the name to the desired location in the 
list. (See the section “Using Texture Maps” on page 178 for more information.)

The Transmission Tab

 The transmission tab contains all of the material channels and attributes which affect the 
transmission characteristics of the group. Some objects in the real world can allow light to 
go through them to a degree. This effect can be seen of you were to hold up a leaf to the 
sun. You would notice the spidery vein network as darker shapes, and the thinner parts of 
the leaf would appear brighter. The transmission channel lets you correctly reproduce this 
phenomena.
ElectricImage 2.8 Supplement        175



Materials and Texture Maps — The Transmission Tab
Figure 104 — The Transmission Tab

The transmission tab is divided into three sections:

• Transmission Color Section
• Transmission Edge Control Section
• Transmission Maps List
• Edge Transmission Maps List

Transmission Color

This attribute determines the transmission amount and color. The best transmission color 
is white, as it will conform to the color of the group and any maps, plus the lightsource. 

Edge Control Subsection

Transmission edge control works the same as with edge transparency (see “Edge Charac-

teristic Section” on page 166,) allowing you to build less translucent edges to curved 
groups the way they would appear in the real world.
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Edge Amount

Controls the transmissiveness of the edge. The Edge Falloff slider must have a value other 
than 0.0 to see the effect.

Edge Falloff

This slider determines how the edge will intrude into the body of the group. The Edge 
Amount slider must have a value other than 0.0 to see the effect.

Edge Graph

To the right of the sliders and edit boxes is the edge graph, which shows the relationship 
of the Amount and Falloff parameters in graphic form. It updates in real-time as these val-
ues are edited.

Transmission Maps List

Transmission maps are used to control the value and color of the transmission. Transmis-
sion maps can be a bitmap image or movie file, or a procedural shader. After a map is 
assigned, the slider no longer has any effect as all the transmission information is derived 
from the value of the map.

The best way to achieve a natural look is to assign a standard color map under the Diffuse 
tab and then a grayscale transmission map under the Transmission Tab.

To add a map to the transmission map list:

• Click the Add button next to the transmission maps list
• Select a map from the file list
• Double click the map, or press the Open button

The map is now added to the list. To configure the map, double click on the name of the 
map in the list. To reorder the map, select the name and drag it to the desired location. (See 

the section “Using Texture Maps” on page 178 for more information.)
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Edge Transmission Map List

Edge transmission maps are used to control the value and color of the edge of the group. 
Edge transmission maps can be a bitmap image or movie file, or a procedural shader. 
After a map is assigned, the slider no longer has any effect, as all the transmission infor-
mation is derived from the value of the map.

To add a map to the edge transmission map list:

• Click the Add button next to the edge transmission maps list
• Select a map from the file list
• Double click the map, or press the Open button

The map is now added to the list. To configure the map, double click on the name of the 
map in the list. To reorder the map, select the name and drag it to the desired location. (See 

the following section on Texture Mapping for more information.)

Using Texture Maps

ElectricImage 2.8 introduces unlimited texture maps per group. Texture maps are an inte-
gral component of a material — not separate, as in previous ElectricImage versions. Tex-
ture maps do different things, depending upon the tab and map list in which they reside. 
The same map can be used in many different channels, and each channel can have an 
unlimited amount of maps as well.

All of this power can come at a price if you are not frugal with your map management. Be 

careful not to waste maps and map memory. If you just need a grayscale value for a bump 

map, then you would be wasting over 1 MB of RAM (for a typical map) if that same map 

also had RGB channels associated with it (and was unused elsewhere).

New map placement controls have been added that allow face to face precision of map 
placement. These tools augment the original projection mapping approach found in previ-
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ous versions of ElectricImage. Multiframe maps can be easily controlled with start and 
stop times and stop ranges. Most of the map functions described in this section can also 
pertain to procedural shaders, another new addition to ElectricImage 2.8.

Map Lists

Maps are managed within map lists. Each material channel contains a map list where 
appropriate. Map lists are a jumping off point to map configuration and management.

Map Order

Map order is very important, as some effects may not be obvious if maps are out of order. 
Fortunately, reordering maps within a channel is easy — just drag the maps to whatever 
order you wish.

Map Alpha Channels

Alpha channels now take on a more specific meaning in ElectricImage 2.8, both to make 
the process of using texture maps easier, and to conform to industry standards. There are 
essentially three ways to use an alpha channel within a texture map:

• Ignored
• As Value
• As Mask

(see “Alpha Channel Configuration” on page 193 for more information.)

They Way it All Works

Maps add into the list from the top. Think of the list being stacked on top of the group. 
The map at the top of the list is the uppermost one, while the map at the bottom is inner-
most, nearest the actual surface of the group. The maps can be reordered by dragging 
them up or down in the list. 
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The circle next to each map is a checkbox that can be used to enable or disable the map. 
This feature is very useful while developing new materials. The empty space next to the 
circle is the map lock toggle. This can be set to prevent this map from being over-written 
by a Master Material assigned to the group.

Texture maps can be copied and pasted from one map list to another. To copy the map, 
highlight the map, select Copy Texture from the Edit menu. To paste the map, select the 
list you want paste it into by clicking somewhere in the list box. The list box will show that 
it has been selected with a thick black outline (as shown below). Use the Paste Texture 
command from the Edit menu to complete the operation.

Figure 105 — Diffuse map list box

To configure the texture map, double-click on the name of the map in the list box. The Tex-
ture Info Window will open. This window displays the group to be textured and the map 
projection (on the right) and has a series of tabs and buttons for controlling texture scaling, 
tiling, etc. (on the left).
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Figure 106 — Texture Info Window

Map Alignment Buttons

There are four map alignment buttons at the upper left of the window assist in map place-
ment, in addition to the projection map methods from earlier versions of ElectricImage. 
These buttons are:

• Move
• Select Polygons
• Fit to Selected
• Align Map Plane (to Polygon) 

Move

This (default) button allows you to move the map projection around in the window for 
proper placement on your model. Drag left or right at the edges of the projection to scale 
the map. Hold down the control key and drag to rotate the map.

Select Polygons

This button is used to select polygons by clicking on individuals or drag a rectangle for 
multiples. Shift click to add or remove polygons within the selection.
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Fit to Selected

This button sets texture projection to the extent of the polygons selected with the Polygon 
Selection Button. 

Align Map Plane (to Polygon)

This button sets map plane any polygon, regardless of the polygons you may have 
already selected with the Select Polygons tool. Unlike the Fit to Selected tool, the size and 
aspect ratio of the map is maintained with this tool. Align Map Plane is a very powerful 
feature for aligning the map projection icon to tricky curved surfaces. This feature is also 
available while in Move mode by Command-clicking on a polygon.

Map Alignment Tab

The alignment tab contains the position and rotation information for the texture map. The 
map alignment tab is divided into three sections:

• Alignment Radio Buttons
• Position Information
• Rotation Information

Figure 107 — Map Alignment Tab
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The Alignment Radio Buttons 

These buttons provide a straightforward way of aligning the texture map:
• User
• Middle
• Front
• Back
• Top
• Bottom
• Left
• Right
• Polygons 

These projections will align and scale the map along the axis noted by the radio button. 
They are used to set the initial map alignment. You can use the map alignment buttons to 
more precisely locate the map to the group.

Position Information

The position information section contains X,Y, and Z readouts for map position, as well as 
a popup menu to control the motion path interpolation method for the map position chan-
nel. You can change the map position by dragging, or by typing values into the edit boxes. 
(For information about the use of Implicit and Explicit keyframe control, see the Function 

Curve Editor chapter.)

Rotation Information

The rotation information section contains X,Y, and Z readouts for map rotation, as well as 
a popup menu to control the motion path interpolation method for the map rotation chan-
nel. You can change the map rotation by rotation tools and keyboard shortcuts, or by typ-
ing values into the edit boxes. (For information about the use of Implicit and Explicit 

keyframe control, see the Function Curve Editor chapter.)
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World Coordinates Checkbox

When this checkbox enabled, the map will reside in world space instead of local space. 
Effectively, the map becomes fixed in space at the coordinates specified (you can always 
animate its position, of course), and the group would then be perceived as moving through 
it’s map if the group were moved. (See the ElectricImage version 2.8 Starter PDF file 

included on the installation CD for more information on World Space and Local Space.) 

Map Projection Tab
The projection tab is used to determine the type of mapping primitive that the map will 
project, as well as the tiling method and map scale. There are four types of map tiling:

• None
• Hold
• Repeat
• Mirror

None

Disables mirroring of the map on the specified map axis. Choosing None for both axes 
will cause the map to be displayed only where you positioned it, nowhere else. You can 
choose this option along with another to constrain a map to hold, mirror, or repeat along a 
single axis.

Hold

Applies the colors found at the map edges outside of the map area. The map will appear 
once as positioned, with the border colors of the map extending beyond the map rectan-
gle, covering the object.

Repeat

Repeats the map along the specified axis. Choosing Repeat for both axes will cause the 
map to repeat continuously, depending upon the scale of the map relative to the group.
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Mirror

Mirrors the map along the specified axis. Choosing Mirror for both axes will cause the 
map to flip flop about both axes.

Figure 108 — Map Projection Tab

Map Type Popup Menu

Map projections use simple primitives to process and align the texture map for rendering. 
There are four types of map projections:
• Flat
• Cylindrical
• Spherical
• Cubic

Pick the projection which most closely matches the shape of the group. (For more informa-

tion on Map Projections, see the ElectricImage Series 2 Reference Manual pp. 14-10 to 14-

13.)

Map Scale Edit Boxes

The map scale edit boxes can be used to fine tune the scale and fit of the map on the group. 
There are separate values for X, Y, and Z axes.
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Image Map Tab

The image map tab contains thumbnails of the RGB and Alpha channels of an image map, 
some statistics about the map, the map cropping rectangle, a Replace Map button, and 
movie playback information for multi-frame map files.

Figure 109 — Image Map Tab

RGB and Alpha Thumbnails

The RGB and Alpha thumbnails give you a quick visual reminder of the contents of the 
map channels. If you click on the thumbnail, a larger image will appear in the view win-
dow to the right of the tab. If you double click on the image in the view window, the 
actual image will be displayed in a separate image display window. (See the ElectricImage 

2.75 Addendum, chapter 10, for information on Image Display.)

Replace Image Button

Allows you to replace the current texture file without losing the placement, scaling, and 
other settings.

Cropping Edit Boxes

These coordinate boxes allow you to crop the texture map to any size or portion of the 
map you wish to use. You can crop interactively by first clicking on the RGB or Alpha win-
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dows, to bring up the image in the texture window, and then drag the crawling ants bor-
der.

Map Playback Controls

These controls will appear whenever you have selected a mutli-frame map as a texture. 
You can adjust the end behavior, at what frame the movie will start, how many frames to 
play back, and the playback rate.

Figure 110 — Map Playback Controls

End Condition Popup Menu

This controls how the movie will behave when the end of the file is reached. There are 
three choices:

• Repeat
• Oscillate
• Hold

Repeat

Repeats the movie when the end of the file is reached.

Oscillate

Cycles back and forth through the movie when the end of the file is reached.
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Hold

Holds the movie at the last frame when the end of the file is reached.

Start Frame

The first frame of the animated texture to be used. The first frame of the animated texture 
is considered frame 1 not frame 0. Choosing a value other than one will cause the ani-
mated texture to begin at that frame. Combined with the Frame Range edit box, you can 
choose to render just a section of the animated texture map.

Frame Range

This value sets the number of frames to use for the animated texture map. When com-
bined with the Start Frame value, this feature can be used to render just a section of the 
animated texture map. The default value is 0, which causes all frames in the animated tex-
ture map to be used.

Frame Rate

Controls the number of animated texture frames to increment for every frame of the out-
put animation. The default is 1.0. Smaller numbers will speed up the apparent playback of 
the texture when viewed at speed. Larger numbers will make the texture appear to be 
slower. Extremely large numbers will make the texture appear to be “step framed.” You 
can fine tune the playback by using real numbers (numbers with decimals.)

Map Filter Tab

The map filter tab contains the image filtering and map strength controls for the texture 
map. This tab also is used to select how the different RGB and Alpha channels will be pro-
cessed. The filter tab is divided into several sections:
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• Map Filter Check Boxes
• Map Quality Edit Boxes
• Map Strength Slider
• Use Channel Popup
• RGB Channel Configuration
• Alpha Channel Configuration

Figure 111 — Map Filter Tab

Map Filter Check Boxes

These check boxes enable map filtering, and the Negative Z function. There are a total of 
three check boxes:

• Interpolate
• Anti-Alias
• Negative Z
• Calculate Once (automatic reflections only)

Interpolate

Interpolation filters the map as it is applied to the model. It cuts down on aliasing, but can 
also soften the image (especially as the map grows larger than 1.0 in scale.) Disabling this 
feature will sharpen the map, but doing so is not recommended.
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Anti-Alias

Texture anti-aliasing is another form of map filtering. With this option enabled, the map is 
effectively anti-aliased twice, first, during the stage in which the map is applied, then, as 
the entire image is anti-aliased. This can cause a loss of high frequency detail in the map, 
which some consider objectionable. Disabling this feature will cause some aliasing, but 
the overall image anti-aliasing might hide the artifacts. Use at your discretion.\

Negative Z

Causes the texture map to be projected along both the positive and negative Z axis. The 
map will be projected along only the positive Z axis if this checkbox is off. As an example, 
imagine a flat map placed on a nearly flat disk. If the Negative Z checkbox is on, the map 
will appear on both sides of the disk. If the checkbox is off it will appear only on the front 
side.

Calculate Once (automatic reflections only)

Causes a mirror or environmental reflection map to be rendered only once in the anima-
tion. This feature can save much rendering time, although it must be used wisely, as the 
reflection will not update after the first frame.

Map Quality Edit Boxes

These edit boxes offer even more control over the quality of the texture. There are two val-
ues to do so:

• Blur
• Samples

Blur

Allows you to degrade the map sharpness. This tool is useful for blurring a bump map 
that is too sharp and not giving you a clean bump, or taking the edge off of a reflection 
that might appear too busy otherwise.
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Samples

Controls the quality of the map. For the most part, 5 samples will yield acceptable results. 
If you wish to improve the quality of your maps even more, just increase this value. 
Higher values will increase rendering time, however.

Map Strength Slider

This slider controls the amount of affect the current texture has on the group. Use this 
slider when you have multiple texture maps on one group to mix together several maps. 
This value can be animated to cause maps to fade in/out over time.

Use Channel Popup Menu

This popup is used to specify what image map channels you wish to use and for what 
purpose. You can choose RGB, Alpha or both and then specify if you want it used as color 
or as value and if you want to invert it. There are three choices:

• RGB Only
• Alpha Only
• RGB + Alpha

RGB Only

Uses the RGB channel only for the map. The options field changes when this item is 
selected, offering you the ability to use the map as a color map, or as a value map (in 
which case the map will be automatically converted to gray scale.) There is also a button 
to the invert the map.

Alpha Only

Uses the alpha (mask) channel only for the map. The options field changes to the invert 
map button, allowing you to reverse the alpha channel.
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RGB + Alpha

Uses both the RGB and Alpha channels. When this option is selected, the options field dis-
plays configuration sections for both the RGB and alpha channels, which allow you to 
modify the behavior of these two channels. These configuration sections are described in 
detail below.

RGB Channel Configuration

There are three items in the RGB channel configuration section:

• As Color
• As Value
• Invert

As Color

This option sets the RGB channel to be used as color only. The color of the map will be 
passed through to whatever shading channel the map is applied to (note that some chan-
nels, such as Bump/Displace and Clipping, do not use RGB colors.)

As Value

This option uses the RGB colors as values (think of it as an automatic gray scale map con-
version.) Effectively, the RGB channel can be used to drive value-based effects, such as 
bump and displacement maps, clip maps, transparency value maps, and so on.

Invert

This option negates the colors of the RGB channel. The map can still be used either As 
Color or As Value. This option often prevents a quick trip to Photoshop!
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Alpha Channel Configuration

There are three items in the Alpha channel configuration section:

• Ignore
• As Mask
• Invert

Ignore

Ignores the alpha channel altogether.

As Mask

This option enables the alpha channel to be used as a mask. 

Invert

This option negates the colors of the alpha channel.

Special Tab

Depending upon the type of map, this tab may be empty or may contain controls for 
bump/displacement maps, as well as controls and buttons to show or save procedural 
shaders.
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Procedural Shaders

Introduction

Procedural shaders are little “C” language programs which Camera can use to shaded 
pixels with a variety of effects.  Well written shaders are typically very fast and efficient.

Shaders can be added to any material channel you choose (diffuse, specular, etc.) they will 
affect this channel and may optionally affect several others as well (shaders do not per-
form displacements at this time.) Most often, you will add the shader to the diffuse chan-
nel.  Shaders are located in the EI Shaders folder, in the same directory that ElectricImage 
is installed.

The shaders have animatable parameters. The numeric entry boxes and the colors can be 
animated to create some very striking effects. (As an example, add the Cammo shader to a 
teapot and animate the Density value over time). Note — Changes you make in these 

interfaces are made at the current project time. To prevent unwanted texture animation, 

disable the Texture Map item for the group in the Project Window.

A shader is added to a material channel using the add button in the Material Info Win-
dow. Once added, you can double-click on the shader to bring up its Texture Info Win-
dow. Under the Special Tab you will find two new buttons: Procedural... and Save 
Procedural as...  The Procedural button brings up the interfaces shown in the rest of this 
chapter. The Save Procedural As button saves a copy of the procedural with the current 
settings as default. This means you can create a shader with unique set of parameters that 
you like and save it out with those parameters imbeded in it. 

Some procedural shaders are designed to work as 2D projections, others as 3D projections.  
Those that work in 2D will appear to stretch along the depth of the projection.  Also, some 
shaders are not anti-aliased within the shader.  You can increase the group sampling to 2x2 
to compensate.
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Working with Procedural Shaders

All of the interfaces presented for each shader are simple dialog boxes, listing paramters 
and values, plus a shader preview area.  The preview area fits within the face of the cubic 
projection that ElectricImage supplies for procedural shaders.  Whatever you  see in your 
preview, will be what you see in the area occupied by the face of the cube, with one caveat: 
the cubic projection must be equalateral, that is, the scales of the X, Y, and Z axes must be 
the same.  If not, the procedural will appear distorted by the amount of the scale values.  
The position of the shader is also influenced by the position of the cubic projection icon. 
You can use this to fine tune procedural placement if necessary.

Figure 112 — Relationship of Preview Area to Cubic Projection Icon

You can also adjust the “lighting” in the shader preview area by clicking the location in 
the preview area that you would like to see the light shine on the preview (it defaults to 
the top right of the preview area.) This can help you to get a better feel for the look of the 
shader before you render.  Some shaders can generate holes in surfaces. The preview area 
will show a non-rendering checkerboard in that case.

You can set color values to alpha 0.0 to use the diffuse color of the group for that compo-
nent, instead of the color swatch.  Some shaders, such as Random Dots, do this automati-
cally.
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Bricks

This 2D shader creates a brick pattern on any group it is added to.

Figure 113 — Bricks Shader Interface

Apply only to the Diffuse Channel. Will affect the Diffuse, Bump, and Specular Channels.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Brick width
The width of each brick. A value of 1.0 will yield bricks as wide as preview window.

Brick Height 
The height of each brick. A value of 1.0 will yield bricks as high as preview window.

Mortar Thickness 
The width and height of the mortar that separates the brick.
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Mortar Depth
The mortar is an inset procedural bump. This controls how deep it is.

Row Vary
Controls brick alignment. If set to 0.0, the alignment between alternate rows of bricks will 
be perfect.

Jagged
Larger numbers than the default will cause extreme variation of the height and length of 
the bricks in a wave like fashion.

Brick Pit Frequency
The bricks themselves have a rough surface due to a procedural bump. This value controls 
the number of pits on each brick surface. Useful values are between .001 and .009.

Brick Pit Depth
Controls the depth of the pits on the surface of the bricks. Useful values are between .01 
and .0001.

Mortar Pit Frequency
The mortar also has a rough surface due to a procedural bump. Useful values are between 
.0001 and .0009.

Mortar Pit Depth
Controls the depth of the pits in the mortar. Useful values are between .0001 and .0009.

Brick Vary 
This controls the color variation of the bricks. Useful values are between 0 and 1.

Brick Color
The RGB color of the bricks.
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Mortar Color
The RGB color of the mortar.

Ks 
The Specular value for the Bricks and Mortar. 0 is no specular, 1 is maximum specular

Bump Array
This 3D shader creates an array of dimples. Could be used for the surface of a golf ball or 
for metal floor plating. It is also useful for creating a pattern of round holes in an object, 
like the lid of the original Star Trek communicator. Apply the shader to the Transparency 
Channel with a Density of 10.0 and the Bump Color set to black.

Figure 114 — Bump Array Shader

Will affect the channel in which it is applied and the Bump/Diffuse Channel.

Density 
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Hex Grid
Realigns the bumps in a hexagonal pattern. It defaults to on.
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Procedural Shaders — Bumpy Noise
Radius
Controls the radius of the bumps. 

Spacing 
Controls the distance between each bump. This number can be set small to cause the 
bumps to overlap.

Bump Blend
Distance over which the bumps blend together. Smoothes over transitions when the 
bumps overlap.

Bump Strength 
Controls the magnitude of the bump, how deep or high it is. Can be positive or negative.

Bump Color
The RGB color of the bumped area.

Surface Color
Sets the RGB value of the surface. You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.

Bumpy Noise

This 3D shader creates a bumpy, noisy pattern. Could be used for alien flesh.
Will affect the Base and Bump Channels.
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Procedural Shaders — Bumpy Noise
Figure 115 — Bump Noise Shader

Density 
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Bump Strength
Controls the magnitude of the bumps on the surface. Useful range is
 -5.0 to 5.0

Color Threshold
Changes where the color blend begins between Bump Color and Surface Color. 0.5 is right 
in the middle of the bump, 1.0 is right at the top of bump.

Color Range
Controls the variation in color between the lowest and highest points on the surface. Use-
ful range is between 0 and 10.

Bump Color
 The RGB color of the bumped area.

Surface Color
 Sets the RGB value of the surface. You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.
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Procedural Shaders — Cammo
Cammo
This is a camouflage 3D shader and is loosely patterned after the standard US “Wood-
land” pattern.

Figure 116 — Cammo Shader

Will affect only the  channel in which it is applied.

Density 
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Surface Color
Sets the RGB value of the underlying surface. The three Cammo regions are applied on to 
of this surface. You can set the alpha to 0.0 to let the object’s diffuse color, or the next tex-
ture map in the diffuse list, come through instead. There are three different regions added 
on top of the surface color. They each have the following controls.

Scale
Controls the size of the pieces that make up the region.

Level
Controls how much of the Surface color shows through the region. 0.0 allows all of the 
surface color to show through. 1.0 allows none at all.
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Procedural Shaders — Cell Look
Color
RGB color of the region.

Cell Look

This shader is neither a 2D or 3D shader, but rather an illumination shader which gives a 
cartoon-like appearance to the groups it is applied to. The defaults have been picked to 
work well. You may wish to try it, as is,  before changing any of the values in the interface. 
The shader will automatically pick up the diffuse color of the object. Therefore, you don’t 
have to change the color values in the shader for each object you use it with.

Figure 117 — Cartoon Cel Shader

Apply to the Diffuse Channel, will affect Diffuse and Specular.

Highlight
If this option is on, the highlight (specular) is operated on by the shader.
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Procedural Shaders — Cell Look
Specular Range Min/Max
Specular is always in the range of 0 to 1. 0 is no specular, 1 is 100% specular. As the object 
is shaded, pixels with a specular value below the Min get no specular highlight at all. Pix-
els greater than the Max get the color in the specular channel of the group after being pro-
cessed by the Brightness and Saturation values.  Between the Min and Max, the color is 
ramped.

Brightness
Varies the brightness of the computed highlight.

Saturation
Varies the saturation of the computed highlight.

Color
When on, the color chosen using the swatch is used instead of the group’s specular color.

Zones
Sets the number of different colors that will be used to shade the group. 

Diffuse Range Min/Max
If the brightness of the pixel being shaded falls into this range, the objects diffuse color is 
multiplied by the Brightness value and applied. If the brightness falls in between ranges 
(as in the case of 0.42, using the numbers in the illustration), the color is ramped.

Brightness 
The factor by which the diffuse color is multiplied to yield the final pixel color.

Color
If the brightness of the pixel being shaded falls into Min/Max range for this Zone, the 
object’s diffuse color is replaced by this color.

Account for Light Colors 
If this option is on, the highlight and the diffuse colors of the shader are effected by scene 
lighting, otherwise the colors of the group will match the swatches in the shader.
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Procedural Shaders — Checker Board
Checker Board

This shader can be either 2D or 3D, and places a checkerboard pattern on the surface of 
the group. Will affect only the channel in which it is applied.

Figure 118 — Checker Board Shader

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Color1&2
RGB color of the alternating squares.

3D Checker
Makes the procedural act as a solid shader. The checkerboard pattern will repeat through-
out the group.
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Procedural Shaders — Clouds
Clouds

This 3D shader creates a cloud-like fractal pattern.  Will affect only the channel it is 
applied to.

Figure 119 — Clouds Shader

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Cloud Threshold
Controls how many cloud puffs are present. Useful range is 2.0 to 0.0.

Cloud Range 
Controls the density of the clouds. Useful range is 10.0 to 0.0

Cloud Color
RGB color of the clouds.

Sky Color
RGB color of the area not covered by clouds.
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Procedural Shaders — Color Noise
Color Noise

This 3D shader creates a psychedelic color pattern, similar to tye-dye.

Figure 120 — Color Noise Shader

Will affect only the channel that it is applied to.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.
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Procedural Shaders — Crumple
Crumple

This 3D shader creates a bumpy pattern on an object very similar to crumpled aluminum 
foil. This shader is not anti-aliased, so use additional group sampling as needed.

Figure 121 — Crumple Shader

Will affect the channel in which it is applied and Bump channels.

Noise Level
Controls how many iterations of noise are computed for the shader. Each successive itera-
tion is half the size of the previous one. More Levels require more rendering time.

Noise Scale
Sets the height at which the High Color is drawn. 

Noise Factor
Each successive level of noise gets smaller by this amount.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.
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Procedural Shaders — Crumple
Bump Scale 
Sets the magnitude of the bump. Can be negated to invert the crumple effect.

Bump Factor
At each successive level of noise is computed the bumps get smaller by this amount.

Animation
Animates the noise pattern over time. A value of 1.0 moves the noise 1 unit of the preview 
square per second. This can be used to create animated water effects. Try doing this by 
animating the Z value for the shader applied to a flat plane.

High Color
Sets the RGB value of the surface at the top of the bumps. You can set the alpha to 0.0 to let 
the object’s diffuse color, or the next texture map in the diffuse list, come through instead.

Low Color
Sets the RGB value of the surface at the bottom of the bumps. You can set the alpha to 0.0 
to let the object’s diffuse color, or the next texture map in the diffuse list, come through 
instead.
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Procedural Shaders — Crust
Crust

This 3D shader creates a series of high, flat ledges.

Figure 122 — Crust Shader

Will affect the channel in which it is applied and Bump channels.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Coverage 
Controls the region that the Crust Color covers. 0.0 yields no Crust Color. 1.0 will cause 
the Crust Color to cover the entire procedural.

Ledge Level
Controls how far the ledges spread out across the surface of the crust.

Ledge Width
Sets the widths of the ledges.

Bump Strength
Sets the magnitude of the bump for the ledges. Values can be either positive or negative.
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Procedural Shaders — Cyclone
Crust Color
Sets the RGB value of the ledges.

Surface Color
Sets the RGB value of the surface. You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.

Cyclone

This 3D shader creates a vortex pattern. The effect is quite startling when applied to the 
Transparency Channel.

Figure 123 — Cyclone Shader

Will only affect the channel in which it is applied.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.
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Procedural Shaders — Cyclone
Cyclone Radius
The radius of the main body of the swirling vortex. This value manages the apparent 
“strength” of the vortex.  The default value of is 1.0, giving a decent looking vortex.  
Smaller numbers will impart less energy to the vortex, effectively weakening it.  A value 
of 0.0 will look like smoke, rather than a cyclone.  Likewise, values of over 5.0 will have a 
similar effect.

Eye Radius 
The radius of the eye at the center of the vortex. 0.5 corresponds to the width of the pre-
view window.

Twist 
Sets the number of revolutions the vortex makes within the width of the preview window

Scale
Sets the magnitude of the amount of clouds created in the vortex. Small changes in this 
value can vary the look of the effect significantly.

Offset
Can be used to make the overall effect more misty.

Omega
Increases the choppyness of the clouds. Useful range is between 0.0 to 1.0, with 1.0 being 
more choppy than 0.0.

Octaves
Controls the complexity of the noise function. Useful range is 1 to 8

Contrast
Lower numbers decrease the contrast between Color1 and Color2.

S Noise 
A noise seed. Can be used to vary the look of the cyclone. 
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Procedural Shaders — Dots
D Noise
A noise seed. Can be used to vary the look of the cyclone.

Color1
Sets the RGB value of the region not part of the swirling vortex.

Color2
Sets the RGB value of the cluds in the vortex.

Dots

This 3D shader makes a grid of dots on the surface of the object.

Figure 124 — Dots Shader

Will only affect the channel in which it is applied.

Density 
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
adding more dots, smaller to zooming in, removing dots.  The default is 1.0.

Dot Diameter
Diameter of the dots. A diameter of 1.0 fills the preview window at a denisty of 1.0. 
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Procedural Shaders — Eroded
Fuzzy Edge Width
Sets a region around the dot to blur slightly. Makes a nicer transition from the surface to 
the dots.

Dot Color
The RGB color of the dots.

Surface Color
Sets the RGB value of the surface. You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.

Eroded

This 3D shader puts dents and holes in the surface of an object. (The shader uses a black 
and white checker pattern in the preview area to denote actual holes that will be visible 
through the material — the pattern does not render.)

Figure 125 — Eroded Shader

Will affect the channel in which it is applied and Bump channels.
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Procedural Shaders — Eroded
Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Bump Strength
The magnitude of the bump applied to the dented portions of the surface. Can be a nega-
tive number.

Erode Holes
When on, holes are actually cut through the surface. When off, areas that represent holes 
are shaded with the Hole Color.

Hole Min
The surface of the object is represented by a value of 0 to 1. Where 0 is the bottom of the 
deepest hole. Hole min sets the range over which holes occur on the object. In the default 
case, holes appear between 0.3 and 0.4

Hole Max
The surface of the object is represented by a value of 0 to 1. Where 1 is the top of the sur-
face. Hole max sets the range over which holes occur on the object. In the default case, 
holes won’t appear between 0.4 and 1.0. Between 0.3 and 0.4 there is a ramp wherein the 
surface transitions nicely into the hole.

Hole Color
RGB value of the color applied to the holes when the Erode Holes flag is off.

Surface Color
Sets the RGB value of the surface. You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.
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Procedural Shaders — Flame
Flame

This 3D shader creates a fire-like color pattern. You may want to re-align the cubic projec-
tion icon to bottom or top, as the preview shader is presenting the flames to you in that 
orientation. (This shader does not aminate the flame effect.)

Figure 126 — Flame Shader

Will only affect the channel in which it is applied.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Distortion
Scales the combination of all noise functions. Larger numbers will yield many smaller 
regions of flame. Useful values are in the range of 0 to 1.

Chaos Scale
Scales the color temperature of the shader. Larger numbers are hotter.
216       ElectricImage 2.8 Supplement    



Procedural Shaders — Flame
Chaos Offset
Increases the color temperature of the shader (default is 0.0.) Larger numbers are hotter.  
Numbers over 1.5 tend to “burn out” the shader and are not very useful.

Flame Height
If set to 0.0 (the default), this shader behaves as a 2D shader. If a height is provided, the 
colors will vary as the height of the object changes. Apply to the top of a cube and enter in 
a height value. When you render the side of the cube, you will see the colors creeping up.

Flame Amplitude
Scales the flame temperature based on the height.

Lacunarity
Sets the gaps (dark areas) between the regions of flame in the preview window. By setting 
the colors of the coolest regions to Alpha 0.0 in the color picker, you can see the group’s 
diffuse color through the gaps.

S Noise Scale
Acts as a noise seed to vary the look of the flame.

D Noise Scale
Acts as a noise seed to vary the look of the flame.

Octaves
Sets the fractal complexity of the shader. Useful values range between 1 and 7.

Colors
Sets the number of colors, from the list of colors on the left, to use when creating the pro-
cedural effect.
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Procedural Shaders — Fractal Noise
Fractal Noise

This 3D shader creates a fractal-based noise pattern.

Figure 127 — Fractal Noise Shader

Will affect the channel in which it is applied and the Bump channels. 

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Noise Level
Controls the complexity of the noise. Useful range is 0 to 8

Noise Factor
Higher numbers produce a rougher surface, smaller number a smoother surface.

Bump Strength
 Sets the magnitude of the bump. Can be negated.

Bump Factor
With each successive noise level calculation, bumps get smaller by this factor.
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Procedural Shaders — Fractal Noise
Sharpen Bumps
Takes the highest point and makes it rougher, takes the lowest point and makes it softer. 
Good for making the bumps nice and craggy.

Color Factor
Sets the point where the shader switches from the High Color to the Low Color. Higher 
numbers will completely eliminate the Low Color.

Sharpness
Larger numbers increase the contrast between the High and Low Colors

High Color
Sets the RGB value of the surface at the top of the bumps. You can set the alpha to 0.0 to let 
the object’s diffuse color, or the next texture map in the diffuse list, come through instead.

Low Color
Sets the RGB value of the surface at the bottom of the bumps. You can set the alpha to 0.0 
to let the object’s diffuse color, or the next texture map in the diffuse list, come through 
instead.
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Procedural Shaders — Granite
Granite

This 3D shader creates a granite rock appearance.

Apply only to the Diffuse Channel. Will affect the Diffuse and Specular Channels.

Figure 128 — Granite Shader

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

ks1
The Specular value for the region colored by Color1. 1.0 is max, 0.0 is no specular

ks2
The Specular value for the region colored by Color2. 1.0 is max, 0.0 is no specular

Color1
The RGB value for the underlying color of the granite rock.

Color2
 The RGB value for the colored pieces that mix in with the granite rock.
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Procedural Shaders — Granite
Grid

This shader creates a 2D or 3D grid of lines.

Figure 129 — Grid Shader

Will only affect the channel to which it is applied.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out 
(seeing more of the grid), smaller to zooming in (seeing less of the grid). The default is 1.0.

3D Grid
Makes the shader work in 3D space. Apply to the top of a cube, then render the side of the 
cube. You will see the grid coming up the sides of the cube.

X,Y,Z
Offsets the grid pattern in the direction specified. Very useful when the 3D Grid checkbox 
is on as you might find the Z position of the grid leaves you right in the middle of a line.

Line Thickness
Sets the thickness of the grid lines. The default is .2  Smaller numbers produce thinner 
lines.
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Procedural Shaders — Hex Tile
Grid Color
Sets the RGB color of the lines.

Surface Color
Sets the RGB value of the underlying surface. You can set the alpha to 0.0 to let the object’s 
diffuse color, or the next texture map in the diffuse list, come through instead.

Hex Tile

This 2D shader creates a hexagonal pattern of terra cotta tiles. Perfect for your patio or 
mud room.

Figure 130 — Hex Tile Shader

Will only affect the channel in which it is applied.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.
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Procedural Shaders — Hex Tile
Tile Radius
Sets the size of the tiles. 1.0 represents one full tile in the preview window.

Mortar Width
Sets the width of the mortar between the tiles. Useful range is 0.0 to 0.3

Tile Vary
Allows subtle variations in the color of the tiles. Useful range is 0.0 to 1.0

Scuffing
Sets the darkness of the scuff marks on the surface of the tiles. Useful range is 0.0 to 5.0

Stains
Creates separate stained areas using the Scuff color. Useful range is 0.0 to 5.0

Stain Frequency
Controls the size of the stained areas. Larger numbers create smaller stains.

Scuff Frequency
Controls the size of the scuff marks. Larger numbers create smaller marks.

Tile Color
Sets the RGB value of the tiles

Mortar Color
Sets the RGB value of the mortar between the tiles.

Scuff Color
Sets the RGB value of the scuff marks on top of the tile.
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Procedural Shaders — Marble
Marble

This 3D shader creates a marble-line surface for rocks, pillars, temples, etc.

Figure 131 — Marble Shader

Will only affect the channel in which it is applied.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Frequencies
Controls the number of separate veins that appear in the marble. The default is 8 and you 
can see 8 distinct black veins running through the marble in the preview window.

Turbulence
Sets the waviness of the veins. Larger numbers yield more waviness.

Noise Factor
Affects the variation of the veins along their length. Useful values are in the range of 0.0 to 
1.0
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Procedural Shaders — Plank
Vein Spacing
Controls the distance from one vein to the next.

Vein Sharpness
Controls the sharpness and apparent width of the veins.

Colors
Controls how many of the colors on the left side of the interface are used to shade the mar-
ble. (Color number 1 defaults to alpha 0.0, allowing the diffuse color of the group to show 

through.)

Plank

This 3D shader creates a nice parquet-style wood pattern. Can be used to great effect on 
the floors of entry halls or on dance floors. Biases the specular highlight with the parquet 
pattern as well. Can also be used to simulate hardwood flooring.

Figure 132 — Plank Shader

Apply only to the Diffuse Channel. Will affect the Diffuse, Bump, and Specular channels.
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Procedural Shaders — Plank
Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Parquet Tile
Creates the parquet pattern of tiled wood. If off, long planks are created instead; perfect 
for hardwood floors.

Planks Per Tile
Number of individual wood slats that make up each tile.

Plank Length
Sets the length of the planks when the Parquet Tile flag is turned off.

Plank Width
Sets the width of the tiles when the Parquet Tile flag is on. If the flag is off, it sets the width 
of the individual planks.

Groove Width
Sets the width of the grooves that separate the tiles from one another and the grooves that 
separate the planks within the tiles from one another.

Ring Scale
Larger number create more, tighter grain patterns in the planks.

Grain Scale
Larger number cause the grain patters to be thicker.

Plank Vary
Cause color variation in the individual planks. Useful range of values is 0.0 to 2.0.

Grainy
Sets the amount of grain in each plank. Larger numbers give you smaller grain.
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Procedural Shaders — Random Dots
Wavy
Larger numbers make the grain more wavy.

Light Wood
Sets The RGB color of the lightly colored planks.

Dark Wood
Sets The RGB color of the darkly colored planks.

Groove Color
Sets The RGB color of the grooves between the planks and tiles.

ks
Sets the specular for each of the areas. 0.0 is no specular. 1.0 is maximum specular.

Random Dots

This 3D shader creates a pattern of randomly colored dots. Perfect for that summer dress.

Figure 133 — Random Dots
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Procedural Shaders — Rust
Will only affect the channelin which it is applied.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in. Defaults to 1.0.

Dot Types
This value controls which of the 10 different dots are supported will be used by the 
shader, from top to bottom of the list as presented in the window.

Dot Color
Sets the color of each dot

Dot Size
Sets the maximum size of each dot. There is random variation in the size from the maxi-
mum down. 

Rust

This 3D shader creates a rusted surface pattern. The surface appears thick with areas 
eroded down to holes.

Figure 134 — Rust Shader
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Procedural Shaders — Rust
Apply only to the Diffuse Channel. Will affect the Diffuse and Bump channels.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Paint Level
Controls how deep into the surface the paint reaches.

Paint Bump
Sets the magnitude of the bumps on the painted surface. 

Paint Color
Sets the RGB value of the surface. You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.

Rust Level
Sets the amount of the surface affected by the rust. 1.0 is all rusty, 0.0 is no rust at all.

Rust Bumps
Sets the magnitude of the bumps on the rusty surface.

Rust Color
Sets the RGB value of the rusted area.

Hole Level
Sets the amount of the surface that becomes holes. 1.0 is all hole, 0.0 is no holes.
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Procedural Shaders — Stucco
Stucco

This 3D shader creates a stucco pattern using bumps. Great for adding a slight variation to 
interior and exterior walls.

Figure 135 — Stucco Shader

Will affect the channel in which it is applied and Bump channels.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Sharpness
Controls the smoothness of the bumps. Smaller numbers are smoother, larger numbers 
sharper. Useful range is 0 to 10.0

Bump Strength
Sets the magnitude of the Bump. Can be positive or negative.

Color Factor
Controls the blend, and therefore the spread, of the Bump Color into the Surface Color. 
Larger numbers correspond to a larger spread.
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Procedural Shaders — Veins
Bump Color
Sets the RGB value of the bumps.

Surface Color
Sets the RGB value of the surface You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.

Veins

This 3D shader creates a series of polygonal shapes separated by grooves. Could be used 
for alien skin or even the surface of a cobblestone walkway.

Figure 136 — Veins

Will affect the Channel in which it is applied and Bump channels.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.
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Procedural Shaders — Veins
Coverage
Controls the region that the Vein colors covers. 0.0 yields no Vein Color. 1.0 will cause the 
Vein Color to cover the entire procedural.

Ledge Level
Controls the height that the shapes rise above the veins

Ledge Width
Controls the width of the shapes

Bump Strength
The magnitude of the bump. Can be negative to cause the veins to rise above the shapes.

Vein Color
Sets the RGB value of the veins.

Surface Color
Sets the RGB value of the surface You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.
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Procedural Shaders — Waves
Waves

This 2D shader creates a sinusoidal pattern. Can be used to simulate ripple effects as drop-
lets fall into water. This shader causes the waves to animate, flowing outward at a rate 
controlled by the Wave Frequency.

Figure 137 — Waves Shader

Will affect the channel in which it is applied and Bump channels.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Wave Source
Sets the number of sources that generate the waves. More sources give rise to complex 
interference patterns

Wave Range
Sets the distance between Wave Sources.

Wave Length
 Distance between the wave crests.
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Procedural Shaders — Wisp
Wave Frequency
Number of units the rings move outward per second.

Bump Strength
The magnitude of the bump. Can be negative invert the wave.

Wave color 
Sets the RGB value of the wave crests.

Surface Color
Sets the RGB value of the surface You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.

Wisp

This 3D shader creates a series of lightly drawn lines, as if a calligraphy pen had been 
used to draw on the surface.

Figure 138 — Wisp Shader

Will only affect the channel in which it is applied.
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Procedural Shaders — Wisp
Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Coverage
Sets the region that the Wisp Color covers. 0.0 yields no Wisp Color. 1.0 will cause the 
Wisp Color to cover the entire procedural.

Ledge Level
Larger numbers increase the number of lines that are drawn

Ledge Width
Smaller numbers increase the thickness of each line.

Wave Color
Sets the RGB value of the lines.

Surface Color
 Sets the RGB value of the surface You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.
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Wood

This 3D shader creates a basic wood-like appearance.

Figure 139 — Wood Shader

Will only affect the channelin which it is applied.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Frequencies
Controls the number of separate grains that appear in the wood.

Turbulence
Sets the waviness of the grain. Larger numbers yield more waviness.

Noise Factor
Affects the variation of the grain along their length. Useful values are in the range of 0.0 to 
1.0
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Vein Spacing
Controls the distance from one vein to the next.

Vein Min
Controls the minimum width of the veins.

Vein Max
Controls the maximum width of the veins.

Colors
Controls how many of the colors on the left side of the interface are used to shade the 
wood.
ElectricImage 2.8 Supplement        237



Procedural Shaders — Wood
238       ElectricImage 2.8 Supplement    



The Project Window — Introduction
The Project Window

Introduction

The Project Window has always been the heart of animation in ElectricImage. It is this sin-
gle window into your scene that offers the most control, to virtually every parameter. 
ElectricImage 2.8 includes a few “under the hood” improvements in the Project Window, 
as noted below:

• The Animation Box
• The Velocity Enable Check Box
• New object selection methods
• Object Parking

 

Figure 140 — Project Window
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The Animation Box

As an animator, you will find that while you may have hundreds of objects in a given 
scene, you may only be animating ten or twenty of them. Like a director on a movie set, 
you expect your props to stay put, while requiring your actors to move and express them-
selves. When animating with a computer, all of these objects have to be tracked, main-
tained, and otherwise dealt with in some fashion. Not all of them need to be animated, 
however.

Figure 141 — Typical Animation Box

That’s where the animation box comes in. A third column has been added to the left side 
of the project window, next to the Visibility check box and the Lock check box.   The Ani-
mation box is a little green arrow that enables animation for each group and each anima-
tion channel within that group. The animation box next to the group name acts as a master 
switch. If the master isn't on, the channels below won’t animate regardless of the settings 
of their animation boxes. A new preference under the Edit >Preferences Keyframe tab 

menu controls whether or not groups default with their master animation boxes on or off.
 

Figure 142 — Animation Preference

By activating animation channels only when necessary, you will conserve memory and 
improve interface performance within ElectricImage. You can specify on a channel by 
channel basis which attributes will animate, and which will not.
240       ElectricImage 2.8 Supplement    



The Project Window — Velocity Enable Box
The Velocity Enable Box

Figure 143 — Velocity Enable Check boxes

A velocity enable box has also been added next to each animation channel capable of a 
velocity calculation. You can disable the velocity calculation for any channel you choose 
by turning off this box.

Object Selection Methods

The 2.8 Project Window also adds greater ease of changing common characteristics of 
multiple objects by adding some new object selection methods. The following steps will 
explain the procedure for changing the Visibility, Lock, or Animation settings for multiple 
objects, and objects with children.

Selecting and changing attributes for Multiple objects:

• Select the objects in the Project Window.

Figure 144 — Multiple Objects Selected

• Click the desired box on one of the selected objects.

Figure 145 — Selected Objects with Animation Turned Off

The selection changes for only the selected objects.
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Selecting and Changing Objects with Children

• Use Option and Command ( ) keys and click on the parent object 
• Change the animation value
 

Figure 146 — Parent and Children Animation Records deactivated

The animation records for the parent group and its children have now been changed.

This technique also works if you have an object with hidden children. Just follow the pro-
cedures above. These features, in combination with selection sets, will make the manage-
ment of large projects substantially easier.

Object Parking

As mentioned in the Introduction chapter, object parking allows you to reset all of the 
transformation values of a group to zero (0.0). Often times models are imported in a vari-
ety of scales and from a variety of modeling programs in order to compose a complete 
scene. This can necessitate the use of scale operations to equalize the relative size of the 
models, and translation operations to fix the relative distances for the composition.  Expe-
rienced users will note that these preparations can make animation somewhat complex.

This is especially true when these objects with multiple scales and transforms are then 
made part of the same hierarchy. While transforms to align relative positions of groups are 
straightforward, scale operations (especially non-uniform scale operations) can cause 
problems from time to time, if classic transforms are selected in the group linkage win-
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dow. It would be far easier to position and scale groups relative to each other, and then 
“zero them out” making everything about then equal (from a transform point of view.) 
This is what object parking is all about.

Object parking can be used for all object types within ElectricImage: Cameras; Lights; 
model groups; and effectors such as bones. Remember to use parking before you begin to 

animate!

There are three locations for the parking icon:

• Tools Menu
• Windows>Tools Palette

• Project Window Tool Bar

Figure 147 — Parking Icon

To use object parking:

• Select the object(s) to park
• Click on the Park icon in the project window

The objects have now had their transforms reset to 0.0.
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Function Curve Editor

Introduction

One of the most exciting new features of ElectricImage 2.8 is the Function Curve Editor. 
The Function Curve Editor is a powerful feature which lets you graphically create, edit 
and apply animation information to virtually any parameter in a scene. Function curve 
editors have formed the basis of some of the most powerful character animation software 
anywhere.

What is a Function Curve Editor?

The Function Curve Editor is a new window which allows animators to graphically con-
trol animation data in the form of a curve which represents changes in time and data val-
ues. The editing methods in the Function Curve Editor provide far more control over how 
the values change, not just when the values change as with the older velocity graphs in 
previous versions of ElectricImage. All animation channels can be edited with a function 
curve, with the exception of color.

The Benefits of Using the Curve Editor

The art of animation involves many subtleties. Good animators know that to add those 
subtleties can be an exercise in tedium. The function curve editor is intended to make that 
task easier. By being able to edit the curve as it enters and exits a keyframe, the animator 
has more control over each keyframe, leading to more control to the overall animation and 
the realism of the shot. At the very least, using the Function Curve Editor will assist the 
animator in creating complex motion using fewer keyframes, saving time in the process.
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Implicit and Explicit Translation

As you may have already noticed, all vectorized quantities in ElectricImage (position, ref-
erence, center, etc.) now have an extra pulldown menu in their info windows. This pull-
down controls whether the quantity is Implicitly or Explicitly translated. Implicit 
translation is what you have been using in past versions of ElectricImage. Explicit transla-
tion allows separate control for each of the three translation components (X,Y,Z).

Implicit Translation Example

Figure 148 — Top View and Velocity Curve Example

The figure above shows us the top view of a basic motion path, as you were used to seeing 
in prior versions of ElectricImage. Next to it is the graph of the camera motion velocity.

The Camera's motion path is really a composite of the Z and X channels of the Camera 
motion path transform. When you drag the Camera in the top view, the Z and X values 
change but Y does not. Velocity is computed on the composite vector (the vectors of X and 
Y). There is no curve available to individually adjust any of the three components by itself.
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Explicit Translation Example

By making the Camera's transformation Explicit, velocity calculations are removed and 
you are free to independently manipulate the three component vectors of the motion 
(X,Y,Z).

To make an group’s Translation explicit:

• Open the Group Info window for a given object. Make sure that the X-Form window 
is in the foreground.

Figure 149 — Group Info Window

• Change the translation of the particular Transformation characteristic from Implicit to 
Explicit. The illustration below shows the Position translation being changed.

Figure 150 — Key Menu

The translation value for the object’s position is now explicit. 
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One of the first things you will notice is the change in the way the motion path for the 

object is now drawn in the world view windows. The path is no longer the familiar bezier 

spline, but rather a curve with no real controls. You can create new keyframes as before, 

by changing the time and dragging the group to a new position, but you cannot edit the 

shape of the curve in the world view windows. 

Accessing the Curve Editor

There are two ways to open the Function Curve Editor:

• Choose Windows>Function Curve Editor
• Type   -` (Command - `).

The Function Curve Editor opens.

The Function Curve Editor Window

The Function Curve Editor is divided into three sections:

• Graph Window
• Channel List
• Tool Bar

Graph Window

The graph window contains the function curves that graph the actual channel data, the 
timeline, and the data scale. The timeline is displayed at the top of the window area. It is 
the same timeline in the project window, and functions indentically. The data scale dis-
plays data values which change depending upon the window magnification. The combi-
nation of the time scale and data scale is used to plot the channel curves.
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Figure 151 — Function Curve Editor (with channel data)

Channel List

To the left of the graph window is the channel list. The channel list is where all of the 
loaded channels are displayed. Each channel is represented by individual curves. The 
channel list is covered in detail on

Tool Bar

Above the channel list and the graph window is the tool bar. The tool bar contains icons 
which are used to control the display of the function curve editor, the display of elements 
within the editor, and the loading and saving of channel envelopes. The Tool bar is cov-
ered in detail on page 254.

Initially, there won't be any channels loaded into the Editor. Channels are loaded by two 
methods:

• From the project window, by double-clicking on the animation channel names in the 
particular object that you want to work with.

• Using the Key Channel Loader described in the Toolbar section of this document.
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You can load in as many channels as you like from as many different groups as you like. 
Virtually any animatable channel, except RGB color, can be loaded into the editor.

The Graph Window

The graph window is used as an interactive display to modify the effects between two or 
more keyframes. Through the use of the graph window, keyframes may be added and 
deleted, as well as modified. Acceleration/Decceleration and Velocity are optionally plot-
ted as well, depending upon toggles set in the tool bar. See “The Toolbar” on page 254 for 

more information.

Figure 152 — Graph Window

The active channel curve is drawn in white. All other curves are drawn in the color next to 
the channel name. (See “To set the curve color:” on page 254.)

Time and data ranges can be selected by dragging in the areas to the right and bottom of 
the graph window. These ranges are indicated by darker gray regions in the graph win-
dow background. The display of these regions can be toggled by clicking on the time and 
data range icons in the tool bar. See “Time Range” on page 260 and “Data Range” on 

page 260.
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There are a variety of commands and shortcuts available in the Graph Window.

The Tab Key

Can be used to restrict the axial movement of the keyframes. Tab once to restrict in X, tab 
again to restrict to Y, tab again to restrict diagonally, tab again to restore free movement. 

Option Clicking

Option-clicking (or option-clicking and dragging) will add a new key to the point on the 
curve on which you clicked.

Figure 153 — Option Click adds new keyframe

Command Clicking

Command clicking on a key will break or mend the control handles.

Figure 154 — Command Click adjusts slope of handles

Shift Clicking

Shift clicking or marquee selecting a group of keys will allow the keys to be dragged 
together.
ElectricImage 2.8 Supplement        251



Function Curve Editor — Reference
Figure 155 — Shift Click selects multiple keys

Control-Drag

Holding down the control key as you drag a key will interactively scale the curve 
(requires that a time range be selected first).

Keypath Drag

Drag the curve between to keys to drag both keys. This allows you to drag a section of the 
curve.

Dragging the Window

Hold the space bar down to drag the entire Graph Window.

Toggle Linear

Command-Control clicking on a key will toggle the linear buttons in the Key Channel 
Dialog box for that key.

Cut and Paste

Cutting and pasting sections of the curve requires that a time range be selected first.
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Channel List

The channel list contains all of the loaded channels in the function curve editor. Each 
curve in the graph window corresponds to one item in the channel list. All channels 
added to the list are added to the bottom. The list cannot be reordered. The black circle to 
the left of each channel name controls the display of the curve for that channel. Clicking 
on the curve will change the visibility of the curve (the circle will turn transparent when 
the curve is not drawn.)

Figure 156 — Channel List

The channel list display area can be resized by dragging the right edge next to the scroll 
bar left or right (the cursor will change as indicated below.)

Figure 157 — Resize Window Pane Icon

Each channel in the list has a separate color to plot its curve in the graph window. The 
color swatch next to the name of the channel is used to set the curve color.
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To set the curve color:

• Click on the color swatch for the desired channel.
• Choose a new color from the color picker.
• Click the OK button to accept the new color.

The new curve color will now be set.
The selected channel will always draw its curve, regardless of the channel’s visibility set-
ting in the channel list.

Double clicking the channel name in the list will bring the Key Channel Window for that 
item forward. See the “Key Channel Window” on page 260 for more information. 

The loading and saving of channel envelope information is controlled by icons in the tool 
bar. For more information on tool bar functions, see “The Toolbar” on page 254.

The Toolbar

To effectively edit motion and time data, some special tools are required. The Function 
Curve Editor comes with its own set of tools which are used to edit data splines, load 
motion data, and various other tools to manipulate the motion data. The following sec-
tions will detail the function of each Tool icon and it’s menu items.
 

Figure 158 — Function Curve Toolbar

Envelope Load  

Envelope Load allows you to load values into and save data out from curves described in 
the Graph Editor (See the Graph Editor section below.)   These curve files are called “enve-
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lopes.” Envelopes may be loaded or saved across the entire time range or across a selected 
range of time.

Figure 159 — Envelope Load Menu

One of the benefits of using a computer is that it can do the repetitive work for you. In 
ElectricImage 2.8, you can easily load motion data from motion capture device data files, 
other groups or function curves from another EI project. By saving and loading envelopes 
from other channels, you can reuse existing motion data and customize it for your current 
animation project. This works very well when doing repetitive motion, such as animating 
a set of humming bird wings, a trail of ants taking over a picnic, or matching blinking 
light patterns.

Clicking on the Load icon brings up a drop down menu with four choices:

• Load to Replace All...
• Load to Insert Into Time Selection
• Save All...
• Save Within Time Selection.

These tools allow you to load and save motion envelopes.

Load To Replace All

This menu choice will replace all of the keys with a previously saved channel envelope. 
Selecting this menu choice will present the standard Macintosh file open dialog from 
which you can select an envelope file. Envelope files can be saved from other channels or 
motion capture data files. 
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Load to Insert Into Time Selection

Using this option will replace the selected time frame with the saved data envelope. If the 
inserted envelope is larger than the selection area, keys outside the selection area are 
scaled to allow for the inserted envelope. Inserting an envelope works as if a slice of time 
is being inserted at the selection area. If the selection area is the same size in time as the 
envelope, keys outside the selection are unaffected. If the envelope is smaller than the 
selection area, keys following the selection area are shifted to an earlier time in the time-
line.

Save All

Use the Save All function to save all keys in the selected function curve. This effectively 
saves an entire channel as an envelope which can be loaded at a later time

Save Within Time Selection

Using this option, you can save all keys located within a selected range to an envelope file.

Key Channel Loader 

As its name suggests, the Key Channel Loader is used to add key channels into the Curve 
Editor. Select the object(s) in the Project Window, then use this tool load in all of or a 
selected group of animation channels. Once loaded, the channels are displayed in the 
channel list. The circles to the left of the channel names may be used to turn off the display 
of the channel in the graph window. Channel may be removed from the editor by select-
ing them in the channel list and hitting the delete key or by using the clear under the edit 
menu.
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Figure 160 — Key Loader Dialog

All

Using the All option, all channels for the selected object(s) are added to the key path edi-
tor. Depending on whether the selected object is a camera, light, or geometry there may be 
as few as 7 or as many as 30 or more channels added to the editor via this option.

Custom

Loads the channel selected using the Custom... view option in the project window.

Specific

Using the Specific option, you can import channels of selected types only. This option 
works well when you only need to edit a single attribute on many objects, such as the vis-
ibility property. Since some attributes have interrelated channels, those too will be loaded. 
For example, loading the Material type will load as many as 22 channels, while the Trans-
form type will load 9 and the visibility type only one.

Color Preferences 

Use to set the default color for curves displayed in the graph window of the Curve Editor. 
Clicking on this option invokes a dialog box with editor attributes accompanied by a color 
bar for customizing the color used for each attribute. You may use any color combination 
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which is comfortable for you, although selecting non-contrasting colors may make it diffi-
cult to distinguish between editor attributes.

Figure 161 — Color Preferences Dialog

Graph Display Element Control 

This pulldown changes the on/off settings of the last nine controls represented in the tool-
bar. Since, these nine controls can be turned off or on by clicking on them, this particular 
tool is redundant and will likely be removed.
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Figure 162 — F Curve Graph Display Element Control Menu

Grid

Displays a horizontal and vertical grid.

Ruler

Toggles the visibility of the time and range scales.

All Curves

Toggles whether the selected channel or all channels are displayed.

Velocity

Displays the velocity graph.

Acceleration

Displays the acceleration path.

Snap Undo

Displays the Snap Undo path.
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Current Time 

Displays the current time marker.

Time Range

Displays the time ruler.

Data Range

Displays the data ruler.

Grid Options 

This menu controls the grid. Both the spacing of the visual grid and the snapping grid are 
controlled here. To activate snapping, make sure that the caps lock key is set.

Key Channel Window 

The Key Channel window is used to set the curve type for each channel, and the begin-
ning. You can also manage individual keyframes through the key list. Get to know this 
window well, as it will offer you the ability to fine tune your function curves, and get the 
most out of your animation efforts.
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Figure 163 — Key Channel Window

The Motion Type Menu

The motion type menu determines the type of spline curve used to calculate the interpola-
tion of the data in the channel. There are four different curve types:

• Linear
• Natural Cubic
• Hermite
• F-Curve 

Linear

Straight line between the keys, no interpolation.

Natural Cubic

B-Spline interpolation, no controls. Use where you want automatic smoothing.

Hermite

More versatile than Natural Cubic. The whole curve won't change when one key is 
adjusted.
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F-Curve

Contains control handles for fine adjustment. This will give the best control and is similar 
to Bezier curves.

The Left & Right Extension Menus

The beginning and ends of function curves can have a variety of behaviors. This allows 
you to create repetitive motions quickly and easily, and has the added value of transmit-
ting any changes to the carried over curve sections, if desired.

Hold

The hold option maintains the value of the starting or ending point of the curve.

Repeat

This option will cause the entire curve to repeat itself in a cycle.

Oscillate

The Oscillate option will make the curve repeat itself in a mirror-image fashion.

The Key List Subsection

Individual channel keys are displayed in the keylist to the lower left of the Key Channel 
window. Keyframe attributes are displayed when a particular keyframe is selected in the 
list. There are several attributes that are controllable on a keyframe by keyframe basis:

• Time
• Value
• Spline-specific controls
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Figure 164 — Keyframe List

Time and Value Edit Boxes

You can change the time or value of the selected keyframe. Enabling the Hold Value check 
box will force the value of the slope between the selected keyframe and the next keyframe 
be maintained until the next keyframe: no interpolation will occur. This will appear as a 
flat line until just before the next keyframe in the Function Curve Editor.

Spline Specific Fields

This section displays different controls depending upon the spline selected in the Motion 
Type popup menu:

• Linear
• Natural Cubic
• Hermite
• F-Curve

Linear 

There are no additional controls for the Linear Motion Type.

Natural Cubic 

There are no additional controls for the Natural Cubic Motion Type.
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Hermite 

There are controls for the Tension, Bias, Continuity attributes of the acceleration and 
velocity of the curve. You can type the values in directly, or hold down the T, B, or C keys 
(lower case is fine) and dragging. You will see the acceleration and velocity curves change 
as you adjust the value. You will also clearly see changes in the actual motion path drawn 
in the world view windows. You can linearize the values by checking the Linear button.

F Curve 

Controls for the keyframe vectors will appear if the Motion Type is set to F-Curve. The 
keyframe vectors are the little “teeter bars” that appear at each keyframe. There are sepa-
rate vectors for the left and right side of the keyframe. You can set the vector angles by 
clicking and dragging on the vectors, or by typing values directly into the edit boxes. In 
addition, you cal linearize the spline segment by enabling the Linear button. When the 
beginning or ending keyframes are selected, on the left or right vector will be displayed.

There are also two check boxes for slope control, which affect the shape of the curve, and 
how the curve is interpolated through its control points:

Continuous Slope

Causes the curve to be smoothed along both sides of the control point equally.

Automatic Slope

Causes the curve's adjoining slopes to be adjusted for smoothness.

Editor Display Scale

The Editor Display Scale box allows you to scale individual curves so that they can be dis-
played together in the Editor. For example, lets say you have a X motion curve that runs 
from 0.0 to 4444 over 4 seconds and you also have a roll channel that goes from 0.0 to 5 
degrees over the same 4 seconds. Using the Editor Display Scale you can set the scale of 
the X motion to 1.0 and the roll to 889. In this way, both curves will be visible in the Curve 
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Editor and the same time. The Editor Display value for each channel is listed as a percent-
age after the channel name in the channel list.

Snap 

When a data or time range is edited within the Function Curve Editor, the original path 
becomes the Snap value. The Snap command stores the present position of a curve in 
memory. This allows you to display the original path while you make changes to it. You 
can make adjustments to a function curve and revert back by clicking the Unsnap option 
or saving the new curve as the snap value (or new original) by clicking the Snap option.

Range 

Ranges are highlighted sections of the Graph Window. The tools in this menu allow you to 
select a time or data range and to operate on sections of a curve within the range.
The range itself is created by dragging in the white band just below (time range) or just
to the right (data range) of the curve editor. The Time Range and Enable Range buttons 
must be on for the range to be displayed (see below).
 

Figure 165 — Range Menu

Set Ranges…

Brings up a dialog box that allows you to type in values to create the range instead of 
dragging the range at the right or bottom of the Graph Window.
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Fit to Range

Scales the curve to fit within the selected time range.

Fit to Data Range

Scales the curve to fit within the selected data range.

Move to Beginning

Move an entire channel’s keyframes to start at time 0

Reverse Time

Reverses the order of keyframes reversing the animation.

Reverse Data

Reverse keyframes to reverse data values

Key Time Range

Deletes keyframes outside of the selected time range.

Fit Curve To Data in Time Range

This option fits a curve to custom keyframe data with a tolerance setting. The original cus-
tom data is deleted. You can use this setting to turn motion capture data into motion 
curves.

Grid Enable 

This button toggles the display of the grid in the graph window.
266       ElectricImage 2.8 Supplement    



Function Curve Editor — Reference
Time Scale Enable 

This button toggles the display of the time scale, the value scale, and the time thumb con-
trol. The time thumb display mode (seconds, timecode, frames) can be changed by option-
clicking on the control.

All Paths 

When this button is off, only the channel highlighted in the channel list is displayed in the 
graph window.

Velocity Display 

Toggles the display of the velocity curve. The velocity curve is updated as you make 
changes to the channel curve.

Acceleration Enable 

Toggles the display of the acceleration curve. The acceleration curve is updated as you 
change the channel curve.

Current Time 

Toggles the vertical time line that crosses through the editing field.
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Time Range 

Toggles the display of the selected time range. The Time Range is chosen by dragging in 
the white region just below the Graph Window. Copying and pasting takes place inside 
the chosen Time Range.

Data Range 

Toggles the display of the selected data range. The Data Range is chosen by dragging in 
the white region just to the right of the Graph Window.
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Character Animation Section

Introduction

ElectricImage 2.8 introduces state-of-the-art character animation features, including 
advanced inverse kinematics, facial expression morphing and the ability to use hierarchi-
cal Bones to deform a single skin object. As character animation is such a complex and 
varied topic, we have decided cover the topic in several sections, spread over multiple 
chapters.

The first section will address inverse kinematics.  The first three chapters in this section 
will cover Effectors, Hierarchies and Constraints, and the Group Linkage Window.  The 
last two chapters will cover Deformations and Facial Animation.

Bones are partially covered in the Effectors chapter and the Deformations chapter, as a 
bone can serve double duty as both an effector and a deformation.
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Using Effectors

Introduction

Effectors are invisible null objects that models, cameras, and lights in a scene can be linked 
to.  Any transformation, rotation, scale, or deformation applied to the effector will be 
passed on to the groups that are linked to it.  Using effectors allows you to control com-
plex animation's by layering motion characteristics into separate control objects.  The fol-
lowing chapter will explain the use of effectors of all kinds, and describe the layout of the 
new effector window.

Effectors can be used at any level in a heirarchy chain, and can be esecially useful in an 
inverse kinematics chain, to create a “broken hierarchy,” as explained in the chapter 
“Hierarchies and Constraints.”

Adding Effectors to a Scene

1.  Choose File > Add > Type > Effector.  Or choose the effector icon from the Object Pal-
ette.

Figure 166 — The Add Effector button from the Object Palette

2.  The cursor will change to an arrow with a cube next to it.

Figure 167 —  The Add Effector cursor

3.  Click in any view window to set the effector in the scene.
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The Effector Info Window

Figure 168 — The Effector Info window with the X-form tab displayed
 
An effector’s characteristics are controlled by the settings in the Effector Info Window.  
This window is very similar to the Group Info window for model geometry.  It is divided 
into two specific sections, each marked by a folder tab.

• X-Form
• Special

X-Form (Transformation) Tab

The X-form tab in the effector info window is similar to the x-form tab for other objects in 
a scene.  There are four rows of data cells that allow the input of values:

• Position
• Center
• Rotation
• Scale
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Position

This row of data cells allows the input of X, Y, and Z position values for the effector.  The 
"Key" pull-down menu offers a choice of "Implicit" or "Explicit" keyframe recording.

Figure 169 — The Implicit/Explicit menu

Implicit

will create a velocity curve for the keyframes. 

Explicit

will create f-curves for the keyframes.

(For an explanation of Implicit and Explicit translation, please refer to “Using and Ani-

mating Groups” chapter.)

Center

This row of data cells allows the input of X, Y, and Z position values for an effectors center 
of rotation.  Changing these values will move the physical center of the effector.

Rotation

This row of data cells allows the input of X, Y, and Z rotation values for the effector.

Scale

This row of data cells allows the input of X, Y, and Z scale values for the effector.
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Special Tab

Figure 170 — The Effector Info window with the Special tab displayed

The Special tab contains editable fields that affect how different types of effectors display 
in a scene.  This tab is used for Box Effectors, Joints, and Bones only.

The Style pull down menu in the effector info window offers a choice of how you want to 
display an effector. The standard effector display styles are Cross and Box. There are also 
a special class of effectors called Joints and Bones that create pre-built hierarchies.  (See 
the Skeleton Effectors and Bones section later in this chapter.)  Whichever display method 
is chosen, keep in mind that an effector represents a single point in space, and is trans-
formed in relation to that point.
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The Effector Style Menu

Figure 171 — Style pull down menu

Box

Choosing Box from the style drop down menu will display a cube in the scene.  An extra 
checkbox called Show Extent will become available right below the Style drop down 
menu.

 

Figure 172 — The ShowExtent checkbox

Extents are dessentially the lines that join to create the cube.  They display the outer limits 
of the space occupied by the effector.  Unchecking this box will disable the display of the 
cube, leaving only its center of rotation visible in the scene.

 

Figure 173 — A box effector showing extents

The defining characteristic of a box effector is that it can be resized.  This makes the box 
effector display perfect for scaling and deformations, as well as surrounding groups of 
linked objects.
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Special Tab Options

Selecting Box from the style pull down in the Effector Info window will cause the Special 
tab to display two new options:

• Origin 
• Size

Figure 174 — The Origin and Size value boxes

These options only affect the way the effector displays.

Origin

The Origin defines the point in space that the boxes extents are drawn from.  The origin 
displays as a small cross.  In the picture below, the Origin is represented by the black circle 
and the black crossed lines at the center of the effector.

 

Figure 175 — A Box effector with the Origin point in the center

Size

The Size defines the size of the box effectors extents in world units.  Don't confuse size 
with scale (found in the X-Form tab).  If you scale a box effector, you will scale all objects 
attached to it.  Changing extent size affects only the box display.  You can, for instance, 
change these values to make a box effector larger in order to suround the groups that are 
linked to it.
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The size and origin boxes work together to control the overall size and positioning of the 
effector in space.  When a change is made to  the size values, the boxes extents will change 
in relation to the origin point.  To keep the origin exactly in the center of the box the values 
in the origin fields need to be a negative half of the value in the size fields.

For instance, if you change a boxes size from 1.0 on x, y, and z to 100 you would need to 
change the origin to -50 on x, y, and z to keep the point from which the box is drawn even 
with the boxes center point.

Cross

Choosing Cross from the style menu will display a small target shaped circle.
 

Figure 176 — A cross effector

The defining characteristic of the cross effector display type is that it can't be resized.  This 
makes the cross effector ideal for large scenes that require constant zooming in and out.   
Regardless of how far in or out you zoom, the cross effector will remain the same size, and 
thus be easy to select and manipulate.

Special Tab Options

There are no editable attributes displayed in the special menu for a cross effector.

Joint

Figure 177 — Style pull down menu
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Choosing Joint from the style drop down menu will display a Skeleton Effector Joint Vec-
tor in the scene.
 

Figure 178 — Joint (Skeleton) effector

A joint displays as a long, toothpick shaped object, that is pointy on one end and round on 
the other.  The center of a joint effector is displayed where the horizontal and vertical vec-
tor lines cross.  Joint effectors are used to create skeletal hierarchies.  To create a linked 
chain of joint effectors use the File > Add > Type > Skeleton command.

Special Tab Options

Selecting the joint display method enables a row of size data cells in the special tab.

Figure 179 — The Size boxes

These values can be modified to change the length of the Joints vector.  Because skeleton 
joints always orient with the Z-axis running the length of the vector, the only value that 
needs to be changed is the Z data field.  (See Drawing Skeletons and Bones for more infor-
mation.)
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Bone

Figure 180 — Style pull down menu

Choosing Bone from the style drop down menu will display a Bone Effector Joint Vector in 
the scene. 

Figure 181 — A Bone Effector

A bone displays as a long, toothpick shaped object, that is pointy on one end and pyramid 
shaped on the other.  The center of a bone effector is displayed where the horizontal and 
vertical vector lines cross.  Bone effectors are used to deform object meshes.  To create a 
bone effector chain use the file > add > type > bones command.

When a bone display style is chosen, several new items become available in the effector 
info window.
 

Figure 182 — New options in the window when Bone is selected

Bone Color

The bone color displays the color the bone will appear in when it is deselected.  This color 
can be changed by clicking on the color tab and choosing a new color from the color 
picker.
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Bone Highlight

The bone highlight color displays the color the bone will appear in when it is selected.  
This color can be changed by clicking on the color tab and choosing a new color from the 
color picker.

Set Rest

Rotating a bone into the desired position and pressing the "Set Rest" button will tell the 
bone what position to stay in when it is at rest.  Please refer to Chapter X, Deformations, 
for more information.

Set Bias

Resets the current rotation values of the bone to 0,0,0.  Bones have a default Z orientation, 
which can interefere with imported data, such as motion capture data.  This featrue lets 
you position the bone, and then “zero it out.”  This is similar to indexing a servo motor or 
motion control axis on a robotic camera system.

Special Tab Options

Selecting the joint display method enables several new options in the special palette.  
These options, with the exception of bone length, are specific to how a bone deforms a 
mesh.  (See the Deformations chapter for more information.)

Figure 183 — The Special Menu options for Bone
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Why use an Effector?

Often times an animation requires "layering" of motion.  You may need to translate or 
rotate an object in several different ways to achieve the desired animated results.  The only 
problem is that an object has only one set of data channels.  Once the rotation channels are 
filled, for instance, they can't be changed without erasing the previous values.  You can, 
however, link to a second object to create a second set of rotations that will happen on top 
of the rotations that have already occurred in the local data channels.  Effectors allow you 
to gain control of your animation by separating transformations into easily addressable 
layers.

One classic example of this is a moon orbiting a planet.  You want the moon to rotate 
about its local center point, but you also want it to orbit around the planets center point.  
You create a rotation of the moon on the Y-axis so it spins.  But now you have to give the 
moon a second Y-axis rotation characteristic that orbits it around the planet. The only way 
to do this is to link the moon to an effector that is positioned over the center of the planet.  
By rotating the effector on Y you can create two y-rotations for the moon!

Another example would be creating a swarm of bees.  You would want to individually 
animate each bee so it flies in a slightly different manner, but you would also want all the 
bees in the swarm moving forward at a similar rate.  You could animate each bee's for-
ward motion individually.  Each time you change one bee in the swarms forward acceler-
ations, however, you would have to re-animate the rest of the swarm to follow.  A better 
way to control the swarm would be to link each bee in the swarm to an effector that pulls 
them forward as a group.  This would allow you individual control over each bee (as long 
as the link type is set to free), but move them all forward at the same rate.

If you're working on a complex animation task and having difficulty achieving the desired 
results, ask yourself "Could an effector help me here?"
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Skeleton Effectors and Bones

Skeleton Effectors and Bones are a special class of effector that can be used to create pre-
linked hierarchies.  Skeleton Effectors and Bones both display similarly as sharp "tooth-
pick" like vectors.

   
Figure 184 — Joint (Skeleton) effector and Bone Effector

Skeleton Effector chains can be used to create complex hierarchies that geometry can be 
linked to.  By allowing an underlying hierarchy of skeleton effectors to control a complex 
model, you gain the freedom to manipulate, or replace geometry without the necessity of 
re-defining all of your joint parameters.

Bone Effectors are used to create chains that can deform an objects mesh.  They can be 
used to create smooth skeletal deformations in situations where you can’t work with a 
jointed model.

Adding Bones and Skeleton Effectors

Choose File > Add > Type and pick Skeleton or Bone.  Skeleton Joints and Bones can also 
be added by choosing the skeleton or bone effector icon from the Object palette.
 

Figure 185 — The Skeleton and Bone effector icons
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Click in any window to set the root of the chain (double click to set the root for a bone), 
click a second time to set the length of the vector.  Continue clicking in this fashion to cre-
ate a linked chain of any length.

To end the creation of a chain type  -. (Command-Period)

Skeleton Effector and Bone Orientation

The Z-Axis of a skeleton Effector or a bone is always oriented parallel to the length bone 
vector.  This has the potential to cause confusion if you don’t look for it.

For instance if you draw a skeleton effector in the front view window, starting at the top 
and moving to the bottom, you would expect the z-rotation tool to rotate the effector like 
the hand on a clock.  However, you will find this isn’t the case because the z-axis is aligned 
with the world's Y-axis.
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Hierarchies and Constraints

Introduction

Inverse kinematics depends upon hierarchies to function. A hierarchy is defined as a col-
lection of groups attached in a relationship with each other in some fashion, like the links 
in a chain (hierarchies are often referred to as chains.) Any time you link two objects 
together you are creating a hierarchy. A hierarchical relationship allows the transforma-
tions of a parent object to be passed along to child objects. A hierarchy can be as simple as 
two linked objects, or as complex as a thousand linked objects. 

Constraints limit the scope or motion of a joint within the hierarchy.  By establishing con-
straints for each joint, a variety of specialized motion can be easily achieved.  Also, inverse 
kinematics chains are far more predictable if constraints are applied to each joint.  The 
solution process of inverse kinematics can be made more efficient by imposing constraints 
as well. Constraints and hierarchies work hand in hand together. This chapter will have 
direct impact upon your success in working with inverse kinematics. See also chapter 2 of 

the ElectricImage Version 2.5 Supplement, “Inverse Kinematics” for additional informa-

tion.

Hierarchies

There are two types of hierarchies:
• Static
• Articulate

Static Hierarchy

A static hierarchy consists of a group of linked objects that don't change relationships to 
each other. A chair is an example of a static hierarchy. The legs, back and seat are all linked 
together in a “locked” relationship that never changes.
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Figure 186 — A Static Hierarchy

Articulate Hierarchy

An articulate hierarchy consists of a group of linked objects that move in a pre-defined 
relationship to each other, and their parent object. A robotic manufacturing arm would be 
an example of an articulate hierarchy. The claw, upper arm, and lower arm are all linked 
to the base, but each item is free to move around its own pivot point. Articulate hierar-
chies require an extra degree of thought and set-up prior to animating.

Figure 187 — An Articulate Hierarchy
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That’s where constraints come in.  A constraint is a way to limit, or control an objects 
motion. In Electricimage a constraint can be accomplished in several ways: By parenting 
one model to another; By setting joint position and rotation limits; or by creating an auto-
Ik constraint.

Joints and Chains

When you link one object to another, you create a joint. The joint is simply the point where 
the two objects connect.

 The position of the joint is determined by the objects center point, which in turn controls 
how linked objects move in relationship to each other.

A chain, or joint chain, is a series of one or more joints that have been linked together. To 
use the human body as an example, the shoulder is a ball and socket joint, the elbow is a 
hinge joint, and the wrist is similar to a universal joint. The upper arm (shoulder), the 
lower arm(elbow), and the hand (wrist) form a joint chain.
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Figure 188 — Typical Hierarchy Chain

Every chain has a root that defines the parent object holding the chain in place.

Understanding How Joints Rotate

Objects in ElectricImage rotate around their center of rotation. You can recognize the cen-
terpoint when you're in wire frame mode as a small black dot on selected objects.

 

Figure 189 — Arm With Rotation in Center

When you're creating joint chains you need to make sure that the center of rotation is 
aligned with the area you want the object to rotate around.
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If you were to create an arm chain, you would probably want the lower arm to rotate 
around the end that's attached to the upper arm. When you import the model, you will 
need to check and see where the center of rotation is. If it's in the middle of the lower arm, 
the rotation tools would cause it to spin like a propeller.

Figure 190 — Result of Center Rotation on Arm

If, on the other hand, you move it down to coincide with the point it joins the upper arm, 
you will get a believable rotation.
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Figure 191 — Result of Proper Rotation Point for Arm

To move the center of rotation you have to move the local origin, which appears as a small 
cross on selected objects.

Figure 192 —  Center of Rotation

It's important to note that the local origin and the center of rotation are controlled in dif-
ferent dialogues. The center of rotation is controlled in the group info window for an 

Center of Rotation
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object with the “center” data channels. The Local origin is controlled in the group linkage 
window.

In a normal hierarchy you would want to keep the local origin and the centerpoint equal 
to each other. This is to make sure that wherever you drag the local origin to, will also be 
the point around which and object rotates. When the “center” values in the group info 
windows are at 0,0,0 the center of rotation will align exactly with the local origin. The cen-
ter of rotation is the point that actually defines the geometric center of an object. The local 
origin, on the other hand, simply defines where an object joins to its parent. This is why 
control for the two resides in different dialogues. The center of rotation is defined as an 
offset of the local origin. So when you move the local origin, the center of rotation will 
move a proportional amount. The only time you can get into difficulty here is if you man-
ually enter an offset in the “center” channels. This may cause your object to rotate out of 
synch with the position of the local origin.

Animating Joint Chains

When you have you're joints properly configured to rotate in relationship to each other, 
the next logical thing to do is animate them. There are two ways to animate joint chains in 
ElectricImage: Forward Kinematics, and Inverse Kinematics. With either method your 
goal is to move part of a chain toward a target object. 

Animating with forward kinematics requires that you control your hierarchy from the top 
down. You move the parent, then the child. Any movement you give to the parent is 
passed on to the child, but the movement you give to the child is NOT passed on to the 
parent.  This is the default positional animation method in ElectricImage.
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Figure 193 — Forward Kinematics Flow Chart

Let's say we want to create an animation of an arm chain as it reaches out for a glass of 
water.

Using forward kinematics we would first rotate the upper arm toward the glass, then the 
lower arm, and finally the hand. This method of animating gives you the greatest control 
over your joints by forcing you to set keyframes for each one of them. It isn't the most 
intuitive way to reach the target though. You have to guess how far to move the upper 
arm, then the lower arm, in order to get the hand closer to the glass. 

Illustrations “Chain at Rest”, “Shoulder is Moved First”, and “Rotated Elbow brings 
Hand to Glass” demonstrate this process.
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Forward Kinematics Example

Figure 194 — Chain at Rest
 

Figure 195 — Shoulder is Moved First

Figure 196 — Rotated Elbow brings Hand to Glass
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Wouldn't it be much easier if we could just pull the hand toward the glass and have the 
rest of the joints follow?

Animating with Inverse Kinematics will allow us to do just that. As its name implies 
Inverse Kinematics lets you animate from the bottom up. You pass information FROM the 
child TO the parent. Any movement you give to a child object is passed up the hierarchy 
to its parents. Unlike forward kinematics then, parents are aware of what their children 
are doing.

Figure 197 — Inverse Kinematics Flow Chart

To animate our arm with Inverse Kinematics we select the Lower Arm, the Upper Arm, 
and the hand (in any order), and pull on the hand with the IK tool. In one simple step you 
have animated all the joints in the arm chain and reached the glass of water! 
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Figure 198 —  Inverse Kinematics Version of Glass Example

With an inverse kinematics method you've gained control over reaching the target, but 
you've lost control over your joints. Instead of having fixed keyframe values for each joint 
in the chain, you have only one keyframe (the one for the child) controlling them all.

One thing you must keep in mind about Inverse Kinematics is that the parent/child rela-
tionship in your hierarchy hasn't been turned off. It's just temporarily reversed when you 
use the IK tool. It is possible to create a conflict by using an inverse kinematics method 
and a forward kinematics method on the same chain. 

In our example of a hand reaching for a glass of water we set a keyframe, using IK, for the 
hand which controls the lower arm and the upper arm. If, we decide to use the move tool 
to translate the upper arm forward, a forward kinematics solution, we will move the hand 
past the glass.
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Figure 199 — Conflicts between Forward and Inverse Kinematics

Because the forward kinematics solution forces the child to follow the parent again, the IK 
keyframes are actually dragged out of position!

It's a case of the “Push Me Pull You.” When you're using the IK tool, the parents are aware 
of where the children have been keyframed and react accordingly. Using the Forward 
Kinematics tools (move tool, x,y,z rotate tools) makes the parents ignore the child key-
frames.

Using the IK tool

Because IK works on a hierarchy, you must select all the objects you wish to translate first. 

Select all the objects in the chain(s) you wish to translate with the IK tool. Holding the 
shift key down while selecting will let you make multiple objects active.
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Figure 200 — Multiple selected joints in the Front View and Project Windows

With the IK tool select the child on the chain(s) you wish to manipulate

  

Figure 201 — The bottom child on the chain is selected

Pull in any view window. The chains will all move at once within any limits and con-
straints that have been set for them.
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Figure 202 — The IK Chain in motion

It's important to keep in mind that the IK tool actually translates AND rotates all the 
selected joints in a chain at the same time. So if all the joints in your chain are set to free 
(giving them the freedom to rotate and translate) using the IK tool to move the chain will 
actually cause it to break apart.
 

Figure 203 — The IK Chain breaking apart

IK Preferences

The kinematics preferences box can be opened by choosing Edit > Preferences…Kinemat-

ics Tab. The options in this box control the way in which Electricimage solves Inverse 
Kinematics solutions.
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Figure 204 — The Kinematics Preferences  Tab

There are six sections in the Kinematics Preferences Tab:

• IK Dragging Options Section
• IK Deselected Joint Options Section
• IK Interactive Solutions Section
• IK Automatic Solution Section
• Constraint Multipliers Section
• Global Gravity Section

IK Dragging Options Section

This section contains controls which govern the behavior of inverse kinematics chains as 
you drag them. There are three options:

• Use Phantom Joint
• Use Global Gravity
• Keep World Orientation
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Use Phantom Joint

When this box is checked, phantom (ghost) joints for a chain will be displayed as it is 
manipulated with the IK tools. This option defaults to on.

Use Global Gravity

This option activates global gravity for the chain, using the values in the global gravity 
section. This option defaults to off.

Keep World Orientation

This option locks the rotation of the groups in the chain in global space. This option 
defaults to off.

IK Deselected Joint Options Section

This section contains the controls which govern the behavior of the deselected joints in the 
inverse kinematics chain. There are two items in this section:

• Lock Rotation
• Lock Position

Lock Rotation

This checkbox, when enabled, will prevent deselected joints in a chain from rotating. This 
option defaults to on.

Lock Position

This checkbox, when enabled, will prevent deslected joints in a chain from moving. This 
option defaults to off.
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IK Interactive Solutions Section

This section contains controls which lets you fine tune the behavior of the interactive IK 
solution process.

Find Exact Solution

This checkbox, when enabled, will force Electricimage to find the exact IK solution for a 
joint chain when it is manipulated. Enabling this option can add significantly to the time it 
takes to redraw the position of a chain.

Solution Time

This data field allows the entry of a time, in seconds, for the IK chain to update once its 
been manipulated. This time only applies if the Find Exact Solution box has been checked.

Automatic Solution Options

This option controls the behavior of the Automatic Inverse Kinematics feature.

Solution time

This data field allows the entry of a time, in seconds, that can be used before the chain is 
automatically redrawn.

Constraint Multipliers Section

These edit boxes contain values that establish the relative importance of  Position, Orien-
tation, Stiffness, Viscosity and Gravity when applying inverse kinematics. These values 
can be set between 1 and 0. The higher the number in each field the higher the priority that 
channel will take in when the IK solution is calculated.
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Global Gravity Section

These data fields allow the entry of a global gravity constraint that will be applied to all 
joints in a chain when using the IK tool. The default setting is X= 0, Y= -1.0, and Z= 0. Nor-
mal Earth gravity would be zero for the X and Z axes, and a negative value for the Y axis.

Gravity only effects how the group moves while the model is being dragged in IK mode.

Creating a Workable Hierarchy

When you create a joint chain, you are creating a series of dependencies. Each joint in a 
chain will move and rotate in relationship to its parents movements. If you give each joint 
in that chain the freedom to rotate on all axes, you could end up with a joint chain that is 
spinning out of control. 

The price you must pay for the ease of animating with IK is properly setting up joint rota-
tion and position limits for each joint in your chain. By doing this you're telling the IK tool 
where and how to bend your joints.

Broken Hierarchies

When you join multiple joint chains into a single hierarchy, you have to pay close atten-
tion to how these chains will interact with each other when you animate them. In any hier-
archy there can only be one parent. Every time you make a change to the parent you will 
be sending a cascade of changes down all of the joint chains that are connected to that par-
ent. This could lead to a hierarchy that bends and twists in unexpected ways.

To prevent the animation of one joint chain in a hierarchy from contaminating others in 
the same hierarchy it's sometimes necessary to break the hierarchy into separate pieces 
that all lie on the same level. 

The best case for breaking a hierarchy is the human body. 
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As a joint chain structure the human body has two arm chains, two leg chains, a back 
chain, a head chain, and hips. In the natural world the hips tend to be the point where 
everything finally connects. When the hips move forward, so do the arm chains, the head 
chain, and the legs.

It's easy to animate the arm and leg chains in this configuration. Any IK animation you 
give these chains will stop being passed at their roots. But when you try and move the 
entire hierarchy forward (to take a step) the hips will send their movement data back 
down into the leg and arm chains. This will cause the IK solution you've applied to these 
chains to be overridden. The end result will be a hierarchy that isn't working properly.
Each time you rotate a chain in this hierarchy you run the risk of sending the translation 
and rotation information into another, seemingly unrelated, chain.

This can be prevented by breaking the hierarchy up into smaller, related sections. By con-
necting the arm and leg chains to an effector, you create a sort of animation “washer” that 
helps prevent the keyframes used to move the entire hierarchy forward from interfering 
with the local IK keyframes you give to your chain.

Animating a broken hierarchy also requires a “broken” animation technique. You must 
devise an animation strategy that allows you to animate the movement of the individual 
chains with rotation keyframes, but also allows you to pull the same chains around with 
effectors that act as roots of the individual hierarchies.

Auto-IK

While it's not advisable to use the IK tool and the forward kinematics tools on the same 
chain, it is possible to achieve the same effect on the chain using an auto-ik constraint. 
This type of constraint allows you to manipulate objects with the move and rotate tools, 
but applies an Inverse Kinematics solution to the chain.
ElectricImage 2.8 Supplement        303



Hierarchies and Constraints — Auto-IK
Auto-IK allows you to force your chain to follow an object that lies outside of its hierarchy.   
When you move the object that your chain has been auto-IK constrained to, an IK solution 
will be passed up the chain, controlling all of the joints, until it reaches the termination 
point. (This is also known as “goal animation.”)

At the same time you will be able to translate the root of the chain in a different direction. 
When you do this, the joint chain as a whole will try and orient itself so that it stays 
aligned with the position of the root, and the auto-ik constraint object. This is why it's 
called a constraint. When the chain is in motion, it will be constrained to a position 
between the root, and the auto-IK constraint object.

Because an auto-IK constraint object is not part of the joint hierarchy itself, the IK solution 
doesn't know where to stop applying itself within the chain. In order to keep the auto-IK 
constraint from affecting all of the joints, you will need to set a termination point. The ter-
mination point simply tells the auto-IK solution where to stop applying itself.

Setting up an Auto-IK Constraint

Using an auto-IK constraint requires a jointed chain and a constraint object that is not part 
of the chains hierarchy.

Select the part of the chain that you want to follow the constraint object.

Choose the Constrain to object tool from the Project Window or the Tool Palette.

 

Figure 205 — The Constrain to Object tool
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Click on the constraint object. Two keyframes will immediately be set. One at the current 
position of the time thumb, and one at the end of the animation. These are custom key-
frames that will be recalculated every time you move the constraint object.

Select the part of the chain you are constraining and switch your project to keyframe 
mode. Spin down the data channel arrow for the object.

Figure 206 — Auto Frames Channel opened

Spin down the AutoFrames arrow for the object and pick a termination point from the 
Auto IK dropdown menu.

Once the termination point is set you can animate the constraint object, and the chain will 
follow along. Each time you preview your animation the auto-keyframes will be recalcu-
lated. 

To disable an auto-IK constrain select the object in the chain that's being constrained and 
click on the Remove Constraint Tool.
 

Figure 207 — The Remove Constraint tool
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Because Auto-IK constraints create custom keyframe data for the objects they're constrain-
ing, it's a good idea to use the Keyframe > Clear All Keyframes command on the object 
the constraint has been removed from.
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The Group Linkage Window 

Introduction

Through the Group Linkage Window, you determine transformation behavior, rotation 
order, link type, rotation orientation, movement constraints, inherited transform behavior, 
and joint attributes. It is wise to take the time to work with these attributes to get the most 
from bones deformations and inverse kinematics.

A pivot point is the location on the group in which rotations occur. It is also the point of 
origin for scaling operations, and translation (movement). A pivot point is visible for each 
group in all of the world windows, and is presented as a black cross, as illustrated below:

Figure 208 — Pivot Point Indicator

The pivot point and the group center are almost always located in the same position. The 
group center can be offset from the pivot point by typing in a new value in the Group Info 
Window. Doing so is ill advised, and can cause some unwieldy animation behavior. The 
combination of the group center indicator (a black dot) and the pivot point appears below:

Figure 209 — Pivot Point and Center Indicator

The pivot point defaults to the center of the group. You can use the Group Linkage Win-
dow to place the pivot point at some other location. You can even set the pivot point to be 
well outside of the group’s extents, if need be.
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Figure 210 — The Linkage Icon

There are four ways to access the group linkage window:

• Select a group and choose the Linkage Icon from the Tools palette
• Select a group and choose the Linkage Icon from the Tools menu
• Select a group and choose the Linkage Icon from the Project Window
• Hold down the Command & Option keys and double click on a group

Figure 211 — The Group Linkage Window

The Group Linkage Window can be positioned to your preference. It can also be resized 
by clicking on the lower right hand corner and dragging. It is context sensitive — the con-
tents of the window will change to reflect the currently selected group. It can display the 
linkage information for one group at a time. The window is divided into three sections:

• Group Preview Pane
• Pop Up Menu Section
• Tab Section
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Group Preview Pane

The group preview pane allows the pivot point for an object to be interactively positioned 
by clicking and dragging. Unlike the world windows, the pivot point representation in the 
Group Linkage Window is that of a large red cross hair, called a gnome. The gnome dis-
plays the X, Y, and Z coordinate position and orientation for the joint. Where these vectors 
meet represents the center of the pivot point. 

Figure 212 — Pivot Point Gnome

The detail to which an object is drawn in the group preview window is controlled by the 
settings in the Drawing Preferences Box, under Edit >Preferences Drawing Tab. Also, the 
shader ball icon can be set to control drawing, by holding down the option key and click-
ing on the icon, then choosing the desired drawing level from the pop up menu list.

The group preview window view can be manipulated in the same way world view win-
dows are. Clicking on the zoom in, zoom out buttons will bring an object closer or farther 
from the view window. Option-clicking on the zoom icons will fit the group into the view. 
Clicking on the view pop-up will change the angle from which the object is viewed.

-X +X

-Z

+Z

+Y

-Y

Pivot Point Center
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The gnome can be positioned by clicking and dragging on it in any orthographic view.   
The gnome cannot be interactively dragged when the view is set to skew, but it can be 
interactively rotated.

Pop Up Menu Section

The pop up menu section at the top of the group linkage window contain settings that will 
affect joints the same way regardless of what information is entered in the tabs. There are 
three menus:

• Transform Menu
• Rotation Order Menu
• Link Type Menu

Transform Menu

Rotations are susceptible to a distortion known as “shearing” when non-uniform scaling 
is applied to groups within a hierarchy. The transform menu lets you choose how the phe-
nomenon will be addressed, on a group by group basis (each group can have a separate 
setting). The transform menu offers two options:

• Classic
• Standard

Standard

To avoid the shearing phenomenon, this option allows ElectricImage to compensate by 
processing scaling operations so that the shearing phenomenon does not occur. This is the 
default method.

Classic

This method bypasses any compensation for the shearing effect. You can use this option if 
you are not applying non-uniform scaling to any groups in the hierarchy without any ill 
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effects. If you do notice shearing, switch to the Standard method. This option is called 
classic because other programs on the market use this method (even though it is less 
sophisticated.)

Rotation Order Menu

Object rotation order determines how rotations will be processed. Each rotation axis is 
processed one at a time. Ultimately, one of the three axes will nullify one of the other axes. 
For example, a rotation applied to Y and Z may produce the same result, even though 
they are clearly different axes. This is called “gimbal lock.” Choosing a different rotation 
order can alleviate the problem.

Figure 213 — The Rotation Order Pulldown

The default is ZXY. This means that Z rotations will be calculated first, followed by X, and 
finally by Y axis rotation calculations. For many animation situations the default settings 
will work just fine.

A good rule of thumb for assigning rotation order is to calculate the axes in a descending 
order of stability. Think about how you're object is moving, and decide which axis is most 
important to creating the desired motion. Which axis is second most important, and 
which is the least important. 

The last six choices in the Rotation Order pull-down have a fourth coordinate inside 
parentheses. This coordinate controls the last rotation in the order. For instance, XYX(z) 
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indicates an X rotation, then a Y rotation, and a second X rotation that is controlled by the 
Z coordinate channel.

An alternative method for dealing with gimbal lock is to assign separate effectors for 

each axis of rotation, and parenting the group to these effectors. Set up each effector so 

that it can only rotate on a single axis, which prevents gimbal lock altogether.

Link Type Menu

The Link Type pull-down menu contains pre-configured link types that can be applied to 
an objects pivot point. Use this pull-down menu to set a basic set of position and rotation 
limits for a joint. The link type chosen will create global rotation and position limits that 
will override specific values entered in the limits sub-palette, by locking specific X, Y, and 
Z channels.

Figure 214 — The Link Type Menu

There are eleven menu options in the Link Type Menu:

• Custom…
• Free
• Ball Planar
• Cylinder Planar
• Planar
• Socket
• Cylinder
• Universal
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• Slide
• Pin
• Lock

Custom

The custom option opens a dialogue box that allows specific rotation and position param-
eters to be locked or unlocked for a group. Parameters with check marks next to them are 
completely disabled. For instance, a check mark next to Lock Y Position will disable an 
objects ability to move on the Y-axis.
 

Figure 215 — The Custom Link Window

The Custom link type can be used to see what kind of position and rotation limits are cre-
ated by the other pre-defined link types. Just pick one of the link types, like socket, and 
then choose Custom. The Custom Joint dialogue will pop-up with the limits that a socket 
link uses already checked off.

Free

This link type allows an object total freedom to move and rotate on all axes. Free is the 
default link type for root objects in any chain. Because this joint type is free to move and 
rotate on all axis, the values in the limits sub-palette will override it.

Ball Planar

This link type locks the Y position channel only.
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Cylinder Planar

This link type locks the Y position channel and the X rotation channel.

Planar

This link type locks the Y position channel and the X and Z rotation channels.

Socket

This link type locks the X, Y, and Z position channels.

Cylinder

This link type locks the X and Y position channels and the X and Y Rotation Channels.

Universal

This link type locks the X, Y, and Z position channels and the X rotation channel.

Slide

This link type locks the X and Y position channels and the X, Y, and Z rotation channels.

Pin

This link type locks the X, Y, and Z position channels, and the X and Y rotation channels.

Lock

This link type locks all position and rotation channels.
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Folder Tab Section

All of the specific local controls for an group’s pivot point can be set in the folder tabs of 
the Group Linkage window. There are three folder tabs in this section:

• X-form (Transformation)
• Inherit
• Limits

The X-Form Tab

The X-form tab controls the position and orientation of the gnome, and thus the pivot 
point for an object. Values entered in these fields will cause the gnome to be re-positioned 
in the group preview pane.

Figure 216 — The Transformation window

Link Alignment Position

This pull-down controls the position of the groups pivot point in relation to its geometric 
bounds. The different choices will place the gnome in that position relative to the group.
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Figure 217 — The Link Alignment Menu

There are a total of seven items in this menu:

• Middle
• Front
• Back
• Top
• Bottom
• Left
• Right

Figure 218 — Changing the Pivot Point

Middle

The default for all objects, positions the pivot point exactly in the center of the object.

Front

This option positions the pivot point with the groups front.
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Back

This option positions the pivot point with the groups back.

Top

This option positions the pivot point with the groups top.

Bottom

This option positions the pivot point with the groups bottom.

Left

This option positions the pivot point with the groups left side.

Right

This option positions the pivot point with the groups right side.

Link Alignment Orientation

This pull-down controls the orientation of the groups pivot point. Changing the link 
alignment orientation changes the orientation of the X, Y, and Z axes of the pivot point. 
Changing the Link Alignment Orientation will change the direction that the object 
rotates.

Figure 219 — The Link Alignment Menu

The results of changing the Link Alignment Orientation can be seen in the group preview 
pane by watching the changes in the gnome orientation as different options are chosen.
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There are three choices in the Link Alignment Menu:

• Z is Z
• Z is X
• Z is Y

Z is Z

The default option maintains the objects initial link coordinates.

Z is X

This option will swap the group's Z and Z coordinates so that the Z coordinate becomes 
the X coordinate.

Z is Y

This option swaps the group's Z and Y coordinates so that the Z coordinate becomes the Y 
coordinate.

Position Section

This area contains data cells for the X, Y, and Z position of the pivot point. Entering values 
in this field will update the position of the gnome in the group preview window.

Rotation Section

This area contains the data cells for the X, Y, and Z rotation of the pivot point. Entering 
values in this field will update the orientation of the gnome in the group preview window.

Parental Offset Section

This area contains data cells for the X, Y, and Z parental offset values of the pivot point. 
The parental offset is the distance between the pivot point of the parent object, and the 
pivot point of the child object. Changing the values in the Parental Offset data cells 
changes the distance between the pivot point of the child and the pivot point of the par-
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ent, it does not change the position of the pivot point in relation to the object. Changing 
the parental offset value will cause an object to move closer too, or farther away from its 
parent.

The Inherit Tab

The inherit tab controls which transformations performed on the parent will be passed on 
to the child in a hierarchy. To enable an attribute check its box, to disable an attribute 
uncheck its box. 
 

Figure 220 — The Inherit Tab

By default rotation and position information are passed from the parent to the child. 
When a parent object is transformed or rotated, its child will be transformed or rotated 
accordingly. If the position and rotation checkboxes were unchecked, the child would not 
react at all to the parents movements.

The default preferences for the inherit options can be changed by opening the Import... 
options under the Edit menu. The Import Preferences dialog contains an identical set of 
attributes to the inherit palette. Checking attributes in the Import Preferences dialogue 
will make those settings the default for all newly created hierarchies.
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Figure 221 — The Import Options dialog

Inherit Position

This checkbox option, when enabled, links the position of the child group to the position 
of its parent group. When the parent is moved in X, Y, or Z space, the child will be moved 
with it.

Inherit Rotation

This checkbox option, when enabled, links the rotation of the child group to the rotation of 
its parent group. When the parent is rotated in X, Y, or Z space, the child will be rotated 
with it.

Inherit Scale

This checkbox option, when enabled, links the scale of the child group to the scale of its 
parent group. When the parent is scaled in X, Y, or Z space, the child will be scaled with it.

Inherit Visibility

This checkbox option, when enabled, links the visibility of the child to the visibility of the 
its parent. When the parent's visibility is off, the child's visibility will be off.

Inherit Deformation

This checkbox option, when enabled, will include the child with a deformation applied to 
the parent. The deformation region for the parent must be adjusted to include the child 
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object within the deformation region for this option to be effective. This is a very powerful 
feature that will allow you to deform an entire hierarchy as if it were one object.

The (Joint) Limits Tab

Joint limits allow you to set up your hierarchy chains to behave in a realistic manner, 
using a variety of natural forces and limited ranges of freedom. You can also create joint 
libraries to make the creation of complex hierarchy chains easier.
 

Figure 222 — The Limits Tab

The limits tab consists of the following items: 

• Load Joint Pop Up Menu
• Rotation Tab
• Stiffness Tab
• Viscosity Tab
• Position Tab
• Gravity Tab

Load Joint Pop Up Menu

This pull-down menu allows you to use, or remove, joints from a pre-defined joint library. 
Unlike the pre-defined choices in the Link Type menu, these joints can have pre-defined 
rotation and position limits in degrees of freedom.
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Figure 223 — The Load Joint menu with the New submenu exposed

This pull-down menu allows you to use, or remove, joints from a pre-defined joint library. 
Unlike the pre-defined choices in the Link Type menu, these joints can have pre-defined 
rotation and position limits in degrees of freedom.

Use

Loads a choice of pre-defined joint types in the currently open joint library. To create a 
new library choose Use > New.

Remove

Removes a pre-defined joint from a group.

Modify

Allows a pre-defined joint type to be replaced.

The Rotation Sub-Tab
 
The rotation sub tab allows joint rotation limits to be set for X, Y, and Z rotation. There are 
four items in the tab:

• Enable Limits Check box
• Minimum Section
• Center Section
• Maximum Section
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Figure 224 — The Rotation sub-tab

Minimum Section

This row of data cells contains values, in degrees, for the minimum angle a joint can 
rotate.

Center Section

This row of data cells contains the values, in degrees, for the angles at which the joint 
wants to be naturally positioned at rest. This value is used to help smooth the transition 
between the minimum and maximum rotation limits. Instead of rotating between the 
maximum and minimum, the joint motion curve will arc through the center limit first.

Maximum Section

This row of data cells contains values, in degrees, for the maximum amount a joint can 
rotate.

Use Current Value Arrows

Each data cell in the rotation limits sub-palette has a small arrow that, when clicked on, 
will bring up a Use current value box. Selecting this option will update the current rota-
tion value of the joint into the data cell. This allows rotation limits to be set interactively 
by rotating a joint with the rotate tools, and transferring the value of the rotation into a 
limits data cell. The group linkage window is non-modal, so you can easily jump back and 
forth between world view windows and the limits palette to make use of this feature.
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Figure 225 — The Use Current Value popup

ElectricImage is very smart when it comes to updating the maximum and minimum cells 
with current limits. It knows to put the highest value in the maximum box, and the small-
est value in the minimum box. This means you can click on the Maximum or Minimum 
use current value arrow and the proper values will be inserted where they belong. For 
instance, if you try to put a negative X value in the Maximum box, and a positive X value 
in the minimum box, ElectricImage will automatically “flip-flop” the two values so the 
positive value is in the Maximum box and the negative value is in the Minimum box.
 

Figure 226 — The Use Center of Limits popup

There is an additional current value choice in the drop-down menu for the center data 
cells called Use center of limits. Selecting this option will divide between the minimum 
and maximum limits and enter the result in the data cell. Note that in some cases the cen-
ter of limits may not be where you want the joint to be when it is at rest. In those cases 
manually rotate the joint into the resting position and select the “use current values” 
option.

The Stiffness Sub-Tab

The stiffness sub-tab can be used to control the amount of pull required to move a joint 
through its X, Y, and Z rotation. The higher the values in these fields the harder the pull 
required to move the joint. The end result is that joints with a smaller stiffness setting will 
move farther, faster, than joints with a high stiffness setting.
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Figure 227 — The Stiffness Sub-Tab

 An example would be a human leg. The thigh bone should move slower than the shin 
bone. Setting a higher stiffness for the thigh would mimic this motion.

The Enable checkbox, when checked, makes the stiffness settings active.

The Viscosity Sub-Tab

The viscosity sub-tab can be used to control the viscosity, or apparent friction, of a joints X, 
Y, and Z rotation. The higher the values in these fields, the more friction the joint will 
appear to experience as it rotates. Very high values will make the joint appear to catch and 
release as it rotates. Click the Enable box to activate viscosity.
 

Figure 228 — The Viscosity Sub-Tab

An example would be a rusty door hinge. The rust would cause more friction, and thus 
cause the joint to move in an un-smooth fashion. To recreate this you would apply a high 
amount of viscosity to the hinge joint.
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The Position Sub-Tab

The position sub-palette allows joint position limits to be set for the X, Y, and Z axes. These 
limits control how close, or far, a group can move from its parent. The enable limits check-
box, when checked, makes the position limits active.
 

Figure 229 — The Position Sub-Tab

There are two sections in the Position Sub-Tab:

• Minimum
• Maximum

Minimum

This row of data cells contains the minimum X, Y, and Z position values for the groups 
joint.

Maximum

This row of data cells contains the maximum X, Y, and Z position values for the groups 
joint.

Each data cell has a drop-down menu arrow that, when selected, will input the current 
position of the joint into the field.
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The Gravity Sub-Tab

The gravity sub-tab contains values for X, Y, and Z gravity settings for the joint. The set-
tings in these fields apply only to the joint they're set for, not the entire hierarchy. Local 
and Global gravity settings only affect how a group moves while the model is being trans-
lated in IK mode, it is not a physics simulation. Checking the Local box overrides global 
gravity settings for the joint. Normal gravity settings would be X=0, Z=0, and a - Y setting.

Figure 230 — The Gravity Sub-Tab

Working in the Group Linkage Window

Because the group linkage window offers a wide variety of tabs and input fields, it's help-
ful to develop a standard procedure when creating joints. Like any complex task, it's best 
to start with the basics and work your way to the specifics. A basic procedure might go 
something like this:

• Choose a pre-defined link type from the Link Type global pull-down menu.
• Select the X-Form Palette and choose a link alignment position for the pivot point. (If 

one applies)
• Interactively drag the gnome into position in the group preview window. Tweak the 

values in the X-form palette if needed.
• Set Joint rotation and position limits in the Rotation and Position sub-palettes.
• Test your joint to make sure it's working properly.
• Set Stiffness, Viscosity, and Gravity settings only if they're needed.
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Deformations

Introduction

Deformations allow you to bend, twist and otherwise distort groups in a variety of differ-
ent ways. A basic tool for 3D character animation, deformations will enable you to impart 
“life” into a character, “bend steel with your bare hands” (apologies to the Superguy!), 
and so on. ElectricImage 2.8 introduces two new types of deformations: a multi-point bez-
ier deformation, and hierarchical (skeletal) bones deformations, which you can use with 
inverse kinematics. When used in conjunction with morphing, all of these deformation 
tools provide everything you need to create fantastic character animation. 

In this chapter we'll discover just what a deformation is, how to use it, the differences 
between each deformation type offered in ElectricImage and some tips on their use.

What is a Deformation?

A deformation region allows you to squash, stretch, twist, bend, shear or wibble wobble 
any group (including its children) in any manner you see fit. You can have one deforma-
tion action on a group, or you can have many. Any deformation is animatable, which 
means you can make that can of tomato soup do the macarena if your heart desires. When 
you combine different animated deformations into one object, often times the flexibility 
offered is amazing.

Deformations in ElectricImage

In ElectricImage, deformations are applied to groups through the use of regions. A defor-
mation region is similar to a group’s cubic extent at first, but you can adjust the area of a 
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region to suit your needs. You can assign as many deformation regions as you like to a 
group. The reasons for doing so are up to you, and are typically done for either more pre-
cise control or data management (too many deformations in a single region can sometimes 
get a little complex to follow.)

Actual deformations are assign to a specific region. You can have as many deformations as 
you like in a region, and they can be of any supported type. The effect that a deformation 
will have on a group is dependent upon both the order of the deformations in the region’s 
deformation list, and the order of the actual regions in the region list. In both cases, the 
lists are processed top to bottom. You can think of this as a simple hierarchy.

For a complete technical discussion on deformations in ElectricImage, please refer to the 

ElectricImage Series 2 Reference Manual, chapter 16, “The Group Deformation Window.”

Using Deformations

In order to supplement the previous documentation on deformations, we have provided a 
sample ElectricImage project file, which you can find on the 2.8 CD ROM.

Find and open the file, called HotDogD4M.Project. You'll immediately notice a hot dog 
wearing a set of Groucho glasses. We're going to explore the use of deformations by mak-
ing this hot dog do things that no ordinary hot dog would stand for.

Figure 231 — the Hot Dog object
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To Apply a Deformation

1. Select the group, by either clicking on it in the world views or selecting its name in the 
Project window.

2. Open the Group Deformation Window. There are three ways you can do this:

• Select it from the Tools menu
• Click the small Deformations icon in the top row of the Project window.
• Click the Deformations icon in the Tool bar.

The Group Deformation window opens:

Figure 232 — Deformation window for the Hot Dog group

Now we will take a look at this dialog and break down its individual parts:

• Deformation Section
• Region/Deformation Section
• Region Section
• Show Region Buttons
ElectricImage 2.8 Supplement        331



Deformations — Using Deformations
Deformation Section

The deformation section consists of the type menu, the options button, the Angle/
Amount/Strength edit box, Along Axis and Deform Axis check boxes. This section is 
where you choose and control the deformation.
 

Figure 233 — Deformation section of the Deformation Window

Type

This pop-up menu contains all the different types of deformations available to you. This is 
where you select what kind of deformation you'd like to use. We'll discuss the different 
kinds of deformations later in the chapter.

Options

Clicking this button brings up options specific to the type of deformation selected. Each 
deformation type has different options available to it, so depending on what type of defor-
mation you've chosen with the Type pop-up, you will get a different dialog each time you 
select the Options button. We'll discuss the options for each type of deformation individu-
ally when we discuss each later in the chapter.

Strength% (or Scale or Angle)

This is where you enter the amount of deformation to be applied to the group. To animate 
a deformation, you simply change the value in this box over time, by either directly enter-
ing a number or by adjusting it via the rocker buttons to the right of the window. Another 
way to change this value is by directly manipulating the deformation region in the World 
views by clicking and dragging on the selected group. You will see the group update in 
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the world view windows as you drag. Just about any deformation available may be inter-
actively set this way.

One thing to note about this box is that its label will change, depending upon which type 
of deformation you chose. For Twist, Shear and Bend, it will change to Angle; for Scale, 
Taper or Bulge deformations, it will read Percentage; and for Stretch and Bezier deforma-
tions it will read Strength.

Along Axis

These three radial buttons determine what axis or axes the deformation is calculated 
along. Let’s use a bend deformation as an example.

Deform Axis

These check boxes determine what direction the deformation will occur towards. These 
check boxes are dependent upon what axis you chose to deform along in the Along Axis 
setting. If an axis is not available to a particular deformation type, the check box associ-
ated with that axis will be grayed out.

Using a bend deformation on the Hot Dog as an example, let’s look at how these two set-
tings work together.

Deformation Axis Examples

Deform X along Y 

If you choose to bend the hot dog along its Y axis (Along Axis setting is Y), note that the Y 
Deform Axis box is grayed out. That's because you're calculating along the Y axis and 
can't deform in the Y direction. 
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Figure 234 — Y axis deformation along the X axis

Keeping the axis along which the deformation takes place set to Y, a deform along the X 
axis will make the object bend to the left or to the right, depending on the value assigned 
to Angle. Looking at the front view window, positive X is to the right, and negative X is to 
the left. Because we have a bend angle of 45 degrees (positive,) the object bends to the 
right.

             

Figure 235 — 45˚ X Axis Bend Along Y
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Deform Z along Y 

If you choose to deform only the Z axis, you'll see that when you bend your hot dog it will 
bow forward or arc its back.

 

Figure 236 — Y axis deformation along the Z axis

This is because the deformation is moving the polygons toward either the positive or neg-
ative Z along the Z axis. Because we have a negative value for our Angle, the Hot Dog will 
bend towards negative Z, which is to the left when looking at the side view window.
             

Figure 237 — -45˚ Z Axis Bend Along Y
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Deform X and Z along Y 

If you choose to deform in both X and Z axes (both check boxes selected,) then the hot dog 
will appear to bend in all directions, like forward to the right, backward to the left, etc. 

Figure 238 — Y axis deformation along the X and Z axes

The illustration entitled “-45˚ X and Z Axis Bend Along Y” show the Hot Dog bending to 
the forward left. This is because our X deformation is causing it to bend to the left along 
the positive X axis, and our Z deformation is causing it to bend forward along the nega-
tive Z axis.

Figure 239 — -45˚ X and Z Axis Bend Along Y
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Show Regions

As mentioned previously, regions are the extents within which actual deformations are 
applied to the group. There are two types of region display options, Ghost Region and All 
Regions.

Figure 240 — The Show Regions check boxes

These two check boxes determine how the deformation region is displayed in the world 
view windows. 

Ghost Region creates a faded purple box delineating the original extents of the deforma-
tion region. No matter how much you deform an object, the Ghost Region will always 
retain the original shape of the deformation region to show you the original position of 
the region.

By checking the All Regions box you can show every region not currently selected in the 
Region list (located in the upper right of the Group Deformation Window) as a cyan col-
ored line. The difference with this cyan line vs. the faded purple line of the Ghost Region 
is that the cyan line of All Regions actually deforms the extent box of the region to show 
just how much that region has deformed.

Comparing the Ghost region to All Regions gives you an idea of how complex things are, 
and is a good way of finding problems and solving them. If you have 3 or 4 deformations 
and want to know how deformed any of the other regions are, simply check the All 
Regions box and every deformation region will show up as a cyan line, with any deforma-
tion effects applied to the cyan extents box. This is also extremely helpful when you have 
different regions in different parts of a group and don't want your regions to overlap. By 
checking All Regions you can be sure that your new regions don't overlap and acciden-
tally interfere with any previously placed regions.
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Region/Deformation Section

This section contains tools and lists for creating and managing regions and deformations. 
As mentioned previously, deformations are contained within a region that is assigned to a 
group. You can have as many regions as you like, and as many deformations within a 
region as you like.

Figure 241 — The Region/Deformation lists of the Deformation Window

This section covers the following items:

• Region List
• Deformation List
• The Trash Can
• The New buttons

The Region List

This is the area in which all your deformation regions are listed. They are order depen-
dent, processing from top to bottom. You may drag any region up or down in this list to 
change the sequence in which a deformation is applied. It is sometimes necessary to 
adjust the order of regions (and/or their deformations) for very complex multi-deforma-
tion effects.
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The Deformation List

This section lists all the different deformation types associated with a particular Region. 
You may change this setting via the Type pop-up menu. The currently selected deforma-
tion type for TheBend is Bend.

To Change the Deformation Type

1.Click on the Type pop-up window and change the deformation type for TheBend to a 
Scale deformation.

Figure 242 — The Deformation Type popup menu

Notice that the Deformation list has updated to show that you have changed the deforma-
tion type to Scale. You'll also note that the Angle box has changed its name to Scale%, 
which is the animatable value for a scale deformation.

Figure 243 — The Deformation window with TheBend region set to Scale
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2.Change the deformation type back to Bend.

The Trash Can

You can delete a region or deformation by dragging it’s name to the Trash Can icon. Once 
something is deleted in this fashion, the information applied to the disposed region is lost. 
Immediately invoking the Undo command (or typing  -Z) will restore the region and its 
information.

 

Figure 244 — The scale deformation dragged to the trash

The New Buttons

Under both the Region list and the Deformation list you will see a button labelled New. 
Clicking this button will creates a new region or deform, depending on which button is 
clicked. All new regions are created with Bend deformations by default.
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To Rename a Region or Deformation

Regions or Deformations can be easily renamed. Both are renamed in exactly the same 
manner. To illustrate this we will now rename TheBend to something else.

1. Double-click on TheBend region.
A dialog box appears.

Figure 245 — The change region name dialog box

2. Type in “Hot Dog Bend” as a new name for TheBend.
The Deform Region is now renamed.

Figure 246 — TheBend is renamed Hot Dog Bend

4. Change Hot Dog Bend back to TheBend.

To Add a Region or Deformation

1. Click the New button under the Region list and name the new region Twister.
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Figure 247 — The Twister group is created

Note that the default deformation type for the new Region is Bend. Since we already have 
a Bend, let's make this a Twist deformation. 

2. Make sure that the Twister region is highlighted in the Region list. Change the deforma-
tion region to Twist
 

Figure 248 — The Twister region deform is changed to Twist
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The Region Section

This section gives you precise numerical control over regions, and the space that they 
occupy. You can use the edit boxes to adjust the area of the region, or to limit the effective-
ness of a region.

Figure 249 — The Region section of the Deformation window

The Region Section contains four separate items, each containing a space for X, Y, and Z 
values:

• Position
• Rotation
• Minimum
• Maximum

Position

These edit boxes allow you to set the position of the deformation region relative to the 
group it is applied to. This setting may be adjusted by any of three methods:

• Direct entering of numeric values
• Direct manipulation in the world view windows
• By the up and down buttons located to the right of each value. 
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Figure 250 — The Position boxes

This setting is animatable over time. Each of the three coordinates is available, so the 
deformation region may be anywhere in world space. The default 0,0,0 positions the 
deformation region at the center point of the group it is applied to. All measurements are 
in ElectricImage world units, and are measured from the center point of the group being 
deformed.

Animating the Position of a Deformation Region

The ability to animate the position of the region is useful if you need a deformation to shift 
from one part of the group to another. Lets make our hot dog pass through a “distortion 
field.”

1. In the Region list, select the Twister region. In the Y Position box, type in a value of -10.

The Twist deformation has now shifted directly below the Hot Dog group.
344       ElectricImage 2.8 Supplement    



Deformations — Using Deformations
 

Figure 251 — The Twister region directly below the Hot Dog

2. Now we will create our “Distortion Field. Give the Twist deformation an angle of 90˚ 
along the Y axis. This will give the Twister region a 90˚ twist along the Y axis. 

Keep an eye on the Hot Dog as you make your change. While there is no change in the 
shape of the Hot Dog itself, notice that it has turned to its left. 

Figure 252 — The Twister region at 90˚, with the Hot Dog turned to the left
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3. In the areas titled Minimum and Maximum, click and activate the check boxes next to 
the Y value. The Hot Dog group is now oriented correctly. (Why this worked will be 
explained in detail later in the chapter.) 

 

Figure 253 — The Region section with the Y values checked

Your Side View window should look like the following:

Figure 254 — The correct Side view window

4. Open your Project window, and move the time thumb to 1 second.

5. In the Deformation window, enter a value of 10 into the Y Position field for the Twister 
region. A keyframe is created in the Project window for the Hot Dog group.

The region is now directly above the Hot Dog group.
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Figure 255 — The deform region above the Hot Dog Group

6. Again, it looks like nothing has happened to the Hot Dog. To see the effect of the steps 
we just performed, click the little camera icon in the bottom left of the Camera View win-
dow to preview the animation.

 

Figure 256 — The group is deformed as the region passes through it
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As the deformation region changes it's position up the Y axis it applies its deformation to 
the Hot Dog group.

Rotation

Figure 257 — The Rotation boxes

The Rotation section enables you to set the rotation value of a deformation region relative 
to the group to which it is applied to. This setting may be adjusted by any of three meth-
ods:

• Direct entering of numeric values
• Direct manipulation in the world view windows
• By the up and down buttons located next to each value. 

Like Position, this setting is animatable over time. Each of the three rotation axes is avail-
able, so the deformation region may be rotated at any angle. All rotations are measured in 
degrees. Rotating the group to which a deformation region is applied does not affect these 
rotation values; they are only affected by direct rotation of the region itself.

Rotating a Region with the Trackball

You can rotate a region for alignment or effect.

Let’s clear the previous work:

• Move the time thumb back to 0. 
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• Make sure that the Deformation window is open
• Drag the Twister Region to the trash to delete it

Your project should look like the illustration below:

Figure 258 — The Front View window
To rotate the region:

• Select TheBend from the Deformation list
• Press the Control key.
• A Green wireframe sphere will appear. Click and drag within the sphere to rotate

The circle, referred to as a trackball, will rotate, rotating the deformation region in turn.

Note that the Trackball only rotates upon whatever two axes are visible in the particular 
world view window. In the illustration “Region Trackball” below, the Front View window 
allows rotation to take place only upon the X and Y axes, as the Z axis is not directly visi-
ble. Also, as you rotate the Trackball, notice the X and Y values in the Rotation section 
update in real time.
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Figure 259 — Region Trackball

Animating a Region’s Rotation

The following exercise will show you how to animate the rotation values of a deformation 
region:
• Clear Rotation Values to 0.0
• Deform the X axis of TheBend along the Y axis using a value of 45˚
• Move the time thumb in the Project Window to 1 second
• In the Deformation Window, and enter the value 360 in the Y Rotation field. 
• Preview your animation

Watch the Bend deformation rotate over time to produce a twirling effect, making our Hot 
Dog look like he’s doing stretching exercises. 
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Figure 260 — The Hot Dog is animated

Rotation of regions also comes in handy when you want to bend an object in one direc-
tion, but when you apply the deformation it’s bending from the other direction.

Let’s say you wanted to bend our hot dog so that his bottom end moved instead of his top 
end, making him look like he’s kicking instead of bowing. The following steps will dem-
onstrate this technique to you:

• Clear Rotation Values to 0.0
• Rotate TheBend deformation region 180 degrees on the Z or X axis at time 0 (essen-

tially flipping it upside-down)
• Deform the X axis of TheBend along the Y axis using a value of 45˚ (as before)
• Preview your animation
ElectricImage 2.8 Supplement        351



Deformations — Using Deformations
Figure 261 — The deformation region rotated 180˚ on the X axis

The deformation is now applied to the opposite end of the group. The bottom of the Hot 
Dog now flips around in a circle, like it’s dancing.

Minimum & Maximum

Each region can have a limited range of effectiveness. The edit boxes in this section (along 
with their associated check boxes) will enable this control.

Figure 262 — The Minimum and Maximum boxes

The Minimum and Maximum boxes are for setting the size of the deformation region rela-
tive to the group they are applied to. The numbers that initially appear in these fields rep-
resent the extents size of the group the region is applied to. These setting may be adjusted 
by any of following methods:
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• Direct entering of numeric values
• By the up and down buttons located next to each value.
• Direct manipulation of the Boundary Knobs of the deformation region in the world 

view windows.

Boundary Knobs

The Boundary Knobs are the little black dots (circles) in the middle of each side of the 
deform region. In order to see them in the World View windows, Show Ghost Region 
must be checked and a Deformation Region must be selected in the Deformation window.

Figure 263 — The Boundary Knobs displayed

Notice the little black dots on the left, right, top, and bottom of the Deformation Region. 
These are the boundary knobs. 

Using the Boundary Knobs

To adjust the size of the deformation region using the Boundary Knobs, click and drag 
their dots interactively in one of the World View windows. This will adjust the size of the 
deformation region and will determine exactly where the region will deform the group. 
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By checking the check boxes next to these fields, you can limit the effect a deformation 
region has to only the polygons contained within the region.

If you like, refer back to the exercise on Animating the Position of a Deformation Region. 
Remember when we put the 90˚ rotation on the deform region and the Hot Dog group 
rotated 90˚ to the left, even though it wasn’t actually within the deform region? When we 
enabled the checkboxes next to the Y Minimum and Y Maximum fields, we limited the 
effect that the Deformation Region had on the geometry to the values contained in the 
checkboxes. In this instance, these values represented the Y extents of the Hot Dog group. 
As such, the deformation did not take place until the deform region actually entered the 
space occupied by the extents of the group.

Adjusting the Minimum and Maximum

The following exercise will demonstrate further the use of the Minimum and Maximum 
values.

• Activate the ghost region
• Set all region position and rotation values to 0.0
• Deform TheBend with an X axis Angle value of 0˚, along Y.
• Enter the value -1.4 in all the Minimum boxes and 1.9 in all the Maximum boxes

The region box changes size to reflect the new values entered.
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Figure 264 — Before and After the Minimum and Maximum values are applied

Bend the group to see the effects of limiting the effective range of the region:
• Select Bend in The Bend Region
• Enter an Angle value of 90˚
             

Figure 265 — The 90˚bend with the full region and the newly defined region

See how the Hot Dog now has a tighter bend with a smaller arc? Before we were calculat-
ing the bend along the whole length of the hot dog; now the bend only occurs within the 
area defined by the region.
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Let’s change the height of the Region along the Y axis:
• Select the top knob of the region
• Drag it upwards

The arc of the bend will change as you drag it The deformation itself is still 90, but the 
range of the bend is expanding along the Y axis as the region itself expands along the Y 
axis.

Figure 266 — The 90˚bend expands as the Y deform area increases

Let’s see what happens when we reset the limits on the region:
• Set your Y Maximum back to 1.9
• Enable the check boxes next to Y Minimum and Y Maximum.
356       ElectricImage 2.8 Supplement    



Deformations — Different Types
Figure 267 — The 90˚bend with Y Minimum and Maximum off and on

The hot dog is standing straight up except that the area directly within the bend region is 
all bent out of shape. What the check boxes did was tell the program not to include any 
polygons outside of the box to receive the effects of the bend.   While this doesn’t look so 
great in this example, you can easily see the difference that the Minimum and Maximum 
checkboxes make.

This feature is very useful if you need to have something deform in only in one part of a 
group while not affecting anything else in the group. This is extremely helpful for keeping 
different deformation regions from interfering with each other.

Types of Deformations

There are 12 different types of deformations in ElectricImage. They are:

• Scale
• Shear
• Twist
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• Taper
• Bend
• Bulge
• Linear Wave
• Circular Wave
• Stretch
• Bezier
• Bezier II
• Bones

Below you will find a description of each type of deformation and an example illustrating 
its use. To duplicate these examples make your Deform Window settings the same as 
those provided in the example, creating and deleting Deformation Regions as necessary.

Scale

This type of deformation affects the scale of the group. The amount of scaling applied is 
measure in percentage. You do not need to determine what axis the deform is along in the 
Along Axis area since Scale affects all axes selected in the Deform Axis check boxes. To 
designate the axis or axes along which the Scale will occur, click the appropriate check box 
in the Deform Axis area.

There are no options available for the Scale deformation type.

Below is an example of a scale deformation applied to the X and Z axes of the hot dog and 
limited with the Minimum and Maximum settings.
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Figure 268 — The Scale deformation 

Shear

This deformation will Shear (or offset) a group along an the axis defined in the Deform 
Axis check boxes. You may choose to shear a group along any axis by selecting that axis in 
the Along Axis area. 

Shearing can best be described as slanting an object in a particular direction. This slanting 
is more defined and uniform than the Bend deformation, resulting in a harsher effect than 
bending gives.

There are no options for the Shear deformation that can be accessed via the Options but-
ton.

Here is an example of a Shear deformation applied to the Hot Dog.
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Figure 269 — The Shear deformation set to 30˚

Twist

The Twist deformation allows, as its name would suggest, for the twisting of a group. 
Twisting can best be defined as rotation along a defined axis where one end of the defor-
mation region rotates clockwise and the opposite end rotates counterclockwise. The 
amount of deformation is determined by the degree value in the Angle box.

There are no option available for twist deformations.

Twists are generally set up to affect both axes that are not used to calculate the deforma-
tion. For example, if you calculate a twist along the Y axis, it can be used to deform either 
the X, the Z or both the X & Z axes. Experiment with setting Deform Axis to either one or 
the other remaining axes of a deformation to see the varying possible results. 

Note: Since our Hot Dog group is essentially a long, skinny, Y-oriented object, we will use 
another object to better illustrate the Twist deformation. Simply turn off visibility for the 
Hot Dog group and enable visibility for the Box group.
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Figure 270 — The Twist deformation

Taper

The Taper deformation allows a group to be tapered. Tapering can be described as reduc-
ing or increasing the dimensions of an object on one end of the deformation region. This 
dimension change can occur along one or two axes. The amount of tapering is determined 
by the value in the Percentage field.

If the value in the Percentage field is -100%, the group will Taper to a flat edge along 
whichever Deform Axis is not selected. The group will taper to a point if the Deform Axis 
check boxes indicate that two axes are selected.
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Figure 271 — -100% X axis Taper deformation

         

Figure 272 — -100% X and Y axis Taper deformation

If the value in the Percentage field is 100%, the group will double in size on the end of the 
deformation region effected.
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Figure 273 — 100% X and Y axis Taper deformation

Taper Options

The Taper deformation has a Fillet Taper option, which is accessible through the Options 
button in the Group Deformation window. The Fillet Taper option may be applied to 
either the beginning, the end or both ends of the region.

Figure 274 — The Taper options window

Filleting a taper causes a smooth transition between the taper deformation and the unaf-
fected polygons. This can be seen if the deformation region is reduced to be smaller than 
the size of the group as a whole. Without Fillet Taper enabled, the edges of the deforma-
tion region (where the deformation begins to effect the group,) will appear to have hard, 
clean edge. With Fillet Taper enabled this edge is rounded and has a softer transition from 
the area not deformed into the area being deformed.
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Figure 275 — Front view of a Taper with no Fillet options selected

Note the hard edges at the boundaries of the taper region. If this is objectionable, activat-
ing the “At Beginning” option can remedy this.

Figure 276 — Front view of a Taper with beginning Fillet options selected 

At Beginning causes the deformation to be blended into the surrounding polygons, 
changing the shape dramatically.
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Figure 277 — Front view of a Taper with beginning and ending Fillet options selected

With both the At Beginning and At End options selected, we see a smooth transition into 
the deformation at both ends.

Bend

The bend deformation is used to bend a group. The bend occurs along the axis set in the 
Along Axis check boxes and deforms in the direction as determined in the Deform Axis 
check boxes. The deformation amount corresponds with the value in the Angle field.

The bend deformation has a Bend from Center option available via the Options button.
 

Figure 278 — The Bend Options dialog
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Selecting this option changes the center radii of the bend arc from the edge of the defor-
mation group and places it at the midpoint of the deformation region.

If you apply the Bend from Center option to a Y axis bend deformation, both ends of the 
hot dog will bend away from center, rather than having one end “locked down” while the 
other bends away.

Front View of a 90 degree Bend deformation with Bend from Center disabled.
Note how only one end bends away from the group’s center line...
 

Figure 279 — Bend from Center Disabled (default setting)

Front View of a 90 degree Bend deformation with Bend from Center enabled. Note how 
both ends bend away from the group’s center line...
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Figure 280 — Bend from Center Enabled

If a Bend deformation is used in tandem with other types of deformations, and these dif-
ferent deformation regions overlap, it is best to place the bend deformation region last in 
the Region list, so as to apply the Bend deformation to the other deformations in the list. 
this will help to avoid some unwanted or unpredictable results that may occur if vertices 
that are to be deformed by another region if they are bent first.

Bulge

The bulge deformation allows a group to have it’s dimensions increased or decreased on 
two axes from the center of the Bulge deformation region. The amount of dimension 
deformation is correspondent to the Bulge% value. A positive Bulge% value will expand 
the groups dimensions away from the center of the bulge region, whereas a negative 
Bulge% value will draw the dimensions of the group inward toward the center of the 
bulge region.

If you set the Bulge% value to 75, our hot dog will look like a fat knockwurst. If you set the 
Bulge% value to -75, the hot dog will look more like a smoothly rounded hourglass. Bulge 
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deformation with a Bulge% value of 75. Notice how the vertices are “pushed out” from 
the center of the region.
 

Figure 281 — Bulge Out 75%

Bulge deformation with a Bulge% value of -75. See how the vertices are “pulled in” 
toward the center of the region.
 

Figure 282 — Bulge in, -75%
368       ElectricImage 2.8 Supplement    



Deformations — Bulge
The bulge deformation has a Filleted Bulge option available via the Options button. Simi-
lar to the Fillet Taper, the Filleted Bulge allows the edges of the deformation region to be 
made rounded, rather than the default hard edge when this option is disabled. Unlike the 
Fillet Taper, however, the Filleted Bulge has no setting for filleting the beginning or end of 
the region. this is because the Bulge deformation has no beginning nor end, but effects the 
group from the center of the region.
 

Figure 283 — Bulge Option Dialog

A Bulge region with Filleted Bulge option enabled. Note how the deformation eases in 
and is rounded.

Figure 284 — Filleted Bulge Option Enabled
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Linear Wave

The Linear Wave deformation deforms the vertices of the group along a sine wave that 
passes along the axis delineated in the Along Axis radial button settings. The crest and 
trough of the Linear Wave are deformed in the direction delineated in the Deform Axis 
check boxes. The degree of deformation corresponds to the setting in the Amplitude field. 
The higher the Amplitude, the more “wavy” the deformation. The lower the Amplitude, 
the less “wavy” the deformation. The Amplitude is a measurement of Electric Image 
units. If the Amplitude value is set to 1, then the linear wave crest deformation will offset 
the centerline of the Along Axis by 1 Electric Image unit in the direction of the Deform 
Axis setting. The example below is of a Linear Wave deformation calculated along the Y 
axis and deforming the X axis, to an amplitude value of 1. Note how the center point of 
the along axis (in this case, the Y axis) is offset by 1 Electric Image unit, as shown in the 
ruler ticks.

Figure 285 — Linear Wave Deformation

If you’re having difficulty understanding the Linear Wave, think of an ocean. The waves 
of an ocean are traveling along an axis. If the ocean is like any other body of water, the 
waves travel in a horizontal direction. This would mean they are Along the X axis (the 
horizontal axis). Now, the high part of an ocean wave is called it’s crest. The low part of a 
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wave is called it’s trough. The waves of an ocean go up and down as they travel horizon-
tally. This would mean that the ocean waves are deforming the water’s Y axis (hence the 
up and down of the wave). If the waves of an ocean traveled horizontally (along the X 
axis) but deformed side to side (deforming the Z axis instead of the Y axis,) then the waves 
of the ocean would wiggle like a snake instead of going up and down. If you want higher 
wave crests and lower wave troughs, you need to increase the Amplitude. 

The Linear Wave deformation has a Phase and a sin curve selector option available via the 
Options button. To choose a simple sine wave, select the radial button next to Sin. This is 
the default. To select a Cosine wave, select the radial button next to the 1- Cos. A cosine 
wave will have two crests to the sine wave’s one. 

The Phase option allows you to choose where along the sine wave you wish the deforma-
tion to start. Every sine wave has a phase value. The default value for the beginning of a 
wave is 0. As you travel along the length of the wave, the phase value increases or 
decreases, depending on the direction you travel. If you travel along a sine wave to the 
right, the phase value increases. If you travel along a sine wave to the left, the phase value 
decreases. Phase is the measurement of where you are along the length of the wave. If you 
need your Linear Wave deformation to begin it’s deformation at some point other than the 
0 point of the wave, you can change the value in the Phase field of the Options dialog. The 
line drawing of the curve will update to reflect the value you have entered. Look at the 
examples below to see the differences that can be achieved via a change in the Phase 
value. Note the curve feedback in the Options dialog, and how that variance affects the 
group deformation. This area is one where exploration and experimentation is best tried.

Figure 286 — Linear Wave Option Dialog
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Figure 287 — Phase set to 75

By animating the Phase value over time you can achieve interesting results, and with 
some work can animate convincing seaweed flowing in ocean currents, by adjusting noth-
ing more than the Phase value over time.

If you want more than the 2 waves given by the sin or cosine wave, you can adjust the 
Waves field value in the Options dialog to suit your tastes.

Circular Wave
 
This deformation type allows you to create waves or ripples similar to those found when a 
stone is thrown into a pond. The waves move outward from the center of the region in a 
circular pattern. The amplitude (e.g.: crest and trough) of the wave move along the 
Deform Axis, as set in the Deform Axis check boxes. The height of the wave, or intensity of 
amplitude, are determined by the actual height of the circular wave deformation region in 
the axis determined as the Along Axis. Below is an example of how the region height 
affects the wave height...
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Figure 288 — Wave Height is Dependent upon Height of Deformation Region
 

Figure 289 — Camera View with same settings as previous figure

In other words, if your Deform Axis is X, the waves will move outward horizontally. If the 
Deform Axis is set to Z, the same will occur, since these waves are circular and move in all 
directions on these two axes. If your Along Axis is Y, the waves will act like ocean waves/
pond ripples and will have the appearance of having height. To adjust this height, adjust 
the actual height of the deformation region. To do this, show Ghost Region, grab the 
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boundary Knob on the top of the region and drag it either up or down to suit your desire 
for wave height. Here is a close up of the deformation region and the Knobs you’ll need to 
adjust. Note the relation between wave height and the height of the deformation region.... 
 

Figure 290 — Close-up of Circular Wave Region

To determine how much of the group is influenced by the circular wave’s deformation 
region, you may change the value in the Outer Radius field. The Outer Radius is a mea-
surement of percentage of coverage. A setting of 100 will allow 100% of the region to influ-
ence the group. A setting of 50 will only allow half of the region to influence the groups 
deformation. This setting may be animatable over time to produce a rippling effect. An 
object may start with an Outer Radius of 0, which will not allow any of the region to 
deform the group. By setting the Outer Radius to 100 at a later time, the impression of a 
stone being thrown into a still pond may be achieved, with expanding concentric waves 
resulting. 

The circular wave deformation has a number of Rings option available via the Options 
button. To increase the number of waves, simply change the value in this dialog. This 
value may be animated over time to produce expanding rings effects. 
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Figure 291 — Circular Wave Options Dialog

You may also combine several Circular Wave deformation regions to achieve even more 
interesting wave effects. For the random wave pattern found in a pool on a breezy day, 
you may add a number of regions of varying size, outer diameter and wave height set-
tings. Also, rain drops falling onto a puddle may be achieved by adding many smaller 
regions to the puddle group, and animating the regions outer diameter, as well as it’s 
wave height to give the impression of small, short rippling effects common to rain drops. 
Combined with proper water material properties, this effect can be stunning. Here is an 
example of how combining several Circular Wave deformation groups can be applied...
 

Figure 292 — Multiple Circular Wave Deforms
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Stretch

The stretch deformation allows you to grab a region of vertices and pull, move, rotate or 
scale them in any direction while remaining attached to the remaining unselected vertices 
of the group outside of the stretch region. The Stretch deformation is best used when the 
deformation region is smaller than the entire group. If the entire group lies within the 
region of the Stretch deformation, nothing will appear to happen when the Stretch region 
is moved, rotated, etc. except that the whole group moves. To grab this section of vertices, 
you must “capture” them. To capture the vertices for deformation, you must access the 
Capture Vertexes button via the Options button. When your region of desired deforma-
tion is set, you must click the Capture Vertexes button to enable deforming the object. 

Think of your group as a piece of taffy. Now, holding this taffy in your hand, grab one end 
of it with your fingers. Now, pull that section away from the rest of the taffy glob. It 
remains attached, but deformed. It is stretched. This is basically how the stretch deforma-
tion works. You define how much “taffy” (e.g.: vertices) your grab by the size of the defor-
mation region. You close your fingers around the taffy you wish to pull by capturing the 
vertices (e.g.: Capture Vertexes) and you pull by moving the deformation region with 
your mouse, or by entering values in the position or rotation fields.

The best way to understand the Stretch deformation is to see it in action. Follow this 
example:

• Add a new region to the list
• Choose the Stretch Deformation type
• Activate the Ghost Region
• Use the boundary knobs to the bottom of the group only
• Choose the Options button
• Select the Capture Vertexes button (this tells the computer that you ware ready to start 

pulling this group into or out of shape.)
• Grab the region with your mouse and pull it as you see fit. 
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You may also rotate the region via the Rotation values for the region as found in the 
Group Deformation window

Figure 293 — Stretch Deformation

If the stretching seems too harsh or edgy, you may adjust the Blend Factor in the Options 
dialog. Increasing the Blend Factor reduces the harshness of the stretching. A higher Blend 
Factor will allow the stretch region to affect a wider area of vertices outside of the actual 
stretch deformation region. 
 

Stretch with Blend Factor at 5
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You may limit the stretching to affect only vertices along the X, Y or Z axes. This means 
that if you only enable the X axis, that no matter how hard you try to move the region on 
the Y axis, the region will not be allowed to move in that direction until you enable the Y 
axis in the Deform Axis check boxes. You’ll also note that the Along Axis radial buttons 
are disabled. This is because the Stretch deformation doesn’t calculate along an axis, but is 
determined by the size of the region of captured vertices, as well as the Blend Factor, 
regardless of axis. You may also pre-define your stretch region’s position and animate it’s 
Strength% over time to slowly deform your group without having to set keyframes for the 
position or rotation of the stretch region. Only adjust the Strength% over time. The result 
is similar to that of a magnet pulling the vertices out of shape over time.

Bezier 

One of the most powerful tools for character animation within Electric Image is the Bezier 
deformation. A Bezier deformation allows for a very fluid deformation of the group by it’s 
Along Axis and in the direction as determined by the Deform Axis check boxes. The main 
controls for the bezier deformation are its control arms and anchor points. The control 
arms behave in a manner very similar to bones, but have some pronounced differences 
from bones. Think of the control arms as puppeteering rods built inside of the group. By 
moving the pupeteering rods, you change the shape of the group. The control arms 
appear as indigo colored lines that run along the length of the Bezier region as defined in 
the Along Axis radial buttons. The control arms may be animated to produce the effect of 
bending, twisting, stretching, squashing and arcing the group as influenced by the control 
arm. The deformation occurs along the axis that the control arms are parallel to. To define 
which axis the control arms are parallel to, set this axis in the Along Axis radial buttons. 
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Figure 294 — Along Axis set to Y
 

Figure 295 — Along Axis set to the X
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Figure 296 — Along Axis set to the Z

You will note that the boundary knobs of the Bezier region are concealed where the Con-
trol points of the control arms rest on the regions boundaries. To get at these boundary 
knobs, switch the Along Axis setting to a different axis to reveal the Knobs. Adjust them to 
your liking and then reset the Along Axis to the axis you desire to deform along.

Each control arm has three controlling points on it. The Anchor point, the Control point 
and the Spin point. All three points may be animated separately by grabbing them and 
moving them with the mouse, or they may be moved as a group by grabbing the control 
arm itself and moving it. Grabbing the control arm itself and moving the Anchor, Control 
and Spin points all at once produces a result similar to that of the Stretch deformation.

The Anchor point is the black dot at the base of a control arm that is closest to the center of 
the deformation region. This is the center of rotation for the entire control arm. When the 
control arm is moved, it seems to pivot and rotate around this point.

The Control point is the black dot at the very end of the control arm and is located at the 
boundary of the Bezier region. To move the control arm but not affect the Anchor point, 
grab and move the Control point. This will deform the vertices as influenced within the 
region. 
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The Spin point is the point attached to a small spur control arm that emerges from the 
Control point and is perpendicular to the Control arm. The Spin point allows you to spin 
the top of the Bezier region for twisting the group. The center of rotation for the Spin point 
is the Control point, where the center of rotation for the Control point is the Anchor point. 
The Anchor point has no center of rotation and cannot be rotated. The Anchor point may 
be moved. Moving the Anchor point effects the rest of the control arm’s effects of defor-
mation. 
 

Figure 297 — Moving the Control Point

Moving the Control point only causes the group to deform along the curve produced 
between the two points. (Note that the curve is not actually drawn.) You can drag the con-
trol point to any position, as with any bezier spline.
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Figure 298 — Moving the Anchor Point

Moving the Anchor point is equivalent to changing the endpoints of the bezier spline. 
This is useful for making a character lead or “telegraph” the intended direction of travel 
(or perhaps for making a great Axl Rose impersonation!)

Figure 299 — Moving the Spin Point

Moving the spin point will twist the group along the spline direction, with the majority of 
the twist occurring at the location of the spin point.
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Figure 300 — Spin Rotation from the Side

The figure above shows the spin from another direction. Again, notice how the twist effect 
is more pronounced around the spin control point.
 

Figure 301 — Dragging the Control Arm

You can also just drag the entire control arm, which will offset the endpoint, keeping the 
trajectory of the control arm intact. In the example above, the shape is starting to deform 
back to it’s original orientation.
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Figure 302 — Bending and Twisting a Bezier

Bezier deformations, used in tandem with each other, can produce powerfully flexible 
deformations. One can animate the fingers of a hand with a combination of Bezier defor-
mation regions. One important tip to keep in mind when combining more than one Bezier 
region on a group is to limit the influence of the region’s deformation. This is done via the 
check boxes next to the Maximum and Minimum fields in the lower right of the Group 
Deformation window.

Figure 303 — Limited Bezier Region and it’s effects
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Like any deformation, you can have multiple bezier deformations on a group. When 
doing so, it is best to assign a new region, so you can change the focus area of the bezier 
effect, as shown in the illustration, “Limited Bezier Region and it’s effects” on page 384.

The hot dog has two bezier regions on it. You’ll note that when the lowermost Control 
point of the upper region is moved, it moves the whole bottom of the group. This may or 
may not be desirable.

You can limit the influence of that region by checking it’s Y Minimum limit box, and thus 
limit the influence of this region to only those vertices with a Y position value greater than 
the Minimum Y as set in the field.

Figure 304 — Limited Region Bezier Deformations

Now the lower bezier region’s upper Control point is moved. Note the very unpleasant 
deformation results (illustration on page 386). This looks pretty ugly. That’s because the 
upper deformation region has already had it’s deforming effects applied. By deforming 
the lower region, we magnify, or multiply in combination that effect, so that what we see 
is the result of the two regions affecting the same vertices twice.
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Figure 305 — Problem associated with limiting Y Minimum

This can be corrected by limiting this region’s Y Maximum influence. Do this by checking 
the check box next to the Y Maximum field in the Group Deformation window.
 
Observe how the deformations Maximum Y influence is constrained to those vertices 
within the actual Bezier region itself in the following illustration. The undesirable kink 
can be removed by insuring the regions are close but not overlapping. 

Figure 306 — Not Perfect, but Getting There (Min and Max limited)
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If you need to have greater control over the location of your Anchor, Control or Spin 
points, you may obtain their location, relative to the group’s object space, by clicking the 
Options button. In the dialog you will see fields for entering numeric values to adjust the 
positions of these points. This dialog is especially helpful for duplicating point positions. 
If you need to return an Anchor, Control or Spin point to a previously keyframed position, 
you can obtain that location information in this Options window for later reference. Also 
in the Options dialog you will note a Reset Points button. Clicking this button will reset all 
the Anchor, Control and Spin points to their default position relative to the deformation 
region. This is helpful if your deformation gets out of hand or you need to return to the 
default position after animating a deformation.

Figure 307 — Bezier Options Dialog

Also within the Options dialog you will see a check box marked Curve Continuity. This is 
useful for overriding the default results of the Bezier deformation. By default, when a 
group is deformed using a Bezier deformation, pinching is minimized. However, you may 
have undesired results because the continuity, or the continuing, of the curve of the 
group’s vertices as they cross the bezier region boundaries may not be smooth. 
The illustration “Bezier example without continuity applied”is an indication that the 
Curve Continuity option for a Bezier region is necessary. 
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The hot dog is not maintaining it’s volume as it deforms, violating one of the primary 
laws of squash and stretch, a common cartoon technique. To remedy this, activate the 
Curve Continuity option in the dialog.

Figure 308 — Bezier example without continuity applied

Similar to the Stretch deformation, you may preset the amount of bezier deformation and 
simply animate it’s Strength% over time to give a very complex magnet effect.

Bezier II
 
Bezier II is a new deformation type added to Electric Image for version 2.8. This deforma-
tion type behaves in every way similar to the Bezier deformation, but allows greater flexi-
bility in the ability to add extra control arms on the interior of the deformation region. Up 
to four control arms may be had with a Bezier II deformation type. The Bezier II deforma-
tion deforms exactly the way a Bezier deformation does relative to the Deform Axis and 
Along Axis settings. 

In the following illustration, note how the control arms are arranged within the bound-
aries of the Bezier II region.
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Figure 309 — Bezier II default condition

To determine the number of control arms a Bezier II deformation may have, you must 
access the control arm dialog via the Options button. You may also turn off the visibility of 
the Anchor, Control and Spin points of each of the control arms. In the Options dialog you 
may also select what type of curve you wish to use. By clicking the left curve type, it is 
similar to selecting a non-continuous curve. By selecting the right curve type it is similar 
to selecting a Continuous curve in bezier deformations. The text below the curve types 
will update to give information about the choice of curve you have made. Also, the Bezier 
II Options dialog has a Reset Curve button. This behaves in a similar way to the Reset 
Points button in the Bezier deformation options dialog. This will set all the Anchor, Con-
trol & Spin points for all control arms to their default position.

Figure 310 — Bezier II Options Dialog
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Like the Bezier deformation you may move any or all of the Anchor, Control or Spin 
points of each control arm. Again, either by individually selecting and moving each point 
or by grabbing the control arm as a whole. Since we covered how the end control arms 
work within the section discussing the Bezier deformation, let us take a closer look at the 
interior control arms of the Bezier II deformation.

The interior control arms acts more as “rockers”, while the end most control arms behave 
like puppeteering rods similar to the way they behave in the Bezier deformation type. The 
interior control arms each have two Control points to their one Anchor point. This allows 
them to “rock” back and forth, with their center of rotation being the center Anchor point 
of the control arm.

Note in this illustration how this combination of “rocking” the interior control arms can 
produce a complex “wavy effect.”

Figure 311 — Tilted Control Arms

In the following illustration, observe how you can move the Anchor and Control points 
for each interior control arm by dragging the Anchor points. The relation of the Control 
and Anchor points to one another remains the same, however the relation of the interior 
control arms to the group changes. This technique is very powerful for complex muscle 
movements and internal shape distortions commonly found in character animation.
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Figure 312 — Offset Control Arms

By combining moving the Anchor points and adjusting the Control points for each inte-
rior control arm, you can achieve very complex deformation effects.

Figure 313 — Hoo, Baby, I Like it Like That!

Again, as with regular Bezier deformations, you may use a series of Bezier II deformations 
in tandem on a single group to achieve even more complex deformations. Remember to 
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use the limit influence check boxes next to the Minimum and Maximum fields to keep 
these multiple regions under control. However, there comes a point of diminishing control 
with multiple Bezier II deformation regions.

Example of a multiple Bezier II deformation region combo. The more you add, the more 
difficult it becomes to get predictable results using Bezier II deformations.

Figure 314 — Now things are getting a little out of hand

Bones

Bones are used to perform “free-form” deformations, with fewer limitations than the 
other deformation types. Bones can be linked together to form a deformation chain, 
imparting an incredible amount of control over a group. With bones, you can deform “sin-
gle skin” objects such as characters or animals as if there were being moved by their own 
skeletal system (in fact, they are!) You can even use bones to create “morph targets” for 
facial expression morphing. In all, bones are quite handy.

Bones can also be a bit picky. Bones act like little magnets, pushing and pulling on groups, 
sometimes destroying them if used with wild abandon. Deforming a group with bones 
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almost always means there will be more than one bone parented to a group. That means 
that they will compete with each other, unless you limit their ranges of influence.

Prepping the Model

Like any other deformation, bones require a model that is properly meshed in order to 
provide the best results. You can use the Dicer plug-in to mesh the model if necessary.

Figure 315 — Low Resolution and high Resolution Models with Bones

The Dicer plug-in will regenerate the model quite often. Since it is unlikely that you will 

want to change the resolution of the model over time (the reason why Dicer regenerates) it 

is best to save the model as a new file once you have the proper resolution.

You can use low resolution proxies to speed up the interaction process when working 
with bones. Just make sure that the low resolution model is volumetrically similar to the 
final target model. You can parent both models to a null effector, with the same cubic 
extent as the models, and then make the working model or final model visible.

Adding Bones

There are two ways to add bones to your project:
• From the File Menu (File>Add>Type>Bones)
• From the Object Palette (Bones Icon)
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Bones are added as a chain until you stop the process by choosing command-period. The 
length of the bone is dictated by the distance between each mouse click. In effect, you can 
actually draw the skeleton on top of the desired model in the world views.

A typical skeleton is comprised of several link chains. The main chain would be the body, 

including the spine and neck. The extremities would each be a separate chain. When repro-

ducing a bones chain, it is best to create each extremity as a separate chain, and then cre-

ate the final hierarchy with the parenting tools available in the Project Window. This 

will enable you to maximize bone usage with inverse kinematics.

Associating Bones to a Group

In order for bones to affect the shape of a group, three steps must first be undertaken. Like 
other types of deformations in this chapter, bones must be attached to a deformation 
region. See the section “Creating Deformation Regions.” It is a good idea to create a 
unique deformation region for bones, to separate them from other deformations. This is 
necessary because bones can exist in only one region per group, and that region needs to 
cover the entire extent of the group in a default position. 

Remember that regions are order sensitive, and you might want to have the Region con-
taining the bones deformation be at the top of the list. Either before or after you create a 
deformation region for the bones chain

Before you parent a bones chain to a group, you must first set up the chain so that the link-
ages of each bone provide the appropriate type of constrained motion. (See the chapter 

entitled “Group Linkage Window” for more information on configuring and constraining 

joints.) 
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To associate bones with a group:

• Make sure that the previous recommendations have been followed
• Select the first bone in the chain from the project window
• Click on the Parent tool icon in the project window
• Select the group name in the project window that you want to deform with bones

Assuming that all of the steps have been followed, the bone chain is now attached to the 
desired group.

Moving the Bones Around

Now that you have created a bones chain, deformation region, set up the joint constraints, 
and parented the bones to a group, you are ready to test your work. You can use either for-
ward or inverse kinematics to move a bone chain. Each produces a different result. (For 

more information on Forward and Inverse Kinematics, see the chapter entitled, “Using 

Effectors.”) 

As you move the bones chain and interact with it, you will likely decide to adjust the val-
ues and parameters of the bones for the effect that you want to achieve. To do this, you 
must configure each bone separately through the Bone Info Window. 

To access the Bone Info Window:

• Select the bone 
• Double click or choose File>Get Info…

The Bone Info Window will appear.
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Bone Info Window

The Bone Info Window contains a series of buttons and tabs for configuring the bone, and 
animating it. As a bone is an effector in ElectricImage, in addition to a deformation type, 
we will only cover the controls which are related to bones deformations in this chapter. 
For an explanation of the other controls, see the chapter “Using Effectors.”

Figure 316 — Bone Info Window

This chapter will cover the controls in the two tabbed sections:
• Bones X-Form Tab
• Bones Special Tab

Bones X-Form Tab

This tab contains the transformation information for a bone. The information in this tab is 
equivalent for the other effector types, and is covered in detail in the Using Effector chap-
ter.
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Figure 317 — Bones X-Form Tab

Bones Special Tab

This tab contains controls for adjusting and setting bones characteristics.

Figure 318 — Bones Special Tab

The tab is divided into four sections:

• General Section
• Range Section
• Rotation Bias Section
• Strength Section
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General Section

This section contains the active check box, which determines whether or not the bones 
effects will be applied to the group, and the bone length edit box. Bone length is set at the 
time that you create the bone, but you are free to edit the length of the bone at any time 
with this control. Bone length is a factor in the strength of the bone.

Range Section

The range section contains four items which control the effective range of the bone, and 
how its energy will be applied to the group through the bone:

• Limited Range Check Box
• Minimum Range Edit Box
• Maximum Range Edit Box
• Fall Off Popup Menu

Limited Range Check Box

This check box activates the bone’s ability to limit its influence. The numbers in the Mini-
mum and Maximum range edit boxes are used when this feature is active. If this feature is 
not active, the bone’s effective influence will apply throughout the deformation region for 
the bone, on the group to which the bone is attached.

When this option is active, the actual range of the bone will be drawn in the world view 
windows around the bone itself. The minimum value will not be drawn if it’s value is 0.0, 
otherwise it will be drawn in dashed lines. The maximum value will be drawn (if it’s 
value is not 0.0) in unbroken lines.

Minimum Range Edit Box

This edit box specifies the minimum area of effectiveness for the bone. A value of 0.0 (the 
default value) will begin to dissipate the energy of the bone immediately, until the maxi-
mum range value is encountered, using the method specified in the Falloff menu. 
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Minimum values can be greater than zero. In this instance, the strength of the effect is 
applied from the center of the bone until it encounters this boundary, at which point the 
energy will begin to fall off as specified in the Falloff menu.

If you encounter a severe amount of distortion on your model, try setting the minimum 
value to be larger than 0.0. Combined with the Maximum range value, you can get very 
precise control over the deformation area.

Maximum Range Edit Box

The edit box specifies the maximum are of influence for the bone. Any part of the group 
which falls outside of this area will not be directly effected by the bone. This option is 
valid only when the limited strength check box for the bone is active.

Falloff Menu

The falloff menu determines the energy transition from the Minimum to the Maximum 
range of the bone. The following methods are available:

• Ease
• Linear
• Power (of) 2
• Power (of) 4
• Power (of) 8
• Power (of) 16

Each of these methods affect the visual quality of the transition. Ease is typically the best 
method, and the default. You may wish to experiment with the other methods as well to 
suit your taste.

Rotation Bias Section

Bones have a default direction of influence, which can cause problems for certain types of 
data, such as motion capture data. This type of data is typically not “indexed” with any 
accuracy. That is to say, there is no rational frame of reference to begin mapping the 
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motion capture data, as it is typically stored as a series of offset values. This section 
enables you to “reconfigure” the bone to more closely match the first frame of data in the 
capture file.

The edit boxes are used to “zero out” the bone. Position the bone to the desired beginning 
position and click the Set Bias button to do so.

Strength Section

Bones have the strongest effect on points closest to them, or those within the bones limited 
range (assuming that option is active.) You may wish to add bones which counteract the 
effect of other bones for more precise mesh control. Typically, these bones would not be 
independently animated, as their intended function would be to suppress unwanted dis-
tortions from becoming pronounced.
Overlapping areas of bone influence can produce points which are under the control of 
more than one bone. When that occurs, the strength of each bone will have an effect as 
well. Sometimes this will be of use to you, such as the case mentioned in the paragraph 
above. At other times, it might be a hindrance. This can be avoided to a degree by limiting 
the bones area of influence.

As bones can be set to different strengths, the bone with the higher strength value will 
exert more influence over points than bones with lower values. All of the bones affecting 
the points will exert some influence, however. Bones with equal strengths will tend to can-
cel each other out if pulling in opposing directions.

The Strength by Length check box will use the length of the bone to calculate its influence 
over the group. The strength edit box is used to set a direct amount of strength for the 
bone, taking all of the bones contained within the chain into consideration for the overall 
effect on a group. Bones with strengths that are greater than their neighbors will exert 
more influence, however the neighbors will still have some “pull,” so to speak.
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Tips On Using Deformations

Performance is affect by the Amount of Colors Displayed

It is a good idea to keep the bit depth settings of your monitor at 256 colors when working 
within ElectricImage, as it is optimized for this monitors setting.

Use Deformation Scale only if Deforming a Group

Do not scale the group or it’s children via the Group Info window. Scaling groups before 
applying deformations is just asking for trouble, especially if your are deforming a group 
and it’s linked children. The greater the variance from the default scale of the parent (e.g.: 
x1.0, y1.0, z1.0), the greater the distortion of deformed linked children. If you need to scale 
a parent and children group before adding a deformation, then use a Scale deformation. 
Make sure the Scale deformation is the first region listed in the Region list in the Group 
Deformation window. This will allow Electric Image to apply the Scale deformation first 
to the group and it’s children, followed by any other deformations. One drawback to this 
is that if you need to Scale deform your group and children by a large amount, it becomes 
difficult to see the actual Scale region in the world views. The Scale region remains the size 
of the group before it was scaled, while as the group is scaled, it becomes larger or smaller. 
Note in the example below how the Ghost Region of the Scale deformation stays the same 
size, while the group itself, scaled by 100%, grows larger. In this example, this is fine, but 
try scaling a group by 1000% and you can see why you may not want this.

Turn Off inherit Deformation or Child Groups will Deform too

If you want to deform an object, but simply want it’s linked children to move along with 
the faces, not actually be distorted themselves, then make sure the linked children have 
Inherit Deformation disabled in their Group Link window. This is the best setting for hav-
ing hands follow a body, or in the case of our hot dog, having the glasses follow the 
deforming hot dog without getting all twisted up themselves.
ElectricImage 2.8 Supplement        401



Deformations — Bones
On the Other Hand, That May Be What You Want

If you desire the children of a group to deform in a similar manner as its parent, then 
make sure the Inherit Deformations option is enabled in the children’s Group Link win-
dow. This is most useful for eyelids that deform along the eye as they blink, or for clothes 
that you wish to squash and stretch with a character as they bend or move. This way the 
children objects will not intersect with the parent as it deforms.

Make Sure Your Models Are Meshed

Groups that don’t seem to deform very well may need to have their mesh density 
increased. Deformations will only move polygons as a whole. Deformations cannot bend 
a polygon itself. So if your deformation seems “choppy” or doesn’t seem to bend 
smoothly, try increasing the polygon density of the deforming group. You can either do 
this by adjusting this in the modeler, or by parenting the group to be deformed to a Dicer! 
object. The best way to handle parenting to a Dicer! is to add the Dicer! object 
(File>Add>Socket>Dicer!), to the project, then link the group to it. Then export the Dicer! 
object with the group linked to it as a fact. Re-import the Dicer! object into the project. Dis-
card the linked group and rename the Dicer! in the Project window to the name of the 
group. What this does is forces Electric Image to recognize the Dicer! group as having 
more polygons. This is helpful when it comes time to render because at render time all 
Dicer! objects need to be recalculated for each frame. But a high density mesh is just read 
like any other model.

Rotations Can Get Tricky

If you need a group to rotate, but don’t want the deformation to rotate with it, then 
counter rotate the deformation. Look at the SewerSnake.Project on the Electric Image CD-
ROM. Note how the bend deformation region doesn't go twirling around at the bottom of 
the sewer snake as it rotates? This is because the rotation of the sewer snake is offset by a 
similar counter rotation of the deformation region. This gives the appearance of the defor-
mation region not moving, when in fact it is actually rotating -1 degree for every degree of 
rotation of the group it deforms.
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Camera View of SewerSnake.Project illustrating counter rotation of deformation regions. 
The head of the sewer snake rotates along with the other parts of the sewer snake as it 
rotates on its Y axis.

 

Figure 319 — Counter Rotation of Regions will Compensate Strange Results

Multiple Groups can give More Control

You can use a combination of groups to achieve even more complex animated deforma-
tion effects by applying the deformation of one group to another as it passes through the 
first group. Look at the SewerSnake-2.Project on the Electric Image CD-ROM. The parent 
Standard Shape, a cylinder, has a 90 degree Bend deformation applied to it. The child, the 
sewer snake, has Inherit Deformation enabled in its Group Link window. As the sewer 
snake is animated to intersect with the parent cylinder, it inherits the 90 degree bend that 
its parent has. This technique is very useful for showing complex organic mechanisms in 
action.

Camera View of SewerSnake-2.Project illustrating inherited deformations to achieve com-
plex animated deformation effects.
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Figure 320 — Child Group Passes through Parent Region
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Facial Animation

Introduction to the Morph Window

One of the most powerful features for character animation is morphing. There are effec-
tively two types of morphing techniques — simple target morphing and weighted target 
morphing. ElectricImage 2.8 offers the weighted target method, as it is superior for facial 
animation. For simple target morphing, try the shareware Keymorph plug-in. This chapter 
will concentrate on using the Morph Window for Facial Animation.

Morphing creates in-between models from a source model and one or more target models. 
The source model is typically a “neutral” version of the model, and the target models are 
versions of the model in various poses or expressions. In simple target morphing, the 
models may not even need to depict the same object. A plate could morph into an apple, 
for example.

Morphing requires that models contain the same number of points and polygons, and that 
they are stored in the same order. For example, the polygons which make up a nose for the 
source model must directly map to the polygons which make up the nose in the target 
model. If these polygons do not correspond, very strange results will occur. 

The Morph Window is just one part of the character animation equation. In addition, 
bones, effectors, and inverse kinematics round out the tools that are typically used to cre-
ate great character animation.

Creating Models for Morphing

It is best to start of with the source model, and use it to create your target poses. There are 
a variety of ways to create both the source and target models, depending upon the model-
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ing software that you choose to use. You can even use the bones feature in ElectricImage 
to create target models from your source model.

To create the new poses or expressions that you need, you drag the points of the polygons 
to create the new shape. This can be a tedious and laborious process, but when done well, 
the results are worth every second. 3D author George Maestri has written a very through 
treatise on character animation, which includes a variety of illustrations that are typically 
used for facial morphing. Published by New Riders, it’s called, “Digital Character Anima-
tion,” and it’s ISBN number is 1-56205-559-3. It retails for approximately $55.00 — not 
cheap, but it will save you an incredible amount of time and effort!

Using the Morph Window in ElectricImage

Once you have created the necessary target models, its then time to load the models into 
ElectricImage so that they can be morphed. Morph model targets are not added into an 
ElectricImage project as other models are. Instead, they are added through the Morph 
tool. All models in the project, whether or not they are used for morphing, are listed in the 
project window, above the group list (in the default project window display). Let’s load a 
model and have a look around the Morph Window.

To add a morph source model into ElectricImage:

• Add the source or anchor model to the project as a normal object file .
• Be sure that the animate checkbox (see the Project Window chapter) is on for both the 

model and the group.
• Select the source model.
• Click on the Morph button in the Project Window. 

The following window will appear.
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Figure 321 — Morph Window with targets

The name of the source model will appear in the Morph Anchor section, to the top left. 
The model that will be morphed is drawn in the view area to the right of the window. The 
Morph Window is divided into sections:

• Morph Anchor
• Target Match Popup Menu
• Reload Target Data Button
• Morph Group
• Morph Target
• Keyframe/Timeline Slider
• Viewing Area

Morph Anchor Section

The morph anchor is the base or source model. The morphing engine will actually use this 
model to create all of the poses and expressions specified by you in the Morph Window. 
The name of the anchor file is listed here.

Target Match Popup Menu

The target match popup menu tells the morph engine how to treat the morph target 
groups. There are five menu options to choose from, depending upon the desired treat-
ment of the targets.
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Figure 322 — Target Match Popup Menu

First

This option will use the first group in the target model as the morphing target. If you only 
have single groups in your morph models, use this option.

Full Match

This is the default option. Group names, number of coordinates and group index order 
must all match in order for this option to have expected results. Properly constructed 
morph targets should conform to this recommendation.

Index Only

Group order must match in order for the morphing to work properly with this option 
selected. In other words, given a group named “foo” in both the source and target models, 
each occurrence of group “foo” in the target models must match the order in which group 
“foo” occurs in the source (anchor) model. No other restrictions are active with this option 
selected.

Name Only

This option morph only across group names contained within the source (anchor) model. 
All other groups will be ignored.
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Geometry Only

This option ignores group names, or group order, and addresses each polygon vertex in 
the order in which it is stored within the model file. In this case, each vertex in the source 
model must be in the same order in the target models. This should be the case in any 
event.

Reload Target Data Button

This button will allow you to replace morph targets while retaining the animation channel 
data for the target. This is useful for fine tuning poses, or substituting higher resolution 
morph targets.

Morph Group Section

Morph target models are placed within Morph groups. You can have as many morph 
groups as necessary. Morph groups are used to organize your morph targets into logical 
collections. As you can imagine, some morphing projects can get pretty complex. The 
morph groups will help to better manage the complexity.

For example, if you have many different models which describe mouth movement, you 
may wish to place all of those targets into a morph group called “mouth.”

To add a Morph Group:

• Click the Add Morph Group button.
• A dialog will appear, asking you to name the group.
• Click OK to clear the dialog.

The morph group is created, and added to the Current Morph Group popup menu. Any 
morph targets that you add will always be added to the morph group indicated by the 
Current Morph Group menu.
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Morph Target Section

As mentioned previously, the morph target models are effectively the extremes of the vari-
ety of poses or expressions that you will be using in the morphing process. Morph targets 
are contained within morph groups for easier management of model and morph data. 
Morph targets are added to the current selection displayed in the Current Morph Group 
Menu.

To Add Morph Targets:

• In the Morph Target section, click the Add button.
• A file dialog will appear, listed model files.
• Select and add the desired target files.
• When complete, press the done button in the dialog.

The target files are now displayed in the morph target area. Along with the actual file 
names, slider bars, edit and check boxes are also displayed in the Morph Target Section. 
The default state of a target slider is the center of the slider. A morph can actually operate 
in the positive or negative. The checkbox to the right of the target name enables or dis-
ables the target from being used in the morph process.

In addition to the actual Morph targets, there are three buttons and one menu in the 
Morph Target Section:

• Add
• Del(ete)
• Add Blend To Curve Editor
• Default Morph Blend Menu

Add (Morph Targets)

This button allows you to add morph targets to the selected Morph Group.
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Del(ete Morph Targets)

This button allows you to remove the selected morph target from the morph target list.

Add Blend to Curve Editor

This button will manual force an update to the animation of the selected morph target to 
the function curve editor for fine tuning. In addition to the manual button presented here, 
at the bottom of the Morph Target section is a checkbox that will automatically send data 
to the function curve editor, if activated.

Default Morph Blend Menu

This menu allows you to choose the interpolation method for the morph targets. The 
interpolation method will appear in the function curve editor as the appropriate spline 
type. There are four options:

• Linear (Default)
• Natural Cubic
• Hermite
• F-Curve

Figure 323 — Default Morph Blend Menu

Linear (Default)

This option directly blends one morph target to another. This option produces rather 
mechanical results.
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Natural Cubic

This option uses a natural spline to interpolate one morph target to another. Splines tend 
to produce a more realistic result than linear interpolation. This curve type offers no mod-
ification options in the function curve editor.

Hermite

This option uses hermite splines to interpolate one morph target to another. Hermite 
splines offer additional Tension, Bias, and Continuity control over the spline curve inter-
polation. These attributes can be adjusted in the function curve editor by selecting either 
the T, B, or C keys and dragging the mouse with the keyframe selected in the editor.

F-Curve

This option uses function curves to interpolate one morph target to another. Function 
curves offer a very realistic result, and additional control in the function curve editor.

Keyframe/Timeline Slider

This slider sets the project time, so that the morphing action desired occurs at the time you 
specify. You can either drag the slider to the desired frame number, or manually enter the 
frame number in the edit section. 

Figure 324 — Keyframe/Timeline Slider with Playback Controls

To the left of the frame display field are the playback controls. These controls are illus-
trated in the following diagram:
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Figure 325 — Playback Controls

Play/Pause

Starts playback of the morph animation. All of the other playback controls require that 
Play be on in order to work.

Step Forward

Will cause the animation to step forward one frame.

Step Backward

Will cause the animation to step backward one frame.

Play Forward

Will cause the animation to play forward.

Play Backward

Will cause the animation to play backward.

View Area Section

This is where you can view the results of your morphing choreography. The default dis-
play is wireframe for speed, however, you can also display this window as phong shaded, 
by option clicking on the blue ball icon in the upper section of the window.

Play Backwards Play Forwards

Step Back Step Forward
Play/Pause
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Making Morphs

We have covered the Morph Window, and the process of adding a morph source model 
and its targets in the previous sections in this chapter. Now we are going to concentrate on 
creating actual morph animations.

The Morph Window is best used as a facial morphing system (although you can animate 
anything you care to morph with it). Each morph target has a slider that lets you blend the 
target with the source. The range of each slider is negative target to positive target, with 
the center, 0, being null (the source would be the result if all of the sliders set to zero. Typ-
ically, your morph target poses (the models that you create for the pose positions) will be 
the positive end of the scroll bar (value 1.0). The negative values (value -1.0) are the oppo-
site of the positive poses, and are derived by determining the change of the target model 
from the source model, and then negating that value. This gives you the benefit of not 
having to create minimum and maximum ranges.

All of the morph targets are weighted and averaged together to form the final object for 

that frame. You can change the interpolation method for the best results. See the section 

entitled “Default Morph Blend Menu” on page 411.

The mechanics of the morphing process requires that you do two basic things:

• Set the current frame
• Move the sliders for the desired look for that frame

The aesthetics of morphing requires far more, of course. It’s one thing to set poses for sync 
sound dialog and the like. It’s quite another to do it with style, and breathe character into 
your creation. George Maestri’s previously cited book, “Digital Character Animation,” 
goes a long way in describing how to achieve character.
414       ElectricImage 2.8 Supplement    



Facial Animation — Making Morphs
For our part, we offer the following: regular people tend to act pretty straight forward, 
and are usually not overly dramatic. Animators learned long ago that presenting such real 
world people makes a rather mundane performance. They learned that by exaggerating 
the performance somewhat, the performance becomes much more interesting. The typical 
purpose of character animation is to entertain, or sell by entertaining. A few extra move-
ments, some obvious thought implied to the character perhaps, can go a long way. It can 
also go overboard as well, and earn the curse of being “over animated,” especially if true 
to life subjects are being presented. 

Two of the greatest tools that you can use to your success are timing and characterization. 
Timing let’s you present the character effectively, making the most by doing the least. Sim-
ply stated, but not simply achieved. Some of the world’s best comedians are also the best 
at timing (knowing when and when not to tell a joke, give a look, and so on.) Timing for 
an animation is a learned art, and it takes time to get it right (sorry!) 

Characterization is effectively the soul of the character that you are endeavoring to create. 
Since the characters you are animating aren’t real, it is your job to impose a sense of reality 
to them. In this way they can seem real, or at least real enough, so that the audience can 
accept them, and enjoy the performance.

Typically, this involves imparting a sense of thought to the character, giving its actions a 
sense of deliberateness. Making the character appear to think and ponder, as well as react 
and emote, are all ways of imparting a soul to it. Some performances might be panto-
mime, others might use heavy dialog. Some might be theatrical, others might be subtle. 

In addition to the Maestri book, there is another must have reference has been written by 
two of the “nine old men” from Disney’s golden age: “The Illusion of Life,” By Frank Tho-
mas and Ollie Johnston. It is available through Amazon.com, and retails for about $60.00 
(Amazon has it for $42.00 at the time of this printing.) This book presents a remarkable 
history of Disney’s best animation, and is an excellent treatise on animating characters.
ElectricImage 2.8 Supplement        415



Facial Animation — Timing
Timing

Typically, animation is keyframed every 8th frame. Cycles tend to happen in eight frames, 
gross mouth positions for dialogs on eight frames, and so on. Essentially derived at for 
film speeds of 24 frames per second, eight frames evenly divides a second into three even 
chunks. Video animation is 29.997 frames per second, but you might find that ten frames 
can be just a tad too long (its up to you.)

ElectricImage user Alain Duranceau, a great character animator, animates everything at 

24 fps, and then uses Adobe® After Effects® to “drop frame” the movie up to video tim-

ings. This produces a very film like result (and renders even faster!)

You should put a keyframe where ever you think necessary (some animators have key-
frames on almost every frame!) but the 8 frame technique is a good rule of thumb.

To set keyframes in the Morph Window:

• Move the keyframe slider into position
• adjust the morph target slider bars for the proper expression

The view area will update to the new pose. Keep adding new keyframes every 8 or so 
frames as needed.

To playback the animation:

• Click the Play/Pause button
• Click the button again to stop
416       ElectricImage 2.8 Supplement    



Facial Animation — Sync Sound
Working with Sync Sound

One of the most powerful character animation tools is sound. The great thing about sync 
sound and dialog is that the timing is built in. All an animator has to do is match up lip 
positions (and add some emotion, of course — acting!)

Since version 2.0, ElectricImage has provided support for sync sound, via AIFF files and 

Quicktime files. For more information on importing sound files, please consult the Elec-

tricImage Reference Manual.

To animate with sync sound in the Morph Window, you use the sync sound display in the 
Project Window. The Keyframe slider in the Morph Window will stay in sync with the 
overall project time slider. By positioning the Project and Morph Windows relative to each 
other so that you can see the full Morph Window, and the sync sound track in the Project 
Window, sync sound is very straight forward to accomplish. To check your animation, cre-
ate a preview in ElectricImage in Quicktime format. When the quicktime file plays back, 
you will be able to immediately see the in sync results of your work. 

Figure 326 — Typical Sync Sound Window Setup
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Sync dialog is actually fairly easy to animate to, and with a little practice the waveforms 
become very easy to read. As an assistant, you can use the Cue feature to break up the 
waveforms and annotate them from the Sound Info Window. A few minutes of work here 
will make sync dialog a snap. Typically, creating a separate cue for every spoken word 
should be enough. You can then use the cue playback feature to get a feel for the mouth 
positions required to sync. Then, all you do is match the mouth positions to the sound. 
The previous illustration shows how to organize your windows so that you can see the 
waveform and morph window at the same time.

Figure 327 — Sound Info Window Cue List

It’s a good idea to concentrate on matching the mouth movements in one pass through, 
and then layer in the emotional content in additional pass throughs. If you try to animate 
every aspect of the performance at once, things can get real confusing. Animating in 
passes is actually faster in the long run, and tends to yield better work.

Working with Morph Curves in the Function Curve Editor

The Morph Window is great for creating the expressions and emotions that you want to 
put into your character. The function curve editor is the better tool for tweaking timings of 
those expressions and emotions. Why? The Function Curve Editor presents morphing as 
curves, showing how the inter-relationships of the morph targets are working. Subtle 
changes can be made in the editor that would be rather tedious to try in the Morph Win-
dow. With a little practice you might even prefer to animate your morphs in the Function 
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Curve Editor. It is also easy to match non-morph animation in your project with morph 
animation in the function curve editor.

You can also adjust timings in the project window, by dragging the keyframe diamonds to 

new desired locations.

To copy a morph “blend” into the function curve editor, select the morph targets that you 
would like to edit, and click on the Add Blend to Function Curve Editor button. The blend 
will now be presented as a linear curve in the editor.

Figure 328 — Function Curve Editor with Morph Blend Curves

The morph target channel is presented to the left of the window. Select the channel, and 
the curve changes to white in the editor. Double click on the channel, and you can change 
the curve to any supported type. You can use all of the tools available in the function 
curve editor to tweak or enhance your animation.

For more information, see the Function Curve Editor chapter.

Morphs and Materials

When rendering morph models, only the material settings in the anchor model will be 
used. Material morphing is not currently supported. Therefore, you need to assign all 
shading attributes to the anchor model. The groups listed in the project window when 
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you select by model are the groups for the anchor model — the groups for the target mod-
els are not presented in the list. 

You can still animate the materials used in the anchor model as expected. If you do not 
want to animate your materials, disable the animation flag on the material and texture 
channels in the project window, under the appropriate group name. This will prevent 
unwanted artifacts from occurring.
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